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1 OVERVIEW
1.1 Background

The degree to which streamflow, or discharge, affects the structure of stream and river ecosystems
cannot be overstated. Stream ecologists consider discharge a master variable, as varying rates of
discharge directly affect the physical, chemical, and thermal attributes of the stream ecosystems. High
flow events have the ability to entirely reshape the physical habitat of streams by repositioning large
woody debris, sediment, and boulders within the active channel, or the active channel itself. Flow rates
often directly affect water temperatures, particularly during flood and low-flow events (Poole and
Berman 2001). Surface water discharge rates directly affect flow through the hyporheic zone (space
between sediments in the benthic zones of streams) as well, where microbial activityis concentrated.
Consequently, discharge candirectly affect nutrient cycling in streams (Grimm and Fisher 1984).
Because of these and other interactions between discharge and the physicochemical attributes of
streams, flow regime characteristics have been found to be significantly correlated with life history
attributes of stream-dwelling organisms such as fishes (Mims and Olden 2012).

Flow regimes in stream andrivers worldwide are rapidly changing due to environmental stressors,
consequentially affecting the ecological services these systems support. Climate change impacts the
timing, magnitude, and severity of flood and drought events with profound consequences for lotic
ecosystems. For example, peak flows in western North Americanrivers are consistently occurring earlier
in the spring (Clow 2010) and these changes may significantly alter the habitat suitability for species
such as cutthroat trout (Zeiglar et al. 2012). Land use change from natural cover to human-dominated
landscapes canalso affect discharge. Impervious surfaces (such as roads and rooftops) in urban
landscapes transfer water directly to stream channels, resulting in elevated flood frequencies and
magnitudes (Schoonover et al. 2006). Agriculturallands may also impact flow regimes either by reducing
flows directly through withdrawals or elevating flow when soils become compacted (Dodds et al. 2004).
All flow regime changes associated with land use substantiallyimpact the biological communities that
residein the receiving waters (Cuffney et al. 2010, Dodds et al. 2004).

Because discharge is fundamentally important to stream ecosystems, NEON will calculate dischargein all
rivers and stream sites withinthe Observatory. The discharge data product will be a crucial input to a
number of additional high-level NEON data products, such as stream metabolism and nutrient fluxes.
Consequently, discharge represents a critical component in the NEON Aquatic Observation System.

1.2 Scope

This document provides a change-controlled version of Observatory protocols and procedures.
Documentation of content changes (i.e. changes in particular tasks or safety practices) will occur via this
change-controlled document, not through field manuals or training materials.

Pagel
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1.2.1 NEON Science Requirements and Data Products

This protocol fulfills Observatory science requirements that reside in NEON’s Dynamic Object-Oriented
Requirements System (DOORS). Copies of approved science requirements have been exported from
DOORS and are available in NEON’s document repository, or upon request.

Execution of this protocol procures samples and/or generates raw data satisfying NEON Observatory
scientificrequirements. These data and samples are used to create NEON data products, and are
documented in the NEON Scientific Data Products Catalog (RD[03]).

1.3 Acknowledgments

NEON acknowledges the current definitive works on this topic, “Discharge Measurements at Gaging

Stations”, U.S. Geological Survey Techniques and Methods Book 3, Chapter A8, by D. Phil Turnipseed

and Vernon B. Sauer (2010) and Mueller, D.S., Wagner, C.R.,Rehmel, M.S., Oberg, K.A.,and Rainville,
Francois, 2013, Measuring discharge with acoustic Doppler current profilers from a moving boat (ver.
2.0, December 2013): U.S. Geological Survey Techniques and Methods, book 3, chap. A22, 95 p.
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RELATED DOCUMENTS AND ACRONYMS

Applicable Documents

Applicable documents contain higher-level information that is implemented in the current document.

Examples include designs, plans, or standards.

AD[01] NEON.DOC.004300 EHS Safety Policy and Program Manual
AD[02] NEON.DOC.004316 Operations Field Safety and Security Plan
AD[03] NEON.DOC.000724 Domain Chemical Hygiene Plan and Biosafety
Manual

AD[04] NEON.DOC.050005 Field Operations Job Instruction Training Plan
ADJ[05] NEON.DOC.004104 NEON Science Performance QA/QC Plan
AD[01] NEON.DOC.004300 EHS Safety Policy and Program Manual

2.2 Reference Documents

Reference documents contain information that supports or complements the current document.
Examples include related protocols, datasheets, or general-information references.

RD[01] [ NEON.DOC.000008

NEON Acronym List

RD[02] [ NEON.DOC.000243

NEON Glossary of Terms

RD[03] [ NEON.DOC.005003

NEON Scientific Data Products Catalog

RD[04] | NEON.DOC.001271

NEON Protocol and Procedure: Manual Data Transcription

RD[05] | NEON.DOC.001646

General AQU Field Metadata Sheet

RD[01] [ NEON.DOC.000008

NEON Acronym List

2.3 Acronyms
Acronym Definition
ADCP Acoustic Doppler Current Profiler
GPS Global Positioning System
LEW Left edge of water (looking downstream)
MBT Moving Bed Test
P&P Procedure and Protocol
REW Right edge of water (looking downstream)
USGS United States Geological Survey
SDRC Stage Discharge Rating Curve
2.4 Definitions

Acoustic Doppler Current Profiler (ADCP): a hydroacoustic current meter used to measure water
velocity over a depth range using the Doppler effect of sound waves scattered back from particles within

the water column.

Page3



n c) n Title: AOS Protocol and Procedure: DSC — Stream Discharge Date: 03/16/2022
e ®

Operated by Battelle [ yEoN poc, #: NEON.DOC.001085 | Author: N. Harrison Revision: H

Area (A): The cross-sectional area ofa stream or a subsection of a stream. For a rectangular subsection,
it is the width times the depth. For anirregular cross-section, it is the summation of a series of
subsectionareas, or the width times the average depth.

Control: A specific section of a stream channel, located downstream from the staff gauge that controls
the relation between gauge height and discharge at the staff gauge.

Depth (D): The depth of the water column at a particular point, measured from the water surface to the
stream bottom.

Discharge (Q): (streamflow) The volume of water flowing through a cross-section during a given period
of time, measuredin units of volume per unit time, such as cubic feet per second, cubic meters per
second, liters per second, gallons per minute, or acre-feet per year. Discharge is computed as velocity x
area.

Left edge of water (LEW): The edge of the streamthat is on the observer’s left when looking
downstream.

Right edge of water (REW): The edge of the streamthatis on the observer’s right when looking
downstream.

Stage: (i.e. stream height, water level) Height of a stream or river relative to a fixed point. Stage can be
measured at a single point in time by reading the water level on a calibrated staff gauge mounted in the
stream channel, or by using a weighted measuring tape to measure down from a fixed point to the
water surface. Stage canalsobe measured continuously with a pressure, optic or acousticsensor, or a
staffgauge.

Stage Discharge Rating Curve (SDRC): An empirical relationship (formula) between a stream stage and
the associated discharge at given stage, which allows automated measurements of stage to be
converted to discharge.

Station: Alocation along the stream discharge measurement transect where velocity and depth are
measured and area and streamflow are calculated. Station, or vertical, spacing is dependent on the
wetted width of the channel and velocity distribution throughout the transect.

Thalweg: The line that connects the deepest part of the active channel.

Transect: The stream cross-section under the measuring tape stretched across the measuring section,
along which velocity measurements are made to compute discharge.

Velocity (V): The speed of water flowing past a point along the transect, measuredin units of rate, such
as liters/meters per second.
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Wetted Width: Width of a stream channel that contains water. As water levels fluctuate in streams, the

wetted width may as well, depending on the cross-sectional shape of the channel.
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3 METHOD

A continuous record of stream discharge is derived using discharge measurement and observed gauge
height data collected by field technicians and pressure data (converted to stage) collected by in-situ

pressure transducers at each NEON aquatic site that contain a wadable stream or river. One component

in building a stage-discharge rating curve involves the measurement of discharge across a wide range of
stage levels by NEON field ecologists. These sampling events are known as discharge surveys. Discharge

is a calculated metric obtained from a series of velocity and area measurements collected along a fixed
cross-sectionin the stream or river (Figure 1). Velocity and area measurements are thenintegratedinto

a single value of streamdischarge that is associated with the gauge height (or stage) during the

measurement.

Once the rating curve is established, and barring significant changes in channel morphology, a single

measurement of water column depth in the stream channelis sufficient to estimate streamflow. Hence,
a pressure transducer is located at a fixed location near the discharge cross-sectionandstaff gaugeis
able to yield a continuous estimate of stream discharge by measuring surface water pressure.

Each NEON aquatic site contains an in-stream staff gauge that is located in a fixed positioned neara
pressure transducer which automatically measures and logs absolute pressure values in-situ at one-

minute intervals throughout the year (or while wateris present within the hydrologic unit). Absolute

pressure data is converted to raw depth using unique calibration coefficients. During eachdischarge
survey field ecologists record gauge height. The raw depth values derived from the pressure transducer

areregressedagainst gauge height measurements collected throughout the water year to derive an
equation that transforms raw depth to stage. A continuous record of stream discharge is derived by

applying stage-discharge rating equations to continuous stage data.

The purpose of this protocol is to provide detailed instructions on how to successfullyimplement a

discharge survey in wadable streams andrivers. This involves pre-deployment and post-measurement

review, step-by-step field methods, data entry procedures, troubleshooting, instrument quality

assurance plans, and safety guidelines specific to NEON sites and personnel.

Two methods are presented for discharge surveys in wadable stream sites: (1) using a handheld
flowmeter to measure dischargeinthe streamand (2) using an acoustic Doppler current profiler (ADCP)
to measure discharge from the streambank. The flowmeter method utilizes a velocity meter that is

designedto measure the speed of water around the sensor tip, yielding an instantaneous localized
velocity measurement. Toobtain anestimate of total stream discharge within the cross-section, the
stream s divided laterallyinto sub-sections. Within each sub-section, an instantaneous velocity

magnitude is obtained and transformedto a volumetric discharge magnitude by applying the velocity
across the full sub-sectionarea. Totalstreamdischargeis then calculated by summing up the discrete
volumetric discharges for each sub-section. The ADCP method utilizes an instrument (ADCP) that uses
sounds to measure water velocity based on the Doppler Effect. The ADCPis mounted to a trimaranfloat

which is pulled across the discharge cross-section while velocity and area are continuously measured
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and total dischargeis calculated. The conditions of use relating to each wadable discharge survey
method are describedin detail laterin the document. ADCP’s are utilized as the sole means to conduct
discharge surveys in rivers. Two ADCP deployment methods are presented to meet sampling goals at
sites: (1) deploying ADCPinstrumentation from a piloted boat and (2) deploying ADCP instrumentation

from a remote-controlled boat.

Wadeable Stream

Biology and Morphology Reach (1 km) . Legend

Sediment Reach (500m) — i ;
gach (500 ) ; | (O sensor station
Reaeration Reach (<500 m) ——— ——————— | 1

() —
(]
VAN
(5
Non-Wadeable River

Biology and Morphology Reach (1 km)

Water Chemistry Sampling
€= Groundwater Well
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Figure 1. Sampling locationsat NEON wadable stream and non-wadable river aquatic sites.

Standard Operating Procedures (SOPs), in Section 7 of this document, provide detailed step-by-step
directions, contingency plans, sampling tips, and best practices forimplementing this sampling
procedure. To properly collect and process samples, field technicians must follow the protocol and
associated SOPs. Use NEON’s problem reporting system to resolve any field issues associated with
implementing this protocol.

The value of NEON data hinges on consistent implementation of this protocol across all NEON domains,
for the life of the project. It is therefore essential that field personnel carry out this protocol as outlined
in this document. In the event that local conditions create uncertainty about carrying out these steps, it
is critical that technicians document the problem and enterit in NEON’s problem tracking system.
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Quality assurance is performed on data collected via these procedures according to the NEON Science

Data Quality Plan (AD[06]).
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4 SAMPLING SCHEDULE
4.1 Sampling Frequency and Timing

While the rating curve is under initial development, it is particularly important to perform discharge
surveys frequently in order to form the basis of the stage-discharge relationship. At wadable stream
sites NEON’s target is to conduct twenty-four (24) discharge surveys annually over a wide range of stage
levels until Science has validated the stage-discharge rating curve for a given site. Once the rating curve
is validated, NEON'’s target is to use discharge surveys to verify the rating curve twelve (12) times per
year across arange of stages. Atriver sites, twelve (12) discharge surveys are to be completed annually
prior to and following rating curve establishment (Table 1). If necessary, the discharge sampling
schedule may deviate in order to conduct measurements at certain flow levels. Inthese cases Field
Science staff should work with Science through the appropriate channels that address scheduling
changes.

Once the rating curve has undergone initial development and validation, the stage-discharge
relationship must be verified over time, as ratings may shift due to bed scour, aggradation, or other
changes in channel geometry. Following each discharge survey, staff must compare the measured
discharge value to the predicted value derived from the rating equation. Consecutive discharge
sampling bouts that yield discharge values greater than+ 10% of the predicted value may be an
indication that the stage-discharge relationship at a given site has changed, or shifted. IfScience has
determined that a rating shift is present, discharge sampling frequency at the site may need to be
increased for purposes of validation, and, if necessary, the creation of new rating equations. Channel
morphology in streams with unconsolidated bed materials are expectedto fluctuate (to varying degrees)
on an annual and storm-event basis. As aresult, rating curves for these channel types will require more
frequent measurements than those for bedrock channels, which are more stable. Sampling frequency
details for each site will be provided in Domain Specific Sampling Design documentation (AppendixE).

Table 1. Required sampling frequencyfor discharge surveys at NEON aquatic sites containing wadeable streams

andrivers.
AquaticSite Types Sampling Dates Sampling Bouts per Year
Wadable Streams: pre-rating curve establishment | Year-round (as feasible) 24
Wadable Streams: post-rating curve establishment | Year-round (as feasible) 12
Rivers: pre- and post-rating curve establishment Year-round (as feasible) 12
4.2 Criteria for Determining Onset and Cessation of Sampling

Certaincriteria for determining the onset and cessation of sampling is dependent on the discharge
survey method. These details are presented below.
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Sampling Cessation — Discharge Measurements at Wadable Stream Sites Using the
Flowmeter Method

At wadable stream sites, discharge sampling should be conducted according to the site-specificinterval

(24 times per year pre-rating curve validation, 12 times per year post-rating curve validation) using the
Flowmeter Method under the following conditions:

1.

Water is presentin the stream channel.

a. Ifwateris not presentin the stream channel then a discharge measurement cannot be
conducted using any available method. Submit an incident ticket to Science documenting
that the reach has gonedry.

Itis safeto enter the stream channel.

a. Reference AD[02] and any other Domain-specific safety plans that detail thresholds for
working in the stream.

The staffgauge is present and un-disrupted.

a. Ifthe staffgaugeis not present, or has been disrupted/damaged, do not collect a discharge
measurement using any available method.

b. Submit anincident ticket to Science documenting this occurrence.

c. Note thatif a discharge surveyis associated with a reaeration sampling event, discharge
should stillbe measuredregardless of staff gauge presence.

Surface water to bed depth is between0.04 and ~0.17 m in > 90% of the channel wetted width.

a. The ADCPis the preferred method to measure discharge at wadable stream sites due to the
high level of data quality the instrument provides. However, the handheld flowmeter can
measure velocity at lower depths than the ADCP, making the Flowmeter method a suitable
option to measure discharge during the ultra-low flow regime.

b. The minimum depth for the ADCP will be determined on a site-by-site basis as
environmental conditions affect the instrument’s measurement ability. At sites withrough
streambeds (i.e. large boulders or cobble) the minimum ADCP depth will likely be greater
than at sites with smooth beds (i.e. sand or smallgravel). Consult with Science if thereis a
guestion as to when to utilize the Flowmeter vs. ADCP method.

c. Thereis no requirement for a minimum wetted channel width.

d. Discharge measurement qualityis dependent on the continuous profile of water that
maintains a minimum depth and laminar throughout the majority of the discharge transect
(this should not include the shallow edge sections).

e. If needed, move smallersubstrate and/or cobbles within the discharge transect to (1)
maintain hydrologic connection within the channel, (2) maintain the minimum depth
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requirements of the flowmeter, and (3) decrease the roughness of the streambedto
improve data quality (reduce uncertaintyin depth measurements).

If larger debris is locatedin the discharge transect and cannot be moved, an alternative
discharge measurement location should be considered. Submit an incident ticket to Science
to document this occurrence and discuss a path forward.

If water depth is below this threshold and the discharge transectis dry, very nearly dry, or
hydrologically disconnected, submit an incident ticket to Science to document this
occurrence.

At higher stage levels (water depth is 2 ~0.17min > 90% of the channel wetted width), the
ADCP method is to be used. Environmental conditions specific to the site will likely dictate
when the transition from the flowmeter to the ADCP method canoccur (see Step 4a above).
Consult with Science if thereis a question as to when to utilize the Flowmeter vs. ADCP
method.

5. Minimal ice cover is present.

a.

4.2.2

If the water surfaceis “lightly iced” over (< 1” of ice) and you can safely break through the
ice to clear/open up a 1m width along the entire discharge transect, collect a discharge
measurement.

Recordice presence and temporary hydrologic conditions in the app and indicate that
surfaceice was broken in order to collect the measurement.

If the surfaceice thicknessis > 1”, do not collect a stream discharge measurement.

Sampling Cessation — Discharge Measurements at Wadable Stream Sites Using the ADCP
Method

At wadable stream sites, discharge sampling should be conducted according to the site-specific interval
(24 times per year pre-rating curve validation, 12 times per year post-rating curve validation) using the
ADCP method under the following conditions:

1. Wateris presentin the streamchannel.

a.

If wateris not presentin the stream channel then a discharge measurement cannot be
conducted using any available method.

b. Submit anincident ticket to Science documenting that the reach has gone dry.

2. The staffgaugeis present and un-disrupted.

a.

If the staff gauge is not present, or has been disrupted/damaged, do not collect a discharge
measurement using any available method.

b. Submit an incident ticket to Science documenting this occurrence.
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If the staff gauge is topped during high flows and a discharge measurement can be safely

collected, attempt to markor in some way reference the elevation of the edge of water
(only do soif this can be accomplished in a safe manner). A future survey of this location

(relative to the staff gauge) can provide an estimate of gauge height during the

measurement.

Note thatif a discharge surveyis associated with a reaeration sampling event, discharge

should still be measured regardless of staff gauge presence.

The ADCP s the preferred method to measure discharge at wadable stream sites due to the

high level of data quality the instrument provides. However, the handheld flowmeter can
measure velocity at lower depths than the ADCP, making the Flowmeter method a suitable

option to measure discharge during the ultra-low flow regime.

The minimum depth for the ADCP will be determined on a site-by-site basis as

environmental conditions affect the instrument’s measurement ability. At sites withrough

streambeds (i.e. large boulders or cobble) the minimum ADCP depth will likely be greater
than at sites with smooth beds (i.e. sand or smallgravel). Consult with Science if thereis a

guestion as to when to utilize the Flowmeter vs. ADCP method.

There is no requirement for a minimum wetted channel width.

Discharge measurement quality is dependent on the continuous and laminar profile of
water that maintains a minimum depth throughout the majority of the discharge transect
(this should not include the shallow edge sections).

If needed (and it is safe to enter the channel), move smaller substrate and/or cobbles within

the discharge transect to (1) maintain hydrologic connection within the channel, (2)
maintain the minimum depth requirements specific to the ADCP at a given location, (3)
decrease the roughness of the streambedto improve data quality (improve bottom
tracking), and (4) minimize the unmeasured area at the bottom of the velocity profile.

If larger debris is locatedin the discharge transect and cannot be moved, an alternative

discharge measurement location should be considered. Submit an incident ticket to Science

to document this occurrence and discuss a path forward.

At lower stage levels (water depthis £ ~0.17min 2 90% of the channel wetted width), the
Flowmeter method is to be used. Environmental conditions specific to the site will likely
dictate when the transition from the flowmeter to the ADCP method can occur (see Step 3a

above). Consult with Science if thereis a question as to when to utilize the Flowmeter vs.

ADCP method.

4. Minimalice cover is present.
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a. Ifthe watersurfaceis “lightly iced” over (< 1” of ice) and you can safely break through the
ice to clear/open up a 1m width along the entire discharge transect, collect a discharge
measurement.

b. Recordice presence and temporary hydrologic conditions in the app and indicate that
surfaceice was broken in order to collect the measurement.

c. Ifthe surfaceicethicknessis >1”, do not collect a stream discharge measurement.
The ADCP passes diagnostics tests prior tothe measurement.

a. Iftheinstrument does not pass diagnostic tests prior to measurement, do not collect a
measurement and submit a trouble ticket to Science.

See Appendix E.2 for site-specific details on maximum depth thresholds which are dependent

on ADCP model type and individual instrumentation configurations.

Sampling Cessation — Discharge Measurements at River Sites Using thePiloted and Remoted
Controlled Boat Method

At river sites, discharge sampling should be conducted according to the site-specificinterval (12 times

per year) using the ADCP Piloted Boat or Remote Controlled Boat methods under the following
conditions:

Wateris presentin the river channel.

a. If wateris not presentin the stream channelthen a discharge measurement cannot be
conducted using any available method. Submit an incident ticket to Science documenting
that the reach has gone dry.

The staff gauge is present and un-disrupted.

a. Ifthe staffgaugeis not present, or has been disrupted/damaged, do not collect a discharge
measurement using any available method.

b. Submit an incident ticket to Science documenting this occurrence.

c. Ifthe staffgaugeistopped during high flows and a discharge measurement can be safely
collected, attempt to mark or in some way reference the elevation of the edge of water
(only do soif this can be accomplished in a safe manner). A future survey of this location
(relative to the staff gauge) can provide an estimate of gauge height during the
measurement.

d. Note thatif a discharge surveyis associated with a reaeration sampling event, discharge
should still be measured regardless of staff gauge presence.

The discharge transect can be safely accessed using the Remote Controlled Boat Method:

a. Reference AD[02] and any other Domain-specific safety plans that detail thresholds for
working on the near shore of the river.
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4. The dischargetransect canbe safely accessed using the Piloted Boat Method:

a. Reference AD[02] and any other Domain-specific safety plans that detail thresholds for
operating a vesselin the river.

5. The ADCP passes diagnostics tests prior to the measurement.

a. Iftheinstrument does not pass diagnostic tests prior to measurement, do not collect a
measurement and submit a trouble ticket to Science.

6. Surface waterto bed depth is between0.15 and 25.0 m in 2 90% of the channel wetted width.
a. There is no requirement for a minimum wetted channel width.

b. Discharge measurement qualityis dependent on the continuous profile of water that
maintains a minimum depth throughout the majority of the discharge transect (this should
not include the shallow edge sections).

c. If water depth is outside this threshold submit an incident ticket to Science that documents
this occurrence.

4.3 Missed or Incomplete Sampling

Sampling according to the schedule is not always possible, and multiple factors mayimpede work in the
field at one or more plots or sampling locations for a given bout. For example:

e Logistics —e.g., insufficient staff or equipment.
e Environment —e.g., deep snow/ice cover, excessive flooding, dangerous weather.
e Management activities —e.g., controlled burns, pesticide application.

Instances such as those listed above must be documented for scheduling, tracking long-term site
suitability, and informing end users of NEON data availability. Some types of missed sampling are due to
events that should be recorded in the Site Management App; refer to the Site Management and Event
Reporting Protocol for more detail (RD[06]).

Missed or Incomplete Sampling Terms
Terms that inform Missed or Incomplete Sampling include:

e ProtocolSampling Dates: Bout-specific sampling dates.

e Scheduled Sampling Dates: Bout-specific sampling dates scheduled by Field Science and
approved by Science. These dates coincide with or are a subset of the Protocol Sampling Dates.

e Missed Sampling: Incidence of scheduled sampling that did not occur. Missed Sampling is
recorded at the same resolution as data that are ordinarily recorded.

e Sampling Impractical: The field name associated with a controlled list of values that is included
in the data product to explain a Missed Sampling event —i.e., why sampling did not occur.
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e Rescheduled: Missed Sampling is rescheduled for another time within the protocol sampling
dates, resulting in no change tothe total number of sampling events per year.

The documentation that must accompany missed sampling depends on the timing, subsequent action,
and the audience appropriate for numerous scenarios (Figure 3).

Can sampling be

- Submit ServiceNow Incident <——No A atieds

Unsure—> - Submit Schedule Change Request

Yes

Rescheduled
within Schedule Sampling
dates?

Was sampling

Sample <—Yes rescheduled?

Yes

No

No

v

Rescheduled
within Protocol Sampling
dates?

Sample €«—Yes - Submit ServiceNow Incident

No
Y

- Submit Schedule Change Request

Schedule Change

Request Approved? Yes—>» Sample

Figure 2. Missed sampling workflowfor the NEON discharge protocol.

To Report Missed or Incomplete Sampling:
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1. Missedor Incomplete Sampling must be communicated to Science by a Service Now Incident
ticket.

a. For MissedSampling thatis Rescheduled, there are some cases that require approval by
Science and Operations (Figure 3).

b. The lead Field Ecologist should consult the Delayed or Cancelled Activities table to best
determine when reporting is required.

4.4 Estimated Time

Estimated time to complete the protocol is dependent on the type discharge survey method. Estimates
for each method are presented below.

4.4.1 Estimated Time — Discharge Measurements at Wadable Stream Sites Using the Flowmeter
Method

The time required to implement the protocol using the Flowmeter method at wadable stream sites will
vary depending on a variety of factors, such as skill level, system diversity, environmental conditions,
and distance between sample plots. The timeframe provided below is an estimate based on completion
of ataskby asingle skilled Field Scientist (i.e., not the time it takes at the beginning of the field season).
Use this estimate as framework for assessing progress. If a taskis taking significantly longer than the
estimated time, anincident ticket should be submitted to Science. Please note that if sampling at
particular locations requires significantly more time than expected, Science may propose to move these
sampling locations.

Table 2. Estimated staff and labor hours required forimplementation of the Stream Discharge protocolusing the
Flowmeter Method at wadable streamsites.

SOP Estimated Suggested Totalperson hours
time staff
SOP A: Preparing for Sampling: Wadable
Stream Sites Using the Flowmeter 10 minutes 1 0.2h
Method

SOP B: Field Sampling: Wadable Stream
Sites Using the Flowmeter Method
SOP C: Post-Field Sampling Tasks:

Wadable Stream Sites Using the
Flowmeter Method
SOP D: Data Entryand Verification:

Wadable Stream Sites Using the 10 minutes 1 0.2h
Flowmeter Method

30 minutes 1 0.5h

10 minutes (if

1 0.2h
necessary)
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4.4.2 Estimated Time — Discharge Measurements at Wadable Stream Sites Usingthe ADCP Method

The time required to implement the protocol using the ADCP method at wadable stream sites will vary
depending on a variety of factors, such as skill level, system diversity, environmental conditions, and
distance between sample plots. The timeframe provided below is an estimate based on completion of a
task by a skilled 2-3 person team (i.e., not the time it takes at the beginning of the field season). Note
that many of the pre-measurement tasks listed can be completed in parallel with one another. Use this
estimate as framework for assessing progress. Ifa taskis taking significantly longer thanthe estimated
time, an incident ticket should be submittedto Science. Please note that if sampling at particular

locations requires significantly more time than expected, Science may propose to move these sampling
locations.

Table 3. Estimated staff and labor hours required forimplementation of the Stream Discharge protocolusing the
ADCP Method at wadable streamssites.

SOP Estimated Suggested Totalperson hours
time staff
SOP E: Preparing for Sampling: Wadable . B
Stream Sites Using the ADCP Method 10-30 minutes ! 0.2-0.5h
SOP F: Field Sampling: Wadable Stream 30-60 minutes )3 05-15h

Sites Using the ADCP Method
SOP G: Post-Field Sampling Tasks:

10 minutes (if

Wadable Stream Sites Using the ADCP 1 0.2h
Method necessary)
SOP H: Data Entryand Verification:
Wadable Stream Sites Using the ADCP 10 minutes 1 0.2h
Method
4.4.3 Estimated Time — Discharge Measurements at River Sites Using the Remote Controlled Boat
Method

The time required to implement the protocol using the remote controlled boat method at river sites will
vary depending on a variety of factors, such as skill level, system diversity, environmental conditions,
and distance between sample plots. The timeframe provided below is an estimate based on completion
of ataskby askilled two-personteam (i.e., not the time it takes at the beginning of the field season).
Use this estimate as framework for assessing progress. If a taskis taking significantly longer than the
estimated time, anincident ticket should be submittedto Science. Please note that if sampling at

particular locations requires significantly more time than expected, Science may propose to move these
sampling locations.
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Table 4. Estimated staff and labor hours required forimplementation of the Stream Discharge protocolusing the
ADCP Method atriver sites.

SOoP Estimated time Suggested Totalperson hours
staff

SOP I: Preparing for Sampling: River
Stream Sites Using the Remote 10-30 minutes 1 0.2-0.5h
Controlled Boat Method
SOP J: Field Sampling: River Stream
Sites Using the Remote Controlled 30-60 minutes 2 0.5-1.5h
Boat Method
SOP K: Post-Field Sampling Tasks: . .
River Stream Sites Using the Remote 1?\(22:taeril)(lf 1 0.2h
Controlled Boat Method
SOP L: Data Entryand Verification:
River Stream Sites Using the Remote 10 minutes 1 0.2h
Controlled Boat Method

4.4.4 Estimated Time — Discharge Measurements at River Sites Using the Piloted Boat Method

The time required to implement the protocol using the piloted boat method at river sites will vary
depending on a variety of factors, such as skill level, system diversity, environmental conditions, and
distance between sample plots. The timeframe provided below is an estimate based on completion of a
task by a skilled two-person team (i.e., not the time it takes at the beginning of the field season). Use
this estimate as framework for assessing progress. If a taskis taking significantly longer than the
estimated time, anincident ticket should be submittedto Science. Please note that if sampling at
particular locations requires significantly more time than expected, Science may propose to move these
sampling locations.

Table 5. Estimated staff and labor hours required forimplementation of the Stream Discharge protocolusing the
Piloted Boat Method atriversites.

SOP Estimated time Suggested Total person hours
staff
SOP M: Preparing for Sampling:
River Stream Sites Using the Piloted 10-30 minutes 1 0.2-0.5h
Boat Method

SOP N: Field Sampling: River Stream
Sites Using the Piloted Boat Method
SOP O: Post-Field Sampling Tasks:

30-60 minutes 2 0.5-1.0h

10 minutes (if

River Stream Sites Using the Piloted necessary) 1 0.2h
Boat Method

SOP P: Data Entryand Verification:

River Stream Sites Using the Piloted 10 minutes 1 0.2h
Boat Method
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5 SAFETY

This document identifies procedure-specific safety hazards and associated safety requirements. It does
not describe general safety practices or site-specific safety practices.

Personnel working at a NEON site must be compliant with safe field work practices as outlined in the
Operations Field Safety and Security Plan (AD[02]) and EHS Safety Policy and Program Manual (AD[01]).
Additional safetyissues associated with this field procedure are outlined below. The Field Operations
Manager and the Lead Field Technician have primary authority to stop work activities based on unsafe
field conditions; however, all employees have the responsibility and right to stop their work in unsafe
conditions.

e Activities in streams should only be performed when flow conditions are safe.
e Never enter the channel when it is unsafe to do so.

e Beaware of the potential for downstream debris transport as stage increases.
e Logs, debris, cobble, and boulders can be very slippery and unsafe to walk on.
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6 PERSONNEL

6.1 Training Requirements

All technicians must complete required safetytraining as defined in the NEON Training Plan (AD[04]).
Additionally, technicians must complete protocol-specific training for safety and implementation of this

protocol as required in Field Operations Job Instruction Training Plan (AD[05]).

Personnel should be:

e Trained in Water Safety Awareness
e Trained in making wading discharge measurements
e Adept at wading in streams.
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7 STANDARD OPERATING PROCEDURES
SOPOverview
Workflow: All SOPs
Field SOP |- SOP A-D
. Ultra low flow regime
(depth =0.04 -~0.17m* in >80% of the
’/'/ \‘\\\ channel)
,./' Wadable .- *minimum depth for method will vary by site
b Stream ) it o
h Sites -
\ SOP E-H
~ Low — High flow regime
(depth >~0.17m* in >90% of the channel)
*minimum depth for ADCP method will vary by site
SOP I-L
A Low — High flow regime
[ARC-Boat is available and depth = 0.15 -
h N 25m in >~90% of the channel)
% River .
A Sites
~ 7
~ SOP M-P
~ Low — High flow regime
(ARC-Boat is NOT available and depth =
0.15 - 25m in >~90% of the channel)

Figure 3. A high level workflow diagram that visually shows how the separate SOPs are sequentially connected.

S0P A: Prepare

Wadable ‘Water present Yes— Staff gauge Yes— No —» for Sampling,
Stream Sites inchannel? present? Flowmeter
Method
No No No Yes

Do not collect S0P E: Prepare

Measurement, for Sampling,
submittrouble ADCP Method
ticket

Figure 4. A high level workflow diagram that visually shows the workflow for wadable stream sites.
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Vertical depth
<0.45m?

One Point Method
@ 605 depth

SOP A: Prapare’ S0P 8:Field

for Sampling, Checkflowmater Calibrate flowmets > Sampling, Determinestation | g Measure —
Flowmeter > settings > | Selibremetiowmee Flowmeter * spacing discharge
Methad Methad

Review
measurement
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= 0.45m?

Twa Paint Method
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Reduce smtion
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total verticals
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S0P C:
Sampling Document
incomplete? > Incamplete
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50 D:Review
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Measurement [/
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Figure 5. A detailed workflowdiagram that visually shows the workflow for wadable stream sites usingthe

Flowmeter Method.

Refarence
Flowmeter
GPs
Method
No Yes
SOPE: Prapare’ Yes SOPF:Field
* Prep equipment, i Conduct pre-
i ‘aDcp ; Setupand test Configure Moving bed
forsampling, ) | asvablish Blustcoth| — comms Ny —» Sampling, )y [ SETUP3N — | wirivernsie | —* | messuement | —* b
ADCP Method ADCP Method High Line asac present?
No
Referance
Navigation:
BT
50PG:
Document
Incomplets
Sampling
" 4
:Data es
No measurement in
Entryand -— i evaluata Dekta
Verification s values

Collect additionsl

transectpairs &

evaluste Datta Q.
values

Figure 6. A detailed workflowdiagram that visually shows the workflow for wadable stream sites usingthe ADCP

Method.
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SOP |: Prepare

3 Water present Yes—» Staff gauge Yes— ARC-Boat Yes— for Sampling,
in channel? present? available? RC Boat
Method
No No No

Do not collect
ME3SUrEMent

SOP M: Prepare
for Sampling,
Piloted Boat
Method

Figure 7. A high level workflow diagram that visually shows the workflow for river sites.
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Method communications Boat Method inRiver IIfile 2AaC :
No
Reference
BT
SOPK:
Document
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Sampling
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Review Measured
S0P LiData e measurementin | * Yes transecs &
+—— No
Entryand e WinRiver lland svsluaiaDeliad
Verification QRev values

Collect sdditional

transect pairs&
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Figure 8. A detailed workflowdiagram that visually shows the workflow for river sites using the Remote Controlled

Boat Method.
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Figure 9. A detailed workflowdiagram that visually shows the workflow for river sites using the Piloted Boat

Method.
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SOPA Preparing for Sampling: Wadable Stream Sites Using the Flowmeter Method

A.l Preparing for Data Capture

Prior to leaving the office ensure that the following is met:

e The flowmeteris fully charged.

e All necessaryequipment is gathered and prepared (Table 11. Equipment list for measuring
discharge at wadable stream sites using the Flowmeter Method. ).

e Ifthe site has an approved stage-discharge rating curve, the current rating equation is available
for measurement comparison/validation.

A.2 Navigate to the Discharge Transect

If a discharge transect, or cross-section, has already been established, the bounds should be
permanently marked using stakes or plot markers (one on eachside of the stream). Navigate tothis
location and proceed to Section A.3.

If a discharge transect has not been established at the site proceed with the following steps:

1. Determine an appropriate location to establisha discharge transect.

a. At wadablestreamsites the transect location must be located in the riffle habitat unit in
close proximity (just downstream) of the pool where the staff gauge andsensorsetare
installed. Consult with Science if the sensor set location is unknown or has not yet been
established.

b. Anideal discharge transect will:

1) Belocated in areasonably straight channel with velocity lines that are more or less
parallel to eachother.

2) Containvelocities that are, for the most part, > 0.15 m/s, and depths that are, for the
most part, >0.15m.

3) Containa stable streambed free of obstructions that would create eddies, slack water,
and turbulence.

4) Containmeasurement sections that are roughly parabolic, trapezoidal, or rectangular.
5) Containa stable downstream control feature.
c. Take pictures of the transect locationthat best meets this criteria as well as the downstream

control feature and sendto Science for consultation.

A3 Assess the Discharge Transect

Prior to collecting the discharge measurement identify any instrumentation or environmental issues that
would negatively affect data quality. Document any temporary hydrologic conditions in the (AOS) Field

SOPA
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Metadata and Gauge Height [PROD] app in Fulcrum. If conditions are unfavorable to discharge
measurement collection, submit a trouble ticket and consult with Science.

Unfavorable conditions include, but are not limited to:

1.

A4

The staff gauge is either not present or has been displacedin some way.

a.

A discharge measurement should not be collected if a staff gaugeis not present at the site
or the gauge has been displaced in any way. Submit a trouble ticket to Science that includes
photos of the gauge.

A pressure transducer is either not present or has been displaced in some way.

a.

A discharge measurement may be collected in the event that the pressure transducer is
missing or has been displaced. However the absence of this instrument prevents
continuous discharge from being estimated. Submit a trouble ticket to Science immediately
if the Pressure transducer is missing or has become displaced.

Too much water is present in the channel to safely conduct the wading survey.

a.

b.

Refer to NEON Operations Field Safety and Security Plan (AD[02]) for details.

Consider using the ADCP method (see Section 4.2).

There is an insufficient amount of water in the channel to conduct velocity measurements.

a.

See Section 4.2.1.

Refer to NEON Operations Field Safety and Security Plan (AD[02]) and NEON Operations Field
Safety and Security Plan (AD[02] for further details.

Setup Flowmeter and Configure Flowmeter Settings

Itis criticalthat the flowmeter settings are configured correctly in the handheld units. Incorrect settings
will negatively affect data quality and, in some instances, prevent data entry. Follow the steps below to
setupthe flowmeter and ensure that flowmeter settings are correct prior to measuring discharge.

The most common flowmeter currently at use at NEON aquatic sites with wadeable streams is the HACH
FH-950. The following steps detail calibration procedures for this model. Ifanother flowmeter is used
for discharge, consult with Science regarding configuration.

1.

Attachthe flowmeter to the wading rod.

a.

Ensure the hexagonal wading rod is attached properly to the rod base. The baseand rod
screw together, tightenif the parts appear loose.

Attach the velocity flowmeter to the mounting shaft of the wading rod, using the thumbscrew
(Figure 10).

SOPA
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a. Do not touch the tip of the sensor bulb, residue from oil on your fingers and hands can

negatively affect the calibration procedures.

Sensor
Bulb

Thumbscrew

I'’4

Figure 10. Velocity meterand the thumbscrew that attaches it to the wading rod.

3. Turn the flowmeter on by pressing and holding the “ON/OFF” button on the outside of the

handheld instrument. Note that the meter may first run a diagnostic check toensure it is
connected to the sensor. Once complete, the Start Menu will appear on the screen (Figure 11).

Ok / Enter
On/Off

Go Back Arrow

1 page Keys

Delete /

Backspace |

Figure 11. HACH FH950 flowmeter with displayed Start menu.

SOPA
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4. Set Measurement Units.

a.

p.
g.

From the Start Menu, select “Setup” and press OK.
Select “More” at the bottom of the screen.
Select “Units” and press OK.

Select “Metric” and press OK.

Under the “Select function” screen, select “Velocity” and press OK.

Select “m/s” and press OK.

The “Parameters successfully saved” screen will appear
Select “flow” and press OK.

Select “liters/s” and press OK.

The “Parameters successfully saved” screen will appear
Select “depth” and press OK.

Select “m” and press OK.

The “Parameters successfully saved” screen will appear
Select “area” and press OK.

Select “m?” and press OK.

The “Parameters successfully saved” screen will appear

Once all units have been set correct, press OK.

5. Set Filter Parameters.

a.

b.

From the Start Menu, select “Setup” and press OK.
Select “Filter Parameters” and press OK.
Select “Mainfilter” and press OK.

Select “Fixed Period Averaging” and press OK.

In averaging time box, enter a value of “40” (seconds) and press OK.

1) This is the amount of time the flowmeter will spend averaging the velocity

measurements.

The “Parameters successfully saved” screen will appear

. Press OK.

. Press OK.

. Press OK.

. Press OK.

. Press OK.

Check that “Pre-filter” is enabled and the data acquisition pre-filter rank is set to “5”.

1) These are default values and should not be changed.

SOPA
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6. Set Flow Calculation Method.
a. From the Start Menu, select “Setup” and press OK.
b. Select “More” at the bottom of the screen.
c. Select “Flow Calculation” and press OK.

d. Select “Mid-section” and press OK.

e. The “Parameters successfully saved” screen will appear. Press OK.

7. Set Station Entry Method.
a. From the Start Menu, select “Setup” and press OK.
b. Select “More” at the bottom of the screen.
c. Select “Station Entry” and press OK.

d. Select “Non-Fixed” and press OK.

e. The “Parameters successfully saved” screen will appear. Press OK.

8. Set Measurement Resolution.
a. From the Start Menu, select “Setup” and press OK.
b. Select “More” at the bottom of the screen.
c. Select “Measurement Resolution” and press OK.

d. Select “0.001” and press OK.

e. The “Parameters successfully saved” screen will appear. Press OK.

9. Set Auto-Zero Mode.
a. From the Start Menu, select “Setup” and press OK.
b. Select “Auto ZeroDepth” and press OK.

c. Select “On” and press OK.

d. The “Parameters successfullysaved” screenwill appear. Press OK.

10. Set EMI.
a. From the Start Menu, select “Setup” and press OK.
b. Select “EMI” and press OK.

c. Select “60Hz.” and press OK.

d. The “Parameters successfullysaved” screenwill appear. Press OK.

11. Set Wet/DryThreshold.

SOPA
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a. This is the trigger point for the meter to know when the sensor is out of the water.

b. This isimportant because if the meter does not know that the sensoris under the surface of
the water, the meter sets the velocity value tozero.

c. From the Start Menu, select “Setup” and press OK.

d. Select “Wet/DryThreshold” and press OK.

e. Select “Default” (value = 20) and press OK.

f.  If the specific conductivity of the wateris very low (i.e. < 15 us/cm, although specific
conditions may vary by site) the flowmeter may not function properly and this value will
need to be adjusted.

1) Anindication of this problem is when the flowmeter measures 0.00 velocity rates in
flowing water.
2) Totroubleshoot:

a) Obtain a “dry conductivity reading” with the flowmeter out of the water.

b) Obtain a “wet conductivity reading” with the flowmeter submerged in a bucket
stream water.

c) Setthe Wet/Drythreshold value to midpoint, or average of the “dry” and “wet”
conductivity reading values.

d) Conductivity fluctuates with stream stage. If you change this value be sure to
update it again during the next discharge measurement based on current
conditions.

3) If problems persist:

a) Document out of the ordinary conductivity conditions in the Fulcrum metadata app.

b) Submit atrouble ticket to Science.

g. The “Parameters successfully saved” screen will appear. Press OK.

12. Set Clock.

a. From the Start Menu, select “Setup” and press OK.

b. Select “Clock” and press OK.

c. Follow the instructions to set local time and current date and press OK.

d. The “Parameters successfullysaved” screenwill appear. Press OK.

e. Update Clock settings toreflect periods of daylight savings time.

SOPA
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A.5 Calibrating the Flowmeter

All flowmeters must be “zero-calibrated” prior to measuring discharge. The most common flowmeter
currently at use at NEON aquaticsites is the HACH FH-950. The following steps detail calibration
procedures for this model. If another flowmeteris used for discharge, consult with Science regarding
calibration instructions.

To calibrate the HACH FH-950 flowmeter:

1. Fill a 5-gallon bucket with water from the stream you will be measuring discharge. Usingthe
local water will ensure that the ionic strength of the “zeroing water” is the same as the water
being measured.

2. Place thevelocity meterin the water. Keep the sensor bulb positioned in the center of the
bucket (or as close to it as possible). The sensor bulb must be kept a minimum of 3-inches from
the sides and bottom of the bucket as well as the surface of the water.

3. Allow water settle for 1-2 minutes to stabilize. Water in the bucket must remain still throughout
the calibration process.

4. Turnon the handheld flowmeter and select “Setup”.
5. Select “Velocity Calibration”.
6. Select “ZeroCalibration”.

7. Allow the flowmeter to cycle through a calibration reading and, once complete, verify that the
unit reads a velocity of 0.00 m/s. Note that -0.00 m/s is acceptable.

8. Ifthe calibration velocity is 0.00 m/s, return tothe main menu on the handheld flowmeter.

9. Ifthe final calibration velocity does not equal 0.00 or -0.00 m/s at the end of the calibration
cycle (100%), repeat previous calibration steps.

a. Reasons for calibration errors may include:
1) The sensorbulb tip was touched or is dirty and needs to be wiped off with a dry cloth.
2) Flowmeter batteries are low.
3) The waterin the 5-gallon bucket was shifted during the calibration procedures.

4) The sensor bulb tip was too close to the bucket edges or the water surface during
calibration procedures.

b. If, after five attempts, the flowmeter cannot be zero-calibrated, the flowmeter should not
be used and discharge should not be measured.

1) Submit atrouble ticket and consult with Science.

2) If possible use another flowmeter to measure discharge that can be zero-calibrated.

SOPA
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SOPB Field Sampling: Wadable Stream Sites using the Flowmeter Method

B.1 Setting up the Discharge Transect and Delineating Station Spacing for Depth and Velocity
Measurements

Discharge surveys at NEON wadeable stream sites are tobe measured from the right to left bank,
looking downstream. Velocity measurement stations are to begin at the right edge of water (REW)and
extend to the left edge of water (LEW).

To ensure high data quality is collected, velocity measurement stations must be spaced correctly across
the streamdischarge transect. Todetermine proper station spacing across a transect, field ecologists
must first assess the relevant hydrologic conditions present at the time of the discharge measurement;
specifically, streamflow magnitude, water surface elevation, and wetted width. The overall goalis to
establish as many velocity measurement stations as possible to obtain a complete and well-distributed
velocity profile throughout the cross-section. However, stations must not be set so close sothat
subsequent stations measure the same velocity profile. The location of velocity measurement stations
do not need to be equally spacedacross the transect. Rather, the locations should be more closely
spaced where water velocity and depth are changing most rapidly (this is often at the center of the
channel and/or near the banks) to ensure that no more than 10% of the total discharge occurs within a
single velocity measurement station.

Use the following steps to consider how to best space stations across the discharge transectgiven the
dynamic nature of stream conditions within the monitoring location.

1. Attachthe measuring tape to the permanent stake on the right bank and extend it across the
streamsothatis perpendicular to the flow. Attachthe opposite end to the permanent stake on
the left bank.

2. Assess whether streamflow appears to be relatively uniform across the channel. Note the
location of any non-laminar (water is flowing in non-parallel vertical layers) streamflow
conditions.

3. Measurethe wetted width within the transect (the distance betweenthe REW and the LEW)
and determine station spacing (Table 6).

a. Ifthe wetted width is >2.00m:
1) Divide the transectintoroughly 20-25 sampling stations.

2) Space stations evenly and at wider intervals where flow conditions are homogenous and
more closely together where flow conditions are non-laminar (Figure 12).

3) Maintaina minimum 0.05m station spacing to avoid duplicate measurements between
stations.

b. Ifthe wettedwidth is<2.00m:
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1) Divide the transectintoas many stations as possible without duplicating measurements

between stations
a) Maintaina minimum 0.05m station spacing.

b) Obtaining 20-25 stations may not be possiblein very narrow streams soless

sampling stations are permitted.

c) The goalis to obtain a well-distributed velocity profile while avoiding duplicate

measurements between stations.

4. Discharge measuredat asingle stationshould not exceed 10% of the total measured discharge
across the transect.

a. If non-uniform flow conditions are present (more concentrated areas of high flow within the

transect):

1) Increasethe number of sampling stations sothat a higher number of stations are
concentratedalong the part of the transect with greatest flow (Figure 13).

a) This will aid in distributing discharge measurements across a greater number of

stations.

5. Proceed with discharge measurement collection once station widths have been properly set.

Table 6. Station spacing of the discharge transect relative to wetted width using the Flowmeter Method at
wadable streamssites.

Wetted . .
Station Spacin
Width (m) pacing
Divide the transect intoas many stations as possible without measuring duplicate velocity
<2.00 profiles between stations. Maintaina minimum 0.05m stationspacing. Obtaining 20-25

stations may not be possible in very narrow streams. Asingle stationis not to account for
>10% of the overall total measured discharge

Divide the transectinto roughly 20-25 sampling stations. Space stations evenly and at wider
intervals where flow conditions are homogenous and more closely together where flow
>2.00 conditions are non-laminar. Maintaina minimum 0.05m station spacing to avoid duplicate
velocity measurements between stations. Asingle stationis not to account for >10% of the
overall total measured discharge.
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Figure 12. Example of well-distributed stations across a discharge transect at a wadable stream site using the
Flowmeter Method. Note that laminar flow is assumed in this example. S0-S12 represent stations and dashed

rectanglesrepresent sub-sections.

Sampling
Points

Right Edge of Water

Left

Edge of Water

Figure 13. Example of uneven station spacing acrossa discharge transect at a wadable streamsite using the

Flowmeter Method. Note that non-laminar flow is assumedin this example.

B.2 Proper Techniques andFile Setup

When collecting a discharge surveyin a wadable stream using the Flowmeter Method the wading rod is

to be held directly in front of the operator (at arm’s length) at each stationalong the transect. The
sensor bulb on the flowmeter must be pointed directly upstreaminto the flow and perpendicular to

meter tape.
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Do not stand upstream or downstream of the velocity meter but rather to the side (i.e. towards the right

bank). Standing directly in front of or behind the flowmeter would create conditions that would cause
errors in the velocity readings.

To set up adischargefile on the handheld flowmeter:

1.
2.

B.3

Turn the unit on by holding on the ON/OFF button.

In the main menu, select “Profiler” and press OK.

Under “Enter Operator Name”, enter the technician’s initials that is collecting the measurement

and press OK.

Select “Stream” and press OK.

Select “Enter name for Stream” and press OK.

Enter the 4-letter site code for the stream name (i.e. “ARIK”) and press OK.

a. Note: Special characters, numbers, or any other deviations from the 4-letter site code will
prevent the discharge file from being uploaded.

Select “Enter Stage Reference” and press OK.

a. Note: Discharge should not be measuredif a staffgaugeis either not installed, or is

displaced at the site. The only exception is if dischargeis being conducted during a

reaeration sampling bout.

b. Submit atrouble ticket to Science.

Enter the water level on the staff gauge.

a. Note: During periods of moderate to high flow, waves may be creating fluctuating water

levels at the staff gauge.

b. Intheseinstances observe where the water level hits the gauge at the highest and lowest

crest and record the value between those as the stage reference value.

c. Submit atrouble ticket to Science if the accuracy of a staff gauge measurementis in

question.

Collecting Velocity and Depth Measurements

Once stationspacing has been determined, navigate to the first station (01) along the meter tape atthe

right edge of water (REW) to begin the discharge measurement. Assess whether the right bank is

undercut or not and follow the appropriate steps tobegin the discharge measurement.

Setting the first stationif the right bank is undercut:

1.

Enter Edge/Obstruction = “Right”, as this is at the first station, the REW.
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Select “Dist. To Vertical” value.

a. Estimatewherethe edge of wateris located along the metertape and enter this value.
Sometimes it’s helpful to stick your foot or the flowmeter rod under the bank to help with
this estimate.

Enter a Station Depth of 0.00m and select “Set Depth”.
Note that with a depth of 0.00m entered the flowmeter will not allow you to measure velocity.
Scroll down to the screenand select “Next” to measure velocity at the next station.

Place the next station (02) just outside of where the bank meets the edge of water. Choose a
stationlocation that is close to the bank but allow some space so that the bulb of the flowmeter
is not touching the side of the bank. Keep in mind that the velocity measured at this location
will be extrapolatedtothe right edge of water.

Continue to Step 3 below to measure velocity at sub-stations across the transect towards the
left bank.

Setting the first stationif the right bank is not undercut:

1.
2.

Enter Edge/Obstruction = “Right”, as this is at the first station, the REW.

If prompted, enter Edge Factor = “0.75”. This is the standard edge factor value for all NEON
aquaticsites.

Select “Dist. To Vertical” value. Enterthe value where the stationlocation falls along the meter
tape.

Determine the station depth.

a. Position the base of the flowmeter rod flat on the bottom of the streambed and note where
the stream surface meets the graduated marks etched into the flowmeter rod.

b. Graduatedmarks are etched into the flowmeter hexagonalrod to allow for water depth
measurement.

1) The marks are delineated into 2 cm (one band mark), 10 cm (two band marks — the
bottom double band), and 50 cm (three band marks).

c. Waterdepth measurements should be rounded to the nearest 1 cm.

d. If needed, practice this step prior to collecting the discharge measurementinorder to
familiarize yourself with the increments.

e. Ifthe bankangleis negligible atthe water’s edge thenthe depth is typically zero, as this is
the point where the water meets the surface.

1) Adepth of 0.00mshould then entered and velocity cannot be measured.

a) Ifthisis the case press OKand proceed to the next station.
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Select “Set Depth” to enter the depth value at the station.
Select “Measure Velocity” (if depth >0.00m) and press OK.
Determine Velocity Point Method: one-point (60%), or two-point (20% and 80%) (Table 7).

a. If stationdepthis <0.45m, collect a one-point velocity measurement at 60% of the depth
below the surface.

b. This velocity measured at this point of the water column is assumedtoequal the mean
velocity within the sampling station.

c. See Section A.5.2forinstructions on setting the flowmeter rod to the appropriate depth.

If station depth is >0.45m, collect a two-point velocity measurement at 20% and 80% of the
depth below the surface.

a. The average of these two measurements inassumed to equal the mean velocity within the
sampling station.

b. See Section A.5.2forinstructions on setting the flowmeter rod to the appropriate depth.

c. One-point (60% depth) and two-point (20% and 80% depth) measurements are relative to
the stream surface equaling Om.

1) For example, if station depth = 0.50m, the first of the two-point velocity measurements
(20% depth) would be collected 0.10m below the water surface, or 0.40m above the
streambed.

2) The second of the two-point velocity measurement (80% depth) would be collected
0.40m below the water surface, or 0.10m above the streambed.

Select “One Point” or “Two Point” Velocity Method depending on depth.
Set the wading rod to appropriate depth.

a. The wading rod must be adjusted in order to set the velocity meter at the correct depth in
the streamflow (Figure 14).

b. The round sliding rod (located behind the hexagonal rod) is used to set the measurement
depth and is scaled with 0.10m graduations from top (0.00m) to bottom.

c. Asmallerscaleon the handle of the hexagonalfixed rod is used to fine-tune the depth, and
is scaled with 1 cm graduations (0 to0.1m).

Listed below are three examples on how to collect velocity measurements at desired depths on
the wading rod. See Section B.1to determine the amount and locations of velocity
measurements required for various water depths in the field.

a. One-Point Velocity Method: 60% Depth, Station Depth = 0.36m

1) The one-point velocity method requires no calculations by the user.

SOPB
Page 37



@_

12.

13.

14.

15.

b.

n c) n Title: AOS Protocol and Procedure: DSC — Stream Discharge Date: 03/16/2022
e ®

Operated by Battelle [ yEoN poc, #: NEON.DOC.001085 | Author: N. Harrison Revision: H

2) Line up the 3 on the sliding rod (represents 0.30m total station depth) with the 6 on the
handle of the fixed hexagonal rod (represents 0.06m total station depth).

a) Coupled, these two settings set the flowmeter at 60% of station depth 0.36m.
Two-Point Velocity Method: 20% Depth, Station Depth=0.72m

1) Multiply the station depth by two (0.72 *2 = 1.44 m) and round to the nearest
centimeter (1.44).

2) Line up the 14 on the sliding rod (represents 1.40m of the total station depth) with the 4
on the handle of the fixed hexagonalrod (represents 0.04m of totalstation depth).

a) Coupled, these two settings set the flowmeter at 20% of the stationdepth at 0.72m.
Two-Point Velocity Method: 80% Depth, Station Depth=0.72m

1) Divide the stationdepth by two(0.72 / 2 =0.36 m) and round to the nearest centimeter
(0.36).

2) Line up the 3 on the sliding rod (represents .30m of the total station depth) with the 6
on the handle of the fixed hexagonalrod (represents 0.06m of the total station depth).

a) Coupled, these two settings set the flowmeter at 80% of station depth 0.72m.

Once the flowmeter has been set to the correct depth and the correct velocity method has been
selected, select “Capture” onthe handheld flowmeter to begin measuring velocity.

The screen will display a graph showing the instantaneous values and the progress of the
reading.

If velocities appear to be inaccurate or are fluctuating > £5%, repeat the reading.

If repeated velocity values seeminaccurate or are fluctuating >5% during the measurement
collection, consider the following causes:

d.

Streamflow is turbulent. Increase the Fixed Period Averaging Time to 60 seconds in the
Filter Parameters settings (See Section A.4).

There is an obstruction immediately upstream or downstream of the stationlocation. Move
the stationlocation so thatis not directlyabove or below the obstruction and try another
velocity measurement.

Flowmeter was not calibrated correctly. Re-calibrate flowmeter and start discharge
measurement over.

Flowmeter is low on batteries. Replace batteries inflowmeter and repeat measurement.

If you cannot diagnose the source of the problem, continue discharge measurement and
submit a trouble ticket explaining the issue.
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f.

Once the measurement has been completed (minimum 40 seconds) press OK to save data
and move to the next stationlocation.

16. Move to the next station location and repeat Steps 3-16. Note that you will not need to enter
an Edge value as these stations should be in open water environments (not along the edge of a
bank or near an obstruction).

17. If the left bank is undercut:

a.

h.

The second to last station should be located just outside of where the left bank meets the
edge of water.

Choose a stationlocation that is close to the bank but allow some space so that the bulb of
the flowmeter is not touching the side of the left bank.

Keep in mind that the velocity measured at this location will be extrapolatedto the left edge
of water.

Enter Edge/Obstruction = “Left”.
Select “Dist. To Vertical” value.
Estimate where the left edge of water is located along the meter tape and enter this value.

1) Sometimesit’s helpful to stick your foot or the flowmeter rod under the bank to help
with this estimate.

Enter a Station Depth of 0.00m and select “Set Depth”.

1) Note that with a depth of 0.00m enteredthe flowmeter will not allow you to measure
velocity.

Proceed to Step 19.

18. If the left bank is not undercut:

Q

Enter Edge/Obstruction= “Left”
Select “Dist. To Vertical” value.
Enter a Station Depth (enter 0.00m if the bank angle is negligible).

Measure velocity (if possible).

19. Once the LEW station has been completed, select “Summarize Collectionand Save Data”.

Observe “Channel Summary” and verify that units are in liters/second.

Verify that the last graph does not contain any red lines (a given vertical contains >10% of
total discharge).

1) If possible return to the stationthat contains >10% discharge and insert an additional
station nearby so that the total discharge per vertical is reduced.
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2) Note thatthis may not be possible under certainlow-flow conditions.

Select “Save Data and Exit”. This s a critical step as all data will be erasedif this is not

completed.

Enter “Name of File”.

Use a unique file name to delineate discharge measurement in the following format

“XXXXMMDD” where:
XXXX = 4-digit site ID (i.e. “GUIL”)
MMDD = month, date of measurement

Example: “GUIL0927”

1) The flowmeter software only allows 8 characters to be used for each filename which
makes it not possible to enter the year of the measurement. As such, at the end of each
calendar year, delete all measurement files on the flowmeter, only after ensuring that

each file on the flowmeter has been
onto the SOM portal.

properly saved on the AOS dropbox and uploaded

Table 7. Velocity point methods based on station depth usingthe Flowmeter Method at wadable stream sites.

Stream Depth at
Measurement Location

Velocity Point Method

< 0.45 meters

One point - 60% of Depth

> 0.45 meters

Two point - 20% and 80% of Depth

Sliding
Total Depth: Rod
0.72 meters Number
20% Depth \\

Total Depthx2=1.44m =14,

60% Depth
Total Depth =0.72m=7,2

80% Depth
Total Depth /2=0.36m =3, 6

Total Depth:
0.72 meters

Flow Direction

/ 21
4
4—rifH=3

Handle

Number

| H

|

i

il siding
Rod

80%
Depth

C o
Sensor H
> .

Figure 14. Wading rod adjustments at 60% (one-point), and 20% and 80% (two-point) depths. Station depth =

0.72m.
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B.4 Evaluating the Discharge Measurement in the Field

Following the discharge survey, the measurement file must be evaluated both in the field prior to
leaving the site and againin the office prior to upload. In addition to impacts todata quality, certain
errors in the discharge file will prevent the file from being uploaded.

The following criteria must be checked prior to leaving the field site (describedin detail below):

e Potential data entry and configuration errors in the measurementfile.
e Percentage of total discharge measured at each measurement station.

e Measureddischarge vs. predicted discharge using the stage-discharge rating curve equation (if
available).

Check for the following data entryand configuration errors in the measurement file before leaving the
site:

1. Station (or location) values are increasing from the right (the first station) to the left (the last
station).

2. Depthvalues were entered correctly (i.e. check decimal points, “0.8” instead of “8”).
3. Depthvalue ata given stationis less than 10 times greater than the preceding station.
a. Ifthiserror occurs than stations were likely set too farapartin the transect.
1) Additional velocity measurements should be collected between stations.

2) Other thanat the left/right edges, zero depth values (0.00m) should not be present

within the discharge transect as continuous, laminar flow is desired throughout the
cross-section.

3) Consider clearing the cross-section of larger cobble in order to connect the transect
hydrologically or move slightly upstream or downstreamto a cross-section where water
is flowing uniformly (more or less) across the transect.

a) Never measure dischargein a cross-sectionthatis under a different hydrologic
control than the staffgauge and pressure transducer.

b) Submit atrouble ticket to Science if the discharge transect was temporaryre-
located to facilitate these conditions.

4. The stream profile name was entered correctly (4-digit site code).
5. The stagereference value was entered correctly.
6. All units were set correctly.

7. The filter parameter was set correctly in flowmeter settings (minimum 40 seconds).

Evaluate the total percentage of discharge collected at each station before leaving the site:
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NEON uses the mid-section method to compute stream discharge. Inthis method, the discharge
transectis divided into rectangular sub-sections. The sub-sectionarea extends laterally from half the
distance from the proceeding station to half the distance to the next station. The width of the sub-
section (variable across the transect)is calculated by subtracting the distance to the previous station
from the distance to next station, then dividing by 2. The area of the sub-section is the width of the sub-
sectiontimes the depth of each station. Discharge per station equals the sub-section area times the
measured velocity. The totaldischarge is the summation of the discharge of all stations.

Most flowmeter models (HACH FH950) automatically calculate discharge per stationand total discharge
per measurement. ldeally, no more than 5% of the total measured discharge should be measured
within a single station, but this can be difficult to achieve in small streams with narrow or irregular
channels. Inthe flowmeter Channel Summary screen, the colors of each graph bar indicate the
following conditions:

e Green: < 5% of totaldischarge was measured at the station
e Yellow: 5-10% of the total discharge was measured at the station
e Red:> 10% of total discharge was measured at the station

In general, no more than 10% of the total measured discharge should be measured within a single
station. Following the discharge measurement, checkthe file to verify that this has not occurred (this
functionality may not be available depending on the make and model of the flowmeter).

If it is observed that >10% of the total discharge was measuredin one or more stations:

1. If>10% of the total discharge was measuredin one or more stations instreams witha wetted
width <2m:

a. Reduce stationspacing by increasing the total number of stations withinthe discharge
transect.

1) Concentrate additional stations inareas with more concentrated flow (maintain a
minimum station spacing of 0.05m).

2) This requirement may be very difficult to achieve in shallow, narrow, and/or irregularly-
shaped stream channels.

2. If, despite these attempts, >10% of the total discharge is still collected in more than one station:
a. Save and upload the discharge measurement.
b. Submit atrouble ticket to Science that documents this occurrence.

Check the measured discharge value against the stage-discharge rating equation, if available:

Once a stage-dischargerating curve has been developed and validated for a site, a rating equation is
derived that predicts discharge given stream stage (supplementary information on rating curves is
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available in Appendix D). Once established, rating equations will be provided to Field Science staff by

Science. Rating equations are commonly expressed as power relationships:

Q=C(G-a)f
Where:

Q= discharge;

G =the stage, or gauge height;

a = the gauge reading corresponding tozero discharge; and

C.and B = rating curve constants

Following the discharge measurement:

1. Enterthe streamstage (G)into the rating equation thatis associated withthe site.

2. Calculate predicteddischarge.

3. Evaluate whether the measureddischargeis +10% of the discharge predicted by the equation.

a. Ifthe measureddischargeis <+10% than predicted discharge:

1) Another discharge surveyis not required.

b. Ifthe measureddischargeis >+10% than predicted discharge (and the stream stage did not

change during the site visit):

1) Conduct another discharge survey immediately.

2) If, aftera second attempt, the measured discharge remains >+10% the predicted rating

discharge:

a) Checkthesecond discharge measurement file for errors.

b) Upload both discharge measurements.

c) Submit atrouble ticket to Science.

(1) This mayindicate a shift in the rating, which, if validated by additional

measurements, would warrant anincreasein the frequency of discharge
measurements at the site. Post-Field Sampling Tasks: Wadable Stream Sites

using the Flowmeter Method
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SOPC Post-Field Sampling Tasks: Wadable Stream Sites using the ADCP Method

Once field verification of the measurement file is complete, the velocity meter, wading rod, and waders
shall be cleaned following standard operating procedures for cleaning field equipment used in aquatic
systems. Batteries for the velocity meter shallbe charged or replaced as applicable.

C1 Document Incomplete Sampling Within a Site

Discharge sampling is scheduled to occur at the prescribed sampling location according to the frequency
and timing described in Section 4and AppendixE. ldeally, sampling will occur at this sampling location
for the lifetime of the Observatory (core sites) or the duration of the site’s affiliation with the NEON
project (gradient sites). However, sampling may be shifted from one location to another when sampling
is compromised. In general, a sampling location is compromised when sampling becomes so limited that
data quality is significantly reduced.

There are two main pathways by which sampling canbe compromised. First, sampling locations can
become inappropriately suited to answer meaningful biological questions — e.g., stream morphology
changes in such a way that the discharge measurement quality is reduced. Second, sampling locations
may be located in areas that are logisticallyimpossible to sample on a schedule that is biologically
meaningful.

For the wadable stream discharge sampling program, a given discharge transect must be sampled during
100% of the bouts expectedfor the site (see AppendixE for the number of expected bouts and
associated site sampling documentation) over a one-year period. Transects that cannot be sampled on
this schedule should be considered compromised.

If sampling at a given transect is not possible during a given bout a trouble ticket should be submitted by
Field Science staff.

To document a missed discharge bout:

1. Createanincident with the following naming convention to document the missed sampling:
‘AOS/TOS Sampling Incomplete: MOD — [Root Cause Description]’

a. Example: ‘TOS Sampling Incomplete: CDW — Could not access plot due to permanently
closed road’

2. Staff scientists review incident tickets periodically to determine whether a sampling location is
compromised.
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Data Entry and Verification: Wadable Streams using the Flowmeter Method

The handheld flowmeter serves as the data collection and storage device for discharge surveys at
wadable streams using the Flowmeter Method. There are no field data sheets for this protocol.

Electronic data should be uploaded via the handheld flowmeter to the appropriate location within seven
days of collection. The maximum timeline for entering data is within 14 days of collection. See RD[04]

for complete instructions regarding manual data transcription.

Export discharge measurement files from the handheld flowmeter to a local computer using the correct

cable type (e.g., a USB to micro-USB cord) using the following steps:

1.

Locate the USB connection port. Plug the correct ends of the connection cord into the display
unit and the computer.

Turn the handheld flowmeter on.

a. A“PVM Drive” should appear on the computer screen.

b. Locatethe utility via My Computer. Two folders should be present: P and RT.
c. Select the “P” folder.

d. Note:if a dialog box appears asking to format the drive, close the window. DO NOT format
the drive.

Select the appropriate file to transfer (e.g., POSE0930.TSV). Copythe file to the computer in the
appropriate folder.

Rename the file if needed (i.e. SITEYYYYMMDD.TSV).
Re-check the discharge files for potential errors as described in Section B.4.

a. Iferrorsarepresentin the.TSV file make appropriate changes in atext editing program (i.e.
NotePad ++) — DO NOT use Microsoft Excel as this will disrupt file formatting.

b. Note thatany changes made to stationor depth values will not change station discharge or
total discharge values.

1) Once the file is uploaded onto the SOM Portal an R-script is generated that re-calculates
stationdischarge and total discharge based on station, depth, and velocity values
contained in thefile. The total discharge value produced from this calculationis what is
ultimate loaded onto the NEON Data Portal.

Upload one copy of the discharge file onto the AOS Dropbox in the appropriate site folder.
Upload another copy of the discharge file onto the SOM/WebUI Portal.
a. Resolve any upload errors that occur (Table 8).

b. If errors cannot be resolved submit a trouble ticket to Science.
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Table 8. Troubleshooting errors encountered while uploading wadable stream discharge files collected with the
Flowmeter Method onto the NEON SOM Data Portal.

SOM Upload Error

Error Description

Resolution

Locations values are not
increasing.

Location values (or meter tape
distances) must be increasing
order in the discharge file.
This erroris usually a result of
a recording typo.

If the erroris clearly
identifiable and canbe
fixed with confidence, edit
the value in Notepad ++
and re-upload the .TSV file.
If it is unknown what the
value should be changed
to, do not upload the
dischargefile.

Depthvalue is greater
than 10 times that of the
previous depth value
(does not apply to the
depth value in the
second vertical).

This is meant to address
recording typos such as
entering “6.50m” instead of
“0.65m”. The second depth
value is not subject to this rule
as oftentimes the first vertical
contains a depth value of Om.

If the erroris clearly
identifiable and canbe
fixed with confidence, edit
the value in Notepad ++
and re-upload the .TSV file.
If it is unknown what the
value should be changed
to, do not upload the
dischargefile.

Invalid profile name. See
line 1 in the .TSV file.

The Profile Name listed on the
firstline of the discharge file
must be the 4-letter site code

(i.e. “ARIK").

Edit the profile name in
Notepad ++ tothe correct
4-letter site code (no
dates, etc.)andre-upload
the dischargefile.

Filter parameter timeis
setto a value less than
10 seconds (i.e. 6). See
line 17 in the .TSV file.

This is a setting in the HACH
flowmeter usedfor fixed point
averaging that controls the
length of time each velocity
measurement was collected.

If this error exists in the
discharge measurement
file it cannot be fixed and

the file cannot be
uploaded. Prior to the
next discharge
measurement, set the
filter parametertimeto =
40 seconds in HACH
settings.

Stage reference value is
>8.00 meters. See line 5
inthe .TSV file.

Observed stream stage for
wadeable stream discharge
measurements is not likely to
exceed 8.00m. This error is
usually a result of a recording

typo.

If the erroris clearly
identifiable and canbe
fixed with confidence, edit
the value in Notepad ++
and re-upload the .TSV file.
If it is unknown what the
value should be changed
to, do not upload the
dischargefile.
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APPENDIXA  DISCHARGE MEASUREMENTS AT WADEABLE STREAM SITES USING THE ADCP METHOD

The following sections provides instruction on how to complete discharge surveys at NEON wadable
stream sites using acoustic Doppler current profiler (ADCP) instrumentation.

A.l Introduction:Discharge Measurements at Wadable Stream Sites Using the ADCP Method

An acoustic Doppler current profiler (ADCP) uses sound to measure water velocity based on the Doppler
Effect, a principal of physics discovered by ChristianJohann Doppler in 1842. Doppler’s principal relates
the changein frequency of a source to the relative velocities between the source and the observer. An
ADCP applies the Doppler principle by reflecting an acoustic signal off small particles of sediment and
other material (scatterers)that are presentin water. The velocity measured by the Doppler principle is
parallel to the direction of the transducer emitting the signaland receiving the backscattered acoustic
energy.

NEON utilizes ADCPs to measure discharge at NEON aquatic sites that contain wadable stream and
rivers. NEON stream discharge measurement collection at wadable stream sites involves mounting a
StreamPro ADCP (TRDI) within a trimaranfloat and utilizing a tethered rope systemto pull the float back
and forth across the channel sothat so that the base of the ADCP is beneath the water surface. The
ADCP contains four beams pointed at 20 degrees from the vertical that can continuously measure water
depth, water velocity, and instrument speed. Discharge and velocity calculations performed by ADCPs
during streamflow measurements are well-documented in the literature (Mueller et al., 2013; TRDI,
2015) but the basic premise is as follows (Den Herder, 2018):

e The ADCPinstrument transmits short pulses of sound at fixed frequencies into the water.

e The transmitted sound bounces off scattered material suspendedin the water (sediment,
microscopic organisms, etc.). The returnedsignals fromthese scatterers are shiftedin
frequency.

e The returned signals from each beam are used to create the water currents in east, North, and
Vertical velocity vectors.

e Returnedsignals are continuously processedinto separate depth cells (or bins) to provide a
profile of the water column

e Binned velocity and depth are integrated to calculate bin discharge, which are then summed to
calculate total discharge

e Multiple discharge transect measurements are completed and mean discharge across transect
measurements is calculated and reported as total discharge.

The ADCP measures the relative motion of the water to the ADCP by correcting the measured water
velocity with the measured velocity of the vessel usedto deploy the instrument (boat, trimaranfloat,
etc.). Thevelocity of the vesselcan be calculatedin twoways: externally via a global positioning system
unit (GPS), or internally utilizing ADCP bottom tracking technology. The ADCP divides the water column
into depth cells (or bins) and reports a velocity for each depth cell.
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The ADCP software integrates total bin velocity over the bin depth to obtain bin discharge. The resulting
sub-section discharges are then summed over the width of the cross-section to obtain total measured
discharge for each transect. Certainareas withinthe channel cross-section profile cannot be measured
by the ADCP (at the water surface due to draft and flow disturbance around the instrument, near the
channel bed due to side-lobe interference, and near each bank due to shallow depths). These areas
must be estimated by the ADCP software. Discharge inthe unmeasured upper and lower portions of the
cross-section are typically estimated using a one-sixth power-curve estimation scheme while discharge
in the unmeasured portions of the cross-section near the bank edges are estimated using a ratio-
interpolation method (Simpson, 2001). Total stream discharge is the sum of the total channel discharge
(the sum of all discharge bin values calculated during the discharge measurement transect), the near-
shore discharge measurement onthe left side of the channel and the near-shore discharge estimate on
the right side of the channel. The totaldischarge associated withthe measurementis the mean
discharge of all transects conducted during the sampling bout. On averageit is expected to take an
experienced field crew 30-75 minutes to complete a stream discharge measurement from start to finish.
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Preparing for Sampling: Wadable Stream Sites Using the ADCP Method

Preparing for Data Capture

Prior to leaving the office ensure that the following criteria are met:

E.2

All necessary equipment is gathered and prepared (Table 12)

Make sure GPS is fully charged and batteries in ADCP are fully charged

Setup ADCP and GPS on trimaran float

Setup and test Bluetooth communications betweenthe ADCP and laptop

Setup and test GPS communications

If the site has an approved stage-discharge rating curve, the current rating equation is available
for measurement comparison/validation.

Installing the StreamPro ADCP and SX Blue Il GPS Antenna ontothe Trimaran Float

The StreamPro ADCP and SX Blue 11 GPS antenna (includes electronics housing with sun shield) are used

in conjunction at most NEON wadable stream sites (Appendix E). Both units must be securely connected

to the trimaranfloat (Figure 15) prior to beginning the discharge survey. An Allen wrench and the hand
tool that is provided with the GPS arerequired. This is a one-time installation that must be conducted
upon receiving the instrumentation. Following this installation the full configured unit (trimaranfloat

with ADCP and GPS instrumentation) can be transported and stored as is, with batteries replaced as
needed. The GPS can be removed later at the DSF to charge.

To assemble the StreamPro ADCP and SX Blue || GPS antenna to the trimaranfloat:

1.
2.

Attachthe ADCParmto the bow of the trimaranfloat using thumbscrews.
Pull the StreamPro ADCP through the bottom of the hole of the ADCParm.

a. Line up thearrow on the ADCPto the front of the ADCP arm (facing towards the bow of the
trimaran float).

b. Line up the grooves in the side of the StreamPro ADCP with those in the ADCParm.
c. Pull through all the way but don’t tighten the adjacent thumbscrew yet.

Plug the ADCP cable into the electronics housing.

a. Line up the prongs and twist the outer ring tosecure the cable.

Connect the GPS arm to the GPS antennae using an Allen or adjustable wrench.

a. Hand tightening will cause the antennae to come loose from the arm.

Remove the thumbscrew on the side of the ADCParmin front of the ADCP.

Place the GPS arm over the ADCParm.

a. Make surethatthe thinner side of the GPS arm rests onthe front left side of the ADCParm.
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10.

11.

12.

13.

14.

15.

Slide the thumbscrew through the hole in the GPS arm and tightento connect it to the ADCP
arm. Ensure this is tight as this screw and arm secure the sensorin place by tightening the
clamp/opening.

Remove the front plate of the ADCP electronics housing by disconnecting the three
thumbscrews.

Remove the battery pack and insert 8 charged AA batteries.
Insert battery packand replace front plate of the ADCP electronics housing.

a. Make surethe thin rubber lining is still in place around the top of the battery pack
enclosure.

b. Remove batteries following Bluetooth configuration and testing sothat they do not drain.

Remove the two corner screws that connect the GPS battery pack to the GPS electronics
housing.

a. Thesearethe screws thatline up tothe holes in the GPS sun shield.
b. Thesescrews are no longer used in the assembly.

Using the two sets of GPS hardware provided (screws, spacers, washers) connect the GPS
sunshield to the base of the GPS electronics housing (at the battery pack).

Connect the GPS sun shield to the top of the ADCP electronics housing using the four
thumbscrews.

Connect the GPS antennae to the GPS electronics housing using the thin copper cable.

a. The straight end of the cable connects tothe GPS antenna, the angled end connects to the
GPS electronics housing.

Installationis now complete. The unit can remain installed as is during times of transport,
measurement use, and storage.
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: GPS electronics housing

-GPS copper-cable.

StreamPro ADCP

() =
ADCP electronics housing

Trimaranfloat

Figure 15. Above: Trimaranfloat, StreamPro ADCP, and SX Blue Il GPS antenna components; Below: Illustrated
workflow (top left to bottom right) detailing how to configure the StreamPro ADCP unitand SX Blue Il GPS antenna
to the trimaran float.
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Installing the RiverPro ADCP and Hemisphere V102 GPS Antenna ontothe Trimaran Float

The RiverPro ADCP and Hemisphere V102 GPS antenna + electronics housing are used at select NEON
wadable stream sites (AppendixE). Both units must be securely connected to the trimaranfloat (Figure
16) prior to beginning the discharge survey. Note that the trimaran float used to house the RiverPro

ADCPis alarger model thanthe one usedto house the StreamPro ADCP.

To assemble the RiverPro ADCP and Hemisphere V102 GPS antenna to the trimaranfloat:

1.
2.

10.
11.
12.
13.
14.
15.

Unfold the outrigger hulls from main hull by removing the pin in the bridle.

Connect the RiverPro ADCP to the GPS mount using M6 socket head cap screws (5mm Hex) and
flat washers.

Insert the ADCP mounting plate into the moon pool lid.
Connect the ADCP cable from the trimaran float.

a. Ensurethatthe Teledyne logo (flower) lines up when it the cable is pluggedinto the ADCP.
The instrument will not work if the cable is plugged in upside down.

Connect the GPS cable to the Hemisphere V102 GPS and attach the GPS antenna to the GPS
mount using 4 M8x16mm screws with lock and flat washers.

Attachthe support braces, ADCP mounting plate and the GPS mount (with GPS antenna
attached)to the main hull by aligning screw holes and tightening thumb screws.

Attach the GPS cable to the main hull by unscrewing the yellow cap and tightening the cable
connecter tothe port.

a. Thesearethe sametype of cable connectors on the GPS antenna, ensure that the port is
aligned, push in to connect, and rotate to tighten the connection.

Unscrew the capto the electronics compartment.

Insert the 12V batteryinto the foam block to the secure battery.

Connect the two internal cables (GPS and ADCP/battery) within the compartment.
Connect the black spade lug connecter to the battery negative terminal.

Connect the red spade lug connector to the battery positive terminal.

Close and tighten the electronics compartment lid so that it is completely sealed.
Unfold the rear boat fins.

During operation and testing, turnon the main power switch located on the main hull to power
the ADCP and GPS units.
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Figure 16. lllustrated workflow (top left to bottom right) detailing how to configure the RiverPro ADCP unitand the
Hemisphere GPS antennato the trimaran float.
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E.4 Establishing Bluetooth Connections forthe ADCPand SX Blue Il GPS antenna

The StreamPro ADCP and SX Blue Il GPS antenna communicate with WinRiver Il software (installed on
the laptop) wirelessly via a Bluetooth (wireless) connection. Two Parani SD1000U Bluetooth
transmitters, or dongles, are required to send data — one for the ADCP and one for the GPS antenna. It is
a good idea to have an extra dongle on hand in the field as a spare. The ParaniBluetooth dongle
contains a USB interface adapterthatis pluggedinto alaptop COM port. Parani Bluetooth dongles are
setupand configured using ParaniWin software. This executable must be downloaded and installed on

the laptop used for ADCP discharge measurement.

If the same laptop is used for ADCP measurements (this is recommended for ease of communication
setup and software availability) the following setup should only need to occur prior to the initial
measurement. Following the initial setup, the ADCP and GPS antenna should automatically connect to
the laptop software via the dongles. These steps should also be used when troubleshooting connection
problems. Setup, testing, andtroubleshooting is best done in the office prior to deployment in case an
internet connection is needed. An ADCP discharge measurement cannot be completed if Bluetooth
communications are not properly configured.

To avoid confusion, it is helpful to label one dongle “ADCP” and the other “GPS” and place a sticky note
near the laptop port each are plugged into that designates an “ADCP” or “GPS” connection.

Physically configure the ADCP and the GPS Bluetooth dongles (Figure 17):

1. EachParanidongle has aset of four DIP switches that are used to set the Bluetooth adapter’s
baud rate and data flow control.

2. These DIPswitches need to be in the correct physical configuration using a small screwdriver,
pocket knife, pen, or similar tool.

3. Move the DIP switches tothe correct position in order to set the Baud Rate to 11520Kb on both
Parani dongles. The diagram on the left of each dongle shows which how the positions of each
switchrelate to baud rate configuration.

4. Set the firstand second DIP switches tothe right.
5. Set the third switchto the left (115200 baud rate)

6. Set the fourth (bottom) switch to the left (HW Flow Control OFF).
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Figure 17. Top: Parani-SD1000U USB Bluetooth Adapter with default settings. Bottom: Correct settings for ADCP
and GPS Bluetooth configuration.

Once physically configured, each dongle needs to be initially setup with the ParaniWin software.
Complete the following steps for the ADCP dongle, then repeat for the SX Blue Il GPS dongle (note that
this information is also contained in the document entitled “Guidance for StreamPro Bluetooth setups”
thatis included with all ADCP materials):

4

1. Ensurethatthe ADCPand GPS units are powered and fully connected to the trimaranfloat.
2. Plug the Paranidongle into a USB port on the laptop.

3. Use Windows Device Manager to determine the laptop COM (communication) port that the
Paraniis assignedto.

a. Navigatetothe Windows Device Manager.
1) Start Menu > Search “Device Manager”
b. Open the “Ports (COM & LPT)” node.

c. Note the COM port number assignedto.
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1) Unplug and re-connect the Paranidongle to note which COM Port number appears and

re-appears. Thisisthe COM Port the Parani dongle is assigned to.

(1) If using Windows XP and later systems, the driver will likely load automatically
when you plug in the Parani dongle.

(2) If the Paraniis not showing up in the Ports (COM & LPT) node, it may show up in
the “Other Devices” node.

(a) Ifthisis the case anupdate to Parani firmware is required (under the
picture of the dongle, find the Downloads tab, click on the firmware link,
and click the download button to save the file to a known folder).

(b) Once complete, open Windows Device Manager, right click on the
appropriate COM Port that the Parani is assignedtoand navigate to the
Drivers window.

(c) Choose “Browse my computer software for driver software”. Clicknextand
it will respond with a message of success or failure.

(d) If successful, close this window and return to Windows Device Manager.
The Paranishould now appear under the COM Ports node.

(e) If unsuccessful contact Science for troubleshooting.

d. Select the Parani SD100U dongle COM Port and set the baud rate to 115200.

1) Rightclick on the COM port assignedtothe Parani dongle and select “Properties” >
“Port Settings”.

2) Configure Port Settings.

a)
b)
c)
d)

e)

Bits per second =115200.
Data bits = 8

Parity = None

Stop bits=1

Flow control = None

3) Click on the Advance Settings button.

a)

b)

c)

Check the COM Port number assigned tothe Paraniin the top of the Advanced
Settings window.

In the BM Options section, select the Latency Timer drop down and set to 1msec.

Click OK twice to exit Windows Device Manager.

4. Note the LED indicators on the Parani dongle.
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The “Mode” LED indicates which mode the Parani dongle is currently configured to.
Ensure the Parani dongle is setto MODE1, the LED will blink green at 1 second intervals.

The “Connect” LED indicates whether the Parani dongle is connected to the ADCP/GPS unit,
the LED will blink green at 1 second intervals.

5. Open ParaniWin software to configure the Bluetooth connection.

a.

The UART Setting window will automatically pop up that displays the communication
settings between the Parani dongle and the laptop. Ensure that the configured settings are
set correctly. Notes: these settings must COM Port and physical dongle settings or the
connection will not be possible.

1) Serial port: Select the laptop COM port number the Paranidongle is assighedto (as
shown in Windows Device Manager).

2) Baud rate: 115200

3) Parity: None

4) StopBit: 1

5) Click “OK”. Initial configuration should be complete.
Select the “Device Setting” tab.

1) Set “Operation Mode” to “Model”.

2) Check that Device Settings are the same as what was entered in the UART Setting
Window.

3) Under “Security Option” check the “Authentication” box and enter “0000” for the “Pin
Code”.

4) Click “Apply”.
5) A “Completed Configuration” message should pop up.

a) Ifthe connection was unsuccessful: review physical Parani dongle settings, COM
port settings in Windows Device manager, and settings enteredin ParaniWin and
repeat process.

6. Select the “Connection (out)” tab.

a.

Click the “Search” button. This will ping all available wireless networks that are within range
of the laptop.

Chose the desiredinstrument to connect to and click “Connect”.
1) The ADCPshould be shown as “RDI SPro”.

2) The GPS should be shown as “iX Blue GPS".
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a) Theselabels mayvary.
3) Click “Connect”.
c. A window will pop up with a “Connected successfully message”.

d. One of the lights on the ADCP will turn blue, indicating that the Bluetooth connection was
successful.

1) If the connection was unsuccessful:

a) Review physical Parani dongle settings, COM port settings in Windows Device
Manager, and all settings enteredin ParaniWin.

b) Repeat process.
7. Repeattheabove steps for the GPS dongle.

8. Once both ADCPand GPS dongle connections have been successfully connected, close the
ParaniWin program.

a. IftheParaniWin programis not closed, WinRiver Il will notbe ableto connect to the

ADCP.

E.5 Testing GPS and ADCP connectionsin WinRiverll

Once both ADCP and SX Blue Il GPS dongle connections have been successfully connectedvia Bluetooth,
the connections must be testedin WinRiver Il in order to ensure that data can be transmittedto the
program. This must be done prior to each discharge survey that utilizes ADCP instrumentationand is
best completed in the office in case additional troubleshooting is needed.

1. Ensurethatthe ADCPis fully powered (greenlight on) and setup for Bluetooth communications
via the Paranidongle (blue light on).

2. Open WinRiver Il.
3. Inthe WinRiver Il main screen, click Configure > Peripherals.
a. Test ADCPcommunications.

1) Ensurethatthe ADCPis fully powered (greenlight should be on) and the ADCP Parani
dongle is installed in the designated COM Port.

2) Inthe “Peripheral Configuration Dialog” window, under the “Peripherals” node, double
click on “Read Serial Raw ADCP Data”

3) Double click on “Port: ADCP Serial Port”
4) Check that COM settings are correct and press OK.
5) With “Port: ADCP Serial Port” still highlighted, click the “Test Port” button on the right.
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6) A dialogue box will open and you should see some information begin streaming

7)

regarding Teledyne StreamPro firmware. This indicates that the ADCP is recognized by
the WinRiver |l program (Figure 18).

a) If nothing appearsthan WinRiver Il is not recognizing the ADCP.

b) Ensurethat ParaniWin is closed. Ifopen, close this program and repeat the
Peripheral test.

c) If ParaniWinis closed and the Bluetooth connection was successfulinthat program,
check COM settings in “Port: ADCP Serial Port” and repeat the Peripheral test.

d) If nothing appears in the test window continue on to the next step for GPS testing.
Further ADCP testing can be completed in the Configuration Dialogue tab of the
Measurement Wizard window.

Click “Stop” and “Close” to cease testing and close the test dialogue window.

b. Test GPS communications.

1)

2)

3)
4)
5)
6)

7)

Ensure that the GPS antenna is fully powered (greenlight should be on) and the GPS
Parani dongle is installed in the designated COM Port.

In the “Peripheral Configuration Dialog” window, under the “Peripherals” node, double
click on “Read NMEA GPS Data 1”.

Double click on “Port: GPS Serial Port”
Check that COM settings are correct and press OK.
With “Port: GPS Serial Port” still highlighted, click the “Test Port” button on the right.

A dialogue box will open and you should see streaming GPS data (Figure 19). This
indicates that the GPS is being recognized by the WinRiver Il program.

a) If nothing appears than WinRiver Il is not recognizing the GPS.

b) EnsurethatParaniWin is closed. Ifopen, close this program and repeatthe
Peripheral test.

c) If ParaniWinis closed and the Bluetooth connection was successfulinthat program,
check COM settings in “Port: GPS Serial Port” and repeat the Peripheraltest.

d) If nothing appearsin the test further GPS testing can be completed in the
Configuration Dialogue tab of the Measurement Wizard window.

Click “Stop” and “Close” to cease testing and close the test dialogue window.

c. Click “Close” toreturn to the main WinRiver |l screen.

4. Once all configuration and testing is complete ADCP batteries should be removed and stored

with field gear soas not to drain them.
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To setupand test the Hemisphere V102 GPS antenna see detailed steps provided in Section J.4.
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Figure 18. ADCP Test Port Dialogindicating that StreamPro ADCP data is streaming fromthe ADCP to the laptop.
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Figure 19. GPS Test Port Dialog indicating that GPS data is streaming from the GPSantenna to the laptop.
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E.6 Navigate to the Discharge Transect

If a discharge transect, or cross-section, has already been established, the bounds should be
permanently marked using stakes or plot markers (one on eachside of the stream). Navigate to this
location and proceed to Section E.7.

If a discharge transect has not been established at the site proceed with the following steps:

1. Determinean appropriate location to establisha discharge transect.

a. At wadablestreamsites the transect location must be located in the riffle habitat unit in
close proximity (just downstream) of the pool where the staff gauge andsensorset are
installed. Consult with Science if the sensor set location is unknown, has not yet been
established, or if an alternative location is best suited to measure discharge at higher flows.

b. Anideal discharge transect will:

1) Belocated in areasonably straight channel with velocity lines that are more or less
parallel to each other.

2) Containvelocities that are, for the most part, > 0.15 m/s, and depths that are, for the
most part, >0.15m.

3) Containa stable streambed free of obstructions that would create eddies, slack water,
and turbulence.

4) Containmeasurement sections that are roughly parabolic, trapezoidal, or rectangular.
5) Containa stable downstream control feature.
c. Takea picture of the transect locationthat best meets this criteria as well as the

downstream control feature and send to Science for consultation.

E.7 Assess the Discharge Transect

Prior to collecting the discharge measurement identify any instrumentation or environmental issues that
would negatively affect data quality. Document any temporary hydrologic conditions in the (AOS) Field
Metadata and Gauge Height [PROD] app in Fulcrum. If conditions are unfavorable to discharge
measurement collection, submit a trouble ticket and consult with Science.

Unfavorable conditions include, but are not limited to:

1. The staffgaugeis either not present or has been displacedin some way.

a. Adischarge measurement should not be collected if a staff gauge is not present at the site
or the gauge has been displaced in any way.

b. Submit atrouble ticket to Science thatincludes photos of the gauge.
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c. Ifthe staffgaugeis topped during high flows and a discharge measurement can be safely

collected, attempt to markor in some way reference the elevation of the edge of water
(only do soif this can be accomplished in a safe manner). A future survey of this location

(relative to the staff gauge) can provide an estimate of gauge height during the

measurement.

d. Note thatif a discharge surveyis associated witha reaeration sampling event, discharge

should still be measured regardless of staff gauge presence.

2. Apressuretransduceris either not present or has been displaced in some way.

a. Adischarge measurement may be collected in the event that the pressure transduceris

missing or has been displaced. However the absence of this instrument prevents continuous

discharge from being estimated.

b. Submit atrouble ticket to Science immediately if the pressure transducer is missing or has

become displaced.

3. Streamflow is exceeding the banks causing unsafe conditions on the floodplain.

a. Referto NEON Operations Field Safety and Security Plan (AD[02]) for details.

4. There is an insufficient amount of water in the channel or bed conditions are not suitable to

conduct ADCP velocity measurements.
a. Consider using the Flowmeter Method.

b. See Section4.2.1.

5. Referto NEON Operations Field Safety and Security Plan (AD[02]) and NEON Operations Field

Safety and Security Plan (AD[02] for further details.
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SOPF Field Sampling: Wadable Stream Sites Using the ADCP Method

F.1 Installthe Temporary High Line ADCP Deployment Assembly

The Temporary High Line is a mechanical assembly used to deploy ADCP’s withtrimaran floats at NEON
wadable streamsites. A guideline runs through a tripod system and across the channel to orient the
trimaranfloat in the streamflow. An additional line runs through the guideline and is supported by crew
members on eachside of the streamthat work together to pull the float steadily across the discharge
cross-section.

The TemporaryHigh Line is comprised of the following components (Figure 20):

e Tripod (supports the winch and pulley posts on the near bank, levels the guideline)

e  Winch post (connects to pulley post, tightens the guideline)

e Pulley post (connects to winch post, guides the guideline)

e Guideline rope (rope or twine that is set between the tripod on the near shore and a fixed point
on the opposite shore, orients the float as itis pulled across the channel by the Control Rope)

e Guideline support (metal tube that connects the Guideline rope to Trimaranrope)

e Guy wire + earth anchor (supports winch post/pulley post/tripod assembly on the near bank)

e Guy wire driving rod (support guy wire)

Additional materials required:
e Control rope (long length of rope used to pull the float back and forth across the channel)

o Strong rope such as climbing rope is recommended.

o Lengthrequired: twice the wetted width of the stream + extra length to accommodate
the distance between the wetted width and where staffare operating the rope on both
banks.

e Trimaranrope (a short section of rope that connects and orients the float off the Guideline
rope).

o Strong rope such as climbing rope is recommended.

o Lengthrequired: dependent on surface water velocity conditions during the time of the
measurement (maximum length needed is not likely to exceed ~1.5 meters).

o Highervelocity levels mandate a longer section.

o Lower velocity levels mandate a shorter section.

e Carabiner (connects the float to the Trimaran rope)

o Locking carabiners are recommended.

o Two sparesarerecommended.

e Asmallhammer to drive the guy wire earthanchor into the substrate.
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PQI‘ley post

Winch post

Figure 20. Parts included with the Temporary High Line Assembly.

To assemble the Temporary High Line (Figure 21):

1. Remove the wingnuts on the top of the winch post.

N

Slide the base of the pulley post into the top of the winch post.
Set connect winch and pulley at an angle into the tripod.

3
4. Set the winch handle so thatis facing away from the winch gears.

o

Loop the guideline through the two holes on the side of the winch and knot them together.

o

Crankthe winch handle so that the guideline is looped through the winch assembly.

7. Once a sufficient length of guideline is looped through the winch assembly bring the end of the
guideline over the pulley (at the top of the pulley post) and through the hook.

8. Securely attachthe end of the guideline to a point on the opposite bank keeping in mind the
following criteria.

a. Atree, post, or stake canbe usedto secure the guideline on the opposite bank so that it is
very sturdy and will not move during the measurement.

b. The guideline should be slightly upstream (~ 0.5 — 1.0m) of the discharge transect.
c. The guideline must be perpendicular to the streamflow.

d. The guideline should be nearly level from the near to opposite bank.
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Lock the winch by setting the trigger tab at the top of the assemblyto “ON”.

Crankthe winch until thereis no slackin the guideline betweenthe tripod and the opposite
bank.

Attachthe guy wire to the base of the winch post using the carabiner and thread this wire
through the notch at the very bottom of the post.

Set the driving rod into the guy wire earthanchor and hammer the rod into the substrate to
refusal.

On the Guideline support, line up the space betweenthe white plasticlockers and the space
that runs along the length of the bracket.

Attachthe Guideline support to the Guideline between the tripod and the opposite bank.
a. Place the guideline through the carabiner.

b. Slide the guideline through the space along the length of the Guideline support (sothat the
guideline is inside the metal tube).

c. Twist the white lockers to hold the guideline in place within the Guideline support.
Connect the middle of the Control rope to the carabiner on the Guideline support using a knot.
Installthe ADCP and GPS in the trimaranfloat (Section E.2) and turn both units on.

Bring the Guideline Rope with the Guideline support to the edge of water on the near bank.
Attach the section of Trimaranrope through the carabiner on the Guideline support.

a. Adjust the length of the Trimaranrope based on the surface water velocity conditions.

b. Set the lengthof the Trimaranrope so that the boat lies flatin the water and the surface
velocity maintains the orientation of the bow pointed upstream.

1) Duringlow velocity regimes the Trimaran rope should be shorter.
2) During high velocity regimes the Trimaran rope should be longer.
Remove the transducer cap on the bottom of the ADCP that protects the beam lenses.

Gently place the trimaran float in the water to let sensors equilibrate. Secure both end of the
Control Rope to keep the float in position prior to the first measurement.

Page 67



n e c’ n Title: AOS Protocol and Procedure: DSC — Stream Discharge Date: 03/16/2022
®

Operated by Battelle [ yEoN poc, #: NEON.DOC.001085 | Author: N. Harrison Revision: H

Control Rope

Figure 21. Assembling the Temporary High Line.

F.2 Practice Operating the High Line Assembly

If needed, practice pulling the trimaran float back and forth across the channel to get comfortable with
the High Line operation prior to measurement collection.
The High Line Assemblyis operated as follows:

1. One person stands on each side of the bank holding the Control Rope.

2. The Control Rope should always be held taught tolimit lateral movement of the float.

3. Tomove the boat across the channel the person on the bank where the boat is headed must
gently pull on the Control rope while the person on the opposite bank gentlyreleases the
Control rope.
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a.

b.

The Control Rope must remaintaught during this operation.

Gloves are recommended to limit hand abrasion from the rope.

The float must be moved at a slow and steady pace with the bow of the float pointed upstream.

a.

b.

Sudden movements of the float will adversely affect data quality.

Eachtransect measurement must last a minimum of 180 seconds. Itis helpful for staffto call
out the measurement duration during the measurement in order to adjust float speeds if
needed.

Ideally the speed of the float should be below the water velocity, although this can be very
difficult during low flow regimes.

1) Inall conditions a steady operation of the float across the channel is paramount.

Practice bringing the trimaranfloat back and forth across the channel until boat staff members
are accustomedto the operation.

Start a New Measurementin WinRiverll

Once the trimaranfloat and High Line Assembly are properly configured, a new measurement file can be
created using WinRiver |l software.

1.

Set the laptop system time zone to UTC (Coordinated Universal Time).

Start the WinRiver Il program.

In the WinRiver Il main screen, click Configure > Units > All SI to set units to metric.

In the WinRiver Il main screen, click File > New Measurement to run the Measurement Wizard.

Fill in all information in the Site Information tab:

a.

Station Name: Four digit site code of where you will be measuring discharge (i.e. “TOMB”).
Station Number: Leave blank.

Measurement Number: The sequential discharge measurement number for the site.

Agency: “NEON”.

District: Leave blank.

Hydrologic Unit: Leave blank.

Field Party: Initials of all crew involved in measurement.
1) Separateinitials with a comma delimiter (i.e. NH, LFS).

Processed By: Initials of technician operating the WinRiver |l software and evaluating data

collection.
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Deployment Type: “Trimaran Float”.
Boat/Motor: Leave blank.

Meas. Location: If measured at the regular discharge cross-section enter “DSC1”, if
measured at a different cross-section within the site denote that with a different code here,
(i.e. “DSC_US" if the cross-sectionis upstream of the regular location).

1) Make sureto alsoinclude notes in the main remarks section that describe alternative
transect locations (be sure to include an estimate of how many meters awaythe
measurement was conducted from the regular location).

a) Toadd a note to the main Remarks section of the measurement file, right-click Site
Information on the Measurement Control window.

b) Enter notes into Remarks section.

Grid Reference: Leave blank.

6. Select the “Rating Information” tab.

a.

b.

Inside Gage Height: Enter the water level measurement on inside of staff gauge.
Outside Gage Height: Same value as “Outside Gage Height”.

Rating Discharge: Enter the predicted discharge given gauge height from rating curve, if
available.

Index Velocity: Leave blank.
Rated Area: Leave blank.
Rating Number: Leave blank.

Water Temp: Enter the water temperature (°C) measured using a thermometer submerged
in the stream for atleast 5 minutes.

1) The measured water temperature should be within 2 degrees of the ADCP temperature
measurement.

a) Tocheck the temperature being measured by the ADCP, open the Test Result
dialogue box under the QAQC > ADCP node. The measured temperature will be
displayed along with other sensor data.

b) You can alsoview temperature time series data during or aftera transect
measurement by selecting View > Graphs > Time Series > Temperature.

c¢) The ADCP must be sitting in the water for at least 5 minutes to allow the instrument
to fully equilibrate to the water temperature.

d) Ingeneral ADCPtemperature measurements do not drift until there is a major issue.
If this does occur, the ADCP-measured temperature will deviate greatly from the
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thermometer measurement. If this is the case make a note in the measurement
note window and contact Science following the measurement bout.

h. Tail Water Level: Leave blank.
i. MagnVariation Method: Model.

j-  Measurement Rating: fill this out at the end of the measurement based on your judgment of
the measurement quality.

1) This is a subjective assessment. Discretionis givento the hydrographer who led the
survey. Include any relevant field notes that formulated the basis of this ratingin the
remarks section.

k. Control Codes: select anythat apply to the measurement.
I.  Wind Speed: Enter the measured wind speed (kph) using an anemometer.

1) If wind speed was enteredin units other than kph, note the units used in the remarks
section.

m. Wind Direction: Enter the measured wind direction using an anemometer.
1) If the anemometer does not provide a direction measurement enter:
a) “Upstream”:ifthe wind is blowing up from upstream to downstream.
b) “Downstream”:ifthe wind is blowing from downstream to upstream.
c) “Cross-wind”:if the wind is blowing across theriver.
d) “Mixed”:if the wind is not blowing in any particular direction.

n. Edge Method: Enter the method used for determining bank distances (i.e. laser rangefinder,
meter tape, eye estimate, etc.).

7. Select the “Configuration Dialogue” tab.
a. The software will immediately tryto recognize the ADCP (“Interrogating the ADCP...”).
1) If the connection is successful, the button next to “ADCP” will eventually turn green.
a) This cantake afew minutes.

b) This means that the software recognizes the ADCP via the ADCP Parani Bluetooth
dongle.

c) The connection should be successful if the ADCP Peripheral test was a success.

d) If awindow pops up thatsays “The ADCPis not responding...” this means that the
ADCP was not recognized by the software.

(1) Click “No” (“Yes” will have the software cycle through all available ports).
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(2) Ensurethat ParaniWin configuration was successful for the ADCP dongle and
that the softwareis closed.

(3) Inthe “Serial Communication Settings” window, ensure that COM Port settings
match what was entered in ParaniWin software. Click OK.

(4) If the “The ADCPis not responding...” message returns, click Cancel.

(5) Inthe “ADCP” dropdown, ensure that the correct ADCP model (StreamPro) is
selectedin the dropdown box. Click the “Check ADCP” button to re-test
configuration.

(6) The ADCP must be recognized by the software for the discharge measurement
to be conducted. If communication problems persist, submit a trouble ticket and
contact Science.

b. Check GPS configuration settings.

1) Ensurethatthe GPS antenna is attached, powered and properly configured within the

2)

3)

trimaranfloat.

If using the SX Blue Il GPS antenna (most NEON wadable stream sites):

a)
b)

c)

Check the “External GPS” box.
The greenlight indicates that the GPS antenna is recognized by the software.
An error message indicates that the GPS is not recognized by the software.

(1) Press OK twice. Oftentimes trying toconnect a second time will be successful.
If software still fails to recognize the GPS antenna:

(a) Checkthatall cables are securely connected.

(b) Check the COM port settings are correctly configuredin Windows Device
Manager, ParaniWin, and WinRiver II.

(c) Re-test GPScommunications in Configure > Peripherals.

(d) If GPSis unable to be integrated withthe software the discharge
measurement should still be conducted.

(e) Document this occurrence as a note in the Remarks Section and submit a
trouble ticket to Science.

(f) Continue with the discharge measurement.

If using the Hemisphere V102 GPS antenna:

a)

Check the “Int. GPS” box.

(a) Setthe baud rateto 19200.
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C.

d.

b) Check the “Ext. Heading” box.
(a) Leavethe “Hdg Off [deg]” box blank.
(b) Anerror message will appear.
(c) Click cancel, this error can be ignored.
The Depth Sounder box can be left blank.
Under Offsets:
1) EnterTransducer Depth.

(1) The standardtransducer depth for StreamPro ADCPs deployed in the trimaran
float is 0.02m.

(2) Verify the transducer depth is 0.02m with a meter tape prior to the first
measurement.

(a) Ensurethatthe boat is steady and stable in the water column prior to taking
this measurement.

(b) Measure from the water level to the center of the slantin the transducer
faces with a ruler or metric tape.

(c) This is a very important measurement! Repeat it two or three times to
ensure accuracy.

(d) Once the transducer depth is confirmed this value can be entered prior to
all subsequent measurements, it should not change unless the unit is
disassembled.

Enter Magnetic Variation, the angle of declination relative to your location in the world.

1) For greatest accuracy, checkthe National Geophysical Data Center website tofind the
declination angle based on your latitude and longitude.

2) Some examples:
a) Butler,AL: -2°27' W (-2.27)
b) Newton, GA: -4°59’W (-4.59)
c) Arcata, CA: +14°16’E (+14.16)
Enter the Max Water Depth.

1) This is an estimate of the maximum water depth (m) that is expectedto be measured
during the discharge measurement.

Enter the Secondary Water Depth
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h.

1) This is an estimate of the minimum water depth (m) thatis expectedto be measured
during the discharge measurement.

Enter the Max Boat Speed

1) This is an estimate of the maximum boat speed (m/s) that is expected during the
discharge measurement.

All other values canbe left as defaults.

8. Select the “Output Filename Options” tab.

a.

Under the “Recording” section:
1) Inthe “Filename Prefix” box enter the four-digit side code.
a) Example: “LEWI”.
2) Ensurethe “Use Prefix in Filename” box is checked.
3) Leavethe output directory at the default location (C:\Measurements\).
In the “Include Filename Options” section:
1) Uncheck the “Measurement Number” box.
2) Leave “Transect Number” at “0”.
3) Leave “Geographic Current Survey” and “Sequence Number” boxes unchecked.
In the “Use Date/Time in Filename” section:
1) Select “Long (YY-MM-DD-hhmmess).
In the “Use Delimiter in File” section:
1) Select “Underscore” (default).

Check in the Filename Preview section that the above settings are correctly applied (Figure
22).

Note that these settings canonly be entered at the start of a New Measurement. Once the
Measurement Wizardis closed, filename settings canonly be changed by starting a new
measurement.

9. Open the Command Preview tab.

a.
b.

C.

Review all information to ensure that is correct.
Ensure that green checks are present for ADCP and GPS communications.

Click the Finish button to complete wizard.

10. Review the Summary Page tabto ensure all information was correctly entered.

11. Click Finish to exit the Measurement Wizard.
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12. Verify that GPS data is being collected.

a.

Once powered, allow a few minutes for the GPS to connect to available satellites.

b. Click Acquire > Start Pinging.

C.

Click View > Tabular > GPS to confirm the availability of GPS data (Figure 23).

1)

2)

3)

External/Integrated (GGA) refers to differential GPS data collected by the external GPS
antenna (i.e. SX Blue Il or Hemisphere V102).

Internal (GGA2) refers to the georeferenced GPS data collected by the GPS unit that is
internal to the ADCP.

External GPS datais much more accurate thanthe internal data as reflected in position
(latitude/longitude) digits.

The number of satellites will often be less in the external GPS column due to the higher
quality threshold for picking satellites (i.e. elevation angle) contained in the external
unit.

HDOPis the measure of possible error due to the geometry of the available satellites,
therefore as this value decreases the quality GPS data increases.

a) Ideally HDOP values should be < 2.

d. Click View > Time Series > Graphs > GPS data to confirm GPS data stream (Figure 23).

13. Once GPS data has been verified end ADCP pinging by clicking Acquire > Stop Pinging.

Setup Dialog X

Measureme nt Wizard
Output Flename Options

Recording
Filename Prefie:

=D | B use Prefisin Fiename

Output Directory:
IC:\Measurements\LEWI Browse

Include Flename Options
[ Measurement Humber [ Geographic Curent Survey
Transect Number: [0 |
[ Sequence Number
Use Date/Time in Flename Use Delimiter in Fllename:

Outpuit Filename (O No Date/Time (O No Delimiter
Options
Q) Shrt (YY-MM-DD) @ Underscore
o
@ @ Long (YY-MM-DD hhmmss) O Custom C =

Commands Preview

\ L)
H  sunmay P

Filename Preview

C:\Measurements\LEWNLEWI_000_19-09-18_125811.PD0O
age

4 Back Mext B> X Cancel

Figure 22. Required settings in the WinRiver Il Output Filename Options dialogue box within the Measurement

Wizard.
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Figure 23. Above: GPS Tabular window that confirms GPS datais available andis being collected ; Below: GPS Time
Series window that indicates GPS data is streaming.

F.4 Pre-Measurement QAQC: Overview
The following QAQC protocols are critical to quality data collection and must be initiated prior to the
first transect measurement of each ADCP discharge bout.

The following procedures are outlined below:

e Set the ADCP clock

e Collect a temperature measurement

e Executean ADCPtest

e Calibratetheinternal ADCP compass

e Perform a moving bed test and assess moving bed test summary

e Configure the reference navigation

F.5 Pre-Measurement QAQC: Set the ADCP Clock

Prior to the initial transect measurement the ADCP clock must be set to match the PC time (UTC).
Failure to properly set the ADCP clock will resultin data files with incorrect timestamps.

1. Set the timezone on the PC to (UTC) Coordinated Universal Time (Figure 24).
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a. Rightclick on the date time in the lower right corner of the screen.

b. Select “Adjust date/time”.

c. Inthe “Timezone” dropdown, select “(UTC) Coordinated Universal Time”.
2. Inthe WinRiver Il main screen, click on Acquire > Set ADCP Clock.
3. Set the ADCP clock to matchthe PC time (UTC).

4. Click the “Set Clock” button.

a. Note: only clicking the “OK” button will not set the clock, the “Set Clock” button must be

selected.
Settings — %
@ bt Date & time
[ Find a setting o ] *Some of these settings are hidden or managed by your organization.
Time & Language Current date and time

3:24 PM, Friday, September 27, 2019
I Date & time

@ Region

AF Language Set time zone automatically
@ off

0 Speech

Set the date and time manually

Change

Synchronize your clock

(UTC-03:00) Salvador

(UTC-02:00) Coordinated Universal Time-02
(UTC-01:00) Azores

(UTC-01:00) Cabo Verde Is.

(UTC) Coordinated Universal Time

(UTC+00:00) Dublin, Edinburgh, Lisbon, London
(UTC+00:00) Monrovia, Reykjavik

(UTC+00:00) Sao Tome

(UTC+01:00) Casablanca

Figure 24.Setthe PCused forthe discharge measurement to (UTC) Coordinated Universal Time and match the
ADCP clock to this setting.

F.6

Pre-Measurement QAQC: Collect a Temperature Measurement

1. Allow the ADCPto equilibrate in the water for at least 5 minutes prior to taking a temperature

measurement with the thermometer.

2. Place the thermometer into the water to begin collecting a temperature measurement.
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Enter this value into the Measurement Wizard Rating Information Tab under “Water Temp”.

Pre-Measurement QAQC: Execute an ADCP Test

This test verifies that the ADCP is functioning properly and communicating with WinRiver Il software.

F.8

1.

In the WinRiver Il main screen, click on Acquire > Execute ADCP Test.

a. Note thatthe ADCP must be installedin the mount and submergedin non-flowing water to
obtain the best test results.

A series of six tests will be initiated that evaluate ROM, RAM, Communications, RTC, Compass,
and Temperature performance.

a. Checkthatall tests pass onthe left pane of the dialog window.
After the tests have been run, sensor data will begin to be sampled and displayed in a loop.

Click the “Stop PC20” and “Stop PC40” buttons to end testing and close the dialog window.

Pre-Measurement QAQC: Calibrate the Internal ADCP Compass

A calibrated compass is essential for conducting Moving Bed Tests and for using GPS data as the
navigation reference. This is a two person task, one staff member must monitor the calibration data in

realtime while another rotates the ARC-Boat.

Ensure thatthe ADCPis secured within the trimaranfloat in the exact position it will remain
throughout the discharge measurement.

Ensure that the float is not located near vehicles, steel bridges, or other large ferro-magnetic
masses.

Check for any materials near the trimaranfloat could disrupt the compass calibration — this
includes tools, tool boxes, cell phones, hot hands, etc. Move these materials away from the
ADCP during calibration and throughout the discharge measurement.

In the WinRiver Il main screen, click on Acquire > Execute Compass Calibration.
Select Use Pitch/Roll?

a. Click “No” if the ADCP will not be subject to pitch and roll (i.e. calm water). This calibration
test requires two rotations, one for calibration and one for verification.

b. Click “Yes” if the ADCP will be subject to very high pitch and roll conditions. This calibration
testrequires up to eight rotations, four for calibration and four for verification. Typically, no
pitch and roll calibrationis required.

Placing the ADCP and trimaran float on the surface of a (non-metallic) Lazy Susancan ensure
smooth rotation and significantly reduce compass calibrationerror.
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7. Click the Start Calibration button and wait a moment until the compass is initialized by the

10.

11.

12.

software.

Beginto slowly and smoothly rotate the trimaranfloat by hand in either direction.

a.

Do not cause sudden accelerations or decelerations.

Rotate the float until all of the red bars in the dialogue window have been replaced by a
different dark green color (Figure 25).

a.

b.

The greener the bars, the better the data.
If a baris not dark green, rotate the boat more slowly and more smoothly.

Correct any non-dark green bars when they occurs by going back 10-20° until that bar is
once again highlighted. Then, when it becomes dark green, proceed as before.

Clear and constant communication between the staff member moving the boat and the staff
member viewing the test on the laptop is critical during this period.

Once -calibration rotations are complete, click OK and continue with the verification rotation.

a.

If Pitch/Roll is selected there will be more initial rotations.

Once the verification rotation is complete a calibration error will be calculated and presented.

a.

b.

Ensure that the calibration erroris less than 2°. Aim for a total error of < 1°.

If calibrationerror is < 2°, the compass calibrationis complete and the window can be
closed (< 1° is preferred — try to obtain this).

If calibrationerror is 2 2°, do not accept the compass calibration and repeat calibration

procedures. Look around for magnetic materials that may be affecting the compass. Move
these materials away from the ADCP or move the ADCP awayfrom them, if possible.

If, after three attempts, a calibration error of < 2° cannot be achieved, reference the
troubleshooting steps below.

1) If, following troubleshooting, a compass calibration of < 2° cannot be achieved, accept
the lowest calibration error possible and proceed.

2) Document this occurrence as a note in the Remarks Section, it will be a very important
component in evaluation the measurement during post-processing.

Once complete, check that the correct Magnetic Variation Correction value was entered by the

software during the measurement wizard setup.

a.

b.

In the WinRiver Il main screen, in the upper left Measurement Control window, open the
Collect Data node and right click on Field Configuration, and select Properties.

Under Properties, select Offsets.
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c. Under Offsets > Compass, verify or set the Magnetic Variation value.

d. Note thatother settings canbe verified and enteredin this window.

Compass Calibration Dialog = x|

nstructions: rotate around untd af rad bars have been
eplaced

T qee;w the bar the better the data. 1f your bors are
{ green, rolate more donly,

Use Pich/Rol? - Headng: [
& N ach: [
 Yes Rol: [

o

Figure 25. WinRiver Il compass calibration dialog box. Upon initializing the compass calibration, all bars beginas
brightred as shown above. Performthe compass calibration until all bars are the dark green color indicatedin the
far right side of the color scale.

Troubleshooting Compass Calibration Issues

There may be too much magneticinterferencein the areayou are attempting tocalibrate the
compass. Ensurethat no magnetic materials are nearthe ADCP. Try moving the boat to a
different area of the stream and repeating the calibration. It may be that materialon the
streambed (rebar, trash)is affecting the calibration.
Computational errors may occur during calibration. If you receive an error message indicating
thata computational error occurred, repeat the calibration and be sure to rotate the ADCP slow
and smooth. Ensure that all points in the calibration display are of good quality (dark green).
Communication errors may occur during calibration when using a slow communication Baud
rate. Ifyou receive a “Failed to get calibration data...” message verify that all ADCP
communications are set to the 115200 Baud rate.
If you receive a “360 degrees” compass error message thenthe compass calibrationtest has
failed and needs to be performed again.
Disable GPS output (if enabled).
o This is the least preferred option and should be attempted if all large errors are encountered

after all other solutions have been attempted.

Un-check the Ext. GPS box in the Measurement Window Configuration Dialog tab.

Repeat Compass Calibration test.
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F.9 Pre-Measurement QAQC: Perform a Moving Bed Test

Moving Bed Tests (MBT) are used to determine if the bed of the discharge cross-sectionis in motion. An
un-accounted for moving bed canlea

d to 5-10% bias in discharge measurements performed with the StreamPro ADCP.

MBTs must be performed prior to each ADCP discharge bout. WinRiver Il software analyzes the data
collected during the MBT to assess the moving bed characteristics of the site and to detect common
error conditions, which may invalidate the test. The loop method is presented below as a means to test

whethera moving bed is present. The loop method must be applied properly, or it may produce
incorrect results.

Note that the accuracy of the loop method is not adequate for mean velocities less than 0.8 ft/second
(0.24 m/s). If mean velocity is below 0.8 ft/s (0.24 m/s), water velocity is low throughout the water
column and the probability that the bed isin motion is decreased. Ifthe bed is in fact in motion at these
velocities (or particles on the surface of the bed arein transit)it is likely that not accounting for it will
exert only a minimum bias in the overall discharge estimation.

A properly calibrated compass is critical to application of the loop method, the error caused by an
improperly or un-calibrated compass can be in either direction, resulting in either more or less moving
bed than actually is present.

To perform a moving bed test:

1. Beginthe MBT from an initial point on the near shore where you will be able toreturn to with
precision (Figure 27).

a. Navigatethe boat to a starting location near the edge of the water on the near bank.

b. Usea ziptie, clip, Sharpie or some device to mark the location on the tagline where the MBT
will startand end.

2. Inthe WinRiver Il main screen, click on Acquire > Start Pinging (shortcut key: F4).

3. Open the Ship Track graph. This allows for a better view of the boat path as it does not show the
velocity paths (Figure 26).

a. View > Graphs > Ship Tracks >Ship Track

b. The greensquareis where the float is located when the test starts.
4. Onthe Acquire menu, click Select Moving Bed Test.
5. Select “Loop Test” and click the Start button (shortcut key: F6).

6. Once you startthetest, immediately begin to pull the boat across the river to the opposite bank
in a slow and steady manner.
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a. Maintaina steadyspeed that, if possible, does not exceed the stream velocity.

b. Note thatthe greensquarein the Ship Track graph denotes your starting location.

3% Ship Track 1- TRDI

(=] k=]

Ship Track
—Ref: BT) ——{Ref: GGA) 1Ref: VIG)
4

e}
P

Distance North [m]
&
S

-45 5}

576 !
600 196

i i
209 613
Distance East [m]

1017

Figure 26.The WinRiver Il Ship Track window observed during aloop moving bedtest. The green boxindicates the
boat starting position, the line shows the boat path asitis navigating across the channel and turned back around

toward the starting bank, and the red boxindicates the boat ending position.

7. The MBT Test must last a minimum of 180 seconds (3 minutes).

a. This duration encompasses the time spent moving the boat across the channel and back to
the near bank.

Itis helpful for a staff member using or nearby the laptop to call out the measurement
duration to the other staff member moving the boat sothe speed canbe adjustedif needed.

When the opposite bank is reached, gently pull the boatin the other direction (don’t stop)and
head back to the exact starting point where the test was initiated.

a. This is a critical part of the moving bed test, make sure this is a smooth and slow turn by
gently pulling the tethered line sothat the boat is moving back toward the near shore.
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Bank

Turn around
but do not stop

I

Start here | Return to starting point

Bank

Figure 27. lllustration of the Loop Moving Bed Test procedure.

9.

10.

Once the boat returns back to the exact starting point on the near shore where you beganthe

MBT, stop the test immediately (shortcut: F6 or Acquire > Stop Moving Bed Test).

a.

Note the green square in the Ship Track Graph indicating where the float was located when
the test beganand the red square indicating where the float was located when the test
ended.

If you don’t hit the F6 button right at the starting point this could falsely indicate that the
bed is moving.

Review the Ship Track window (Figure 28).

a.

If the track (red line) contains an “open mouth” (i.e. the green and red squares do not line
up and thered line is not connected) this may indicate that there is a moving bed.

If the track does not contain an “open mouth” (i.e. the greenand red squares are on top of
each other and the red line is connected), this indicates that a moving bed is likely not
present.

Moving bed conditions will always cause the ship trackto move upstream —if the ship track
moves downstream the loop testis not valid.

If the trimaran float was not returned to the exact starting point it can resultin the end
point being upstream or downstream of the starting point. This results in a potentially false
positive for moving bed conditions (endpoint is upstream of the starting point) or an invalid
result (endpoint is downstream of the starting point).
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Figure 28. Left: A moving bedis likely present (not openloop); Right: a moving bed is not likely present (note
closed loop).

11. Document all relevant notes that apply to the MBT.

a. Toadd a note that relate to a specific MBT, right click on the test node (i.e. “Loop 000”), and
select “Add Note”.

12. Review the Moving Bed Test Result window to evaluate the results of the MBT (Figure 29).

a. Inthe Measurement Control window, under QA/QC, click on the Moving Bed Test node and

open the Test Resulticon for the test that was just completed (Loop tests beginas “Loop
000”).

b. The Test Result window provides metrics that describe the MBT. At the bottom of the
window reference the “NOTE” — it will indicate whether correction is recommended.

1) Ifacorrection is recommended, check the box to the left of the MBT (i.e. “Loop 000”).

This will apply a correction to the measured discharge toaccount for the moving bed
velocity.

a) Ifamoving bed is detected (and GPS data is valid), the Navigation Reference must
be changed from Bottom Track to GPS (Section F.10).

(1) Onthe main WinRiver Il screen select Configure > Reference and change
reference GPS (GGA).

b) If GPSis not available then Bottom Track should be used as the reference navigation
(Section F.10).

(1) Document this in the main measurement file remarks window.

(@) Toadd a note to the main Remarks section of the measurement file, right-
click Site Information on the Measurement Control window.

(b) Enter notes into Remarks section.
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c) Once the correction has been applied and the appropriate reference navigation has

been set, proceed with the next pre-measurement QAQC procedure.

2) Ifacorrection is not recommended and all other aspects of the MBT are valid then no
correction is needed and Bottom Track can be used as the reference navigation.

a) Proceed with the next pre-measurement QAQC procedure.

Test Result

Result:

Time:  18/05/02 15:56:47 Copy Close

Type: Loop Test

Distance Made Good: 0.192
Loop Time: 358.400
Moving Bed Velocity: 0.001
Moving Bed Direction: 144.767
Water Velccity: 0.657
Flow Direction: 239.021
Delta Flow Direction: 5.341
Percent Bad BT: 0.000
Estimated § Correct.: 0.000
Mean Near Bed Velocity: 0.358

Moving Bed Test Results Processed on: 05/02/2018

Filename: H:\NEON\Discharge\River Discharge\Post-Processing\Post-Processed Files\2018\DO3\F

(m]

[a)
[m/s]
[degrees]
[M/3]

Loop time > 180 seconds

[degrees]
[degrees]
[percent]
[percent]
(m/s]

NOTE: Moving Bed Vel. (MBV) < Minimum MBV Criteria

Sl

No Correction Recommended <%

Water Velocity > 0.24 m/s

Test result: No moving bed

Figure 29. Moving BedLoop Test Result window. In this example the required conditions were metto in order to
evaluate amoving bed (Loop time, watervelocity)and a moving bed was not detected (the moving bed velocity <
the moving bed velocity criteria), thus no correction was recommended.

13. If thereis confusion whether or not the MBT was completed correctly or questions arise

interpreting the results, consider the following common sources of errors associated with the

Loop Method.

a. Watervelocity must be >0.24 m/s in order for a moving bed to be evaluated.

1) If velocity is below this threshold a loop test cannot be evaluated by WinRiver II.

2) At low velocities suchas theseit is likely that a moving bed is not present or is negligible

in terms of affecting measureddischarge.

3) Conducting an additional loop test is not required.

4) Proceed with the pre-measurement QAQC procedures in this instance.
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b. Systematiccompasserrors.

1) Check the direction of the velocity vectors (blue lines) during the Loop Test in the Stick
Ship Trackwindow. They should be pointed in the same direction during both loop
paths.

2) If vectors arein opposite or in an erratic direction this is a symptom of poor compass
calibration.

3) Conducting another compass calibration followed by a second MBT may be helpful.
c. Bottom-tracking bias and uncertainty.
1) Check the Velocity Contour Profile associated withthe Loop Test.
2) Aretherelarge unmeasured areas along the streambed?
a) Ifsoa MBT may be difficult to validate.

3) Conducting another MBT along a different transect (upstream or downstream) may be
helpful.

d. Failure toreturn to theinitial starting point.
1) Ensurethatthe float was returned to the exact starting location at the end of the MBT.
2) Make surethat you ended the MBT at the exact time you reachedthe starting location.

e. lIrregular orinsufficient sampling of the cross section because of loss of bottom track, non-
uniform boat speed, and loitering at the banks.

14. If any of the above criteria are in doubt:

a. Conduct another Moving Bed Loop Testin a slow, steady manner with a smooth transition
at the opposite bank.

b. It may be helpful to begin the second Loop Test from the opposite bank or from a different
transect location.

1) Besure not to gettoo far awayfrom where you will be collecting the discharge
measurement.

15. If, after the second Loop Test the results are still unclear, use the GPS as the reference method
(if available).

16. If, after the second Loop Test the results are stillunclear, and GPS is not available, conduct a
Stationary Moving Bed Test.

a. StationaryMoving Bed Tests canonly be used to determine if thereis a moving bed, not
correct for one, therefore only use this if problems occur during the Loop Test and GPS data
is not available.
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b. Toconduct a Stationary Moving Bed Test:

F.10

1) Move the trimaranfloat to the thalweg, or deepest section of the stream.
2) Inthe WinRiver Il main screen, click on Acquire > Start Pinging (F4).
3) Onthe Acquire menu, click Select Moving Bed Test.
4) Select “Stationary Test” andclick the Start button (F6).
5) Hold the ADCPin that location for at least for 300 seconds (5 minutes).
6) Stop thetest (shortcut: F6 or Acquire > Stop Moving Bed Test).
7) Add any pertinent notes to the Stationary Moving Bed Test.
a) Rightclick on the test node (i.e. “Stationary 000”), and select “Add Note”.
Review the Moving Bed Test Result window to evaluate the results of the test.

1) If amoving bed is detected and a correction is recommended, check the box to the left
of the MBT (i.e. “Loop 001”). This will apply a correctionto the measured discharge to
account for the moving bed velocity.

a) Continue to use Bottom Trackas the Reference Navigation (since GPS data is not
available).

b) Document this in the main measurement file remarks window.

(1) To add a note to the main Remarks section of the measurement file, right-click
Site Information on the Measurement Control window.

(2) Enter notes into Remarks section.
c) Proceed with the next pre-measurement QAQC procedure.
2) If amoving bed is not detected proceed with the next pre-measurement QAQC

procedure.

Pre-Measurement QAQC: Configure the Reference Navigation

The reference navigation determines how the direction or bearing (heading) of the instrumentis

measured. The following references are available during an ADCP discharge measurement:

e BottomTrack

O

O
O

ADCP Bottom-Track velocity (standard configuration).

This is primary choice for the reference navigation if a moving bed was not detected.

The ability of the ADCP to Bottom Track can become compromised during periods of high
turbidity and suspended sediment concentrations (SSC). An overload of scaterrersare
produced in these conditions which prevent the ADCP beams from reaching the bottom and
measuring velocity throughout the channel profile. If turbidity is high and the ADCP is having
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difficultly bottom tracking (this is evidenced by alarge bands of missing ensembles in the
velocity contour profile and warnings in the Measurement Control Window), consider using
GPS as the reference navigation.

e GPS(GGA)

O

Differential GPS position from NMEA GGA string (WinRiver Il will differentiate position to
calculate velocity).

o Ifamoving bed is detected and/or during periods of high turbidity and suspended sediment
concentration, this is the primary choice for GPS reference as GGA data contains more
information thanVTG.

o GGAmessages canbe affected by multipath errors caused by large trees or structures
nearby the measurement site.

e GPS(VTG)

o GPSvelocity from NMEA 0183 VTG string.

o If amoving bed is detected, and/or during periods of high turbidity and suspended sediment
concentration, this is the secondary choice for GPS reference as VTG data serves as a backup
for GGA.

o VTG messages are not affected by multipath errors but VTG GPS data is oftentimes less

accurate than GGA, particularly when moving at lower speeds.

If a moving bed was not detected during the previous pre-measurement QAQC procedure (Section F.9)
and turbidity/SSC levels are low it is always preferredto use Bottom Track as the reference navigation.
This allows for the boat movement and water movement to both be referenced to the instrument. Note

that GPS data should still be configured and collected even if it is not used as the reference navigation.

If a moving bed was detected and/or turbidity and SSC levels are high enough to adversely affect bottom
tracking, GPS reference is preferred. GPS data can also be used as a good quality indicator of the Bottom
Trackdata as well.

To change the reference navigation:

1. Inthe WinRiver Il main screen, click on Configure > Reference.

a.

b.

If amoving bed is not present, ensure that “Bottom Track” is selected from the list.

When bottom trackis used as the velocity reference, the speed of the ADCP over ground is
subtracted from the measured relative velocity to give true Earth referenced water velocity.

If, following a moving bed test, a moving bed is present and GPS can be utilized, choose GPS
(GGA) as the reference navigation.

If GPS does not have enough satellites toacquire a strong signal, Bottom Track should be
used as the reference navigation.

1) The number of available GPS satellites is shown by selecting View > Tabular > GPS
(Figure 23).
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2) The absolute minimum number of satellites neededto provide a position is 3.

3) Position will not be as accurate until at least 4 satellites are available due to timing

limitations of GPS receivers.

4) The greater the number of satellites, the greater the positionaccuracy, 7+is preferred.

e. GPSlatency canbe detected using the Ship Track windows (View > Graphs > Ship Tracks)

(Figure 30).

1) Comparethe red lines (Bottom Track) vs the blue and greenlines (GPS).

2) Separation between GPS and Bottom Track may denote:

a) GPSlatency.

b) Thatan offset is required to the External Heading.

(1) See Section 1.3 for details on applying External Heading offsets.
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Figure 30. Above: Bottom Track and GPS data are in good agreement, indicating proper compass calibration, an
accurate Magnetic Variation value, and low GPS latency; Below: Bottom Track and GPS data are in poor
agreement, indicating poor compass calibration, an inaccurate Magnetic Variation value, and/or high GPS latency.

F.11

Conduct Discharge Measurements with the ADCP and Trimaran Float

WinRiver |l software calculates discharge using real-time velocity measurements acquired during
transects across the stream. Perform the following steps in order to successfully collect a high-quality
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stream discharge measurement using the ADCP method at wadable stream sites. Eachstepis presented

in greater detail throughout this section.

1.

Start ADCP pinging.

Establishtransect start and end points.

Enter staff gauge height prior to each transect measurement.
Measure discharge across the channel (minimum 4 transects).
Evaluate whether additional transects are required.

Save transect locations (optional).

Start ADCP Pinging

Setting the ADCP to start pinging enables ADCP and GPS data collection. In general, after you have
started the ADCP pinging, there is no reasonto stop pinging until you are finished the entire discharge

survey and ready to remove the ADCP from the water. An exception would be if you were operating

with batteries of limited capacity, under that circumstance stopping ADCP pinging will conserve power.

1.
2.

2.

Ensure that the trimaranfloat is in the water and the ADCP and GPS antenna are powered on.
Press F4 to start the ADCP pinging (or Acquire > Start Pinging).

In a few seconds, ensembles will begin to be generated and changing values will appear within
several of the WinRiver |l data windows.

a. Anensemble is the data output generated by multiple ADCP pings that are averaged
together. Ensembles are tracked in numerical order, timestamp, and position.

b. Ifthe ADCPis positioned in sufficient depth, velocity profiles will become available.

c. Note that WinRiver Il will not display meaningful data unless the trimaran float is in the
water.

If enabled, GPS positions will be displayed at the bottom of the Composite Tabular display
window and valid GGA positions are being received from the GPS system. External Heading data
will be displayed if that functionality is enabled.

The ADCP can continue pinging when it is not in the water.

Establish Transect Startand End Points

The locations at eachside of the channel where the discharge measurement begins and ends must be
established before recording discharge transect data. Because stream depths eventually become too
shallow for valid data collection as the ADCP approaches a bank, it is necessaryto estimate discharge in
the near-shore unmeasured zones using the WinRiver Il and Q-Rev software. To ensure the accuracy of
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near-shore discharge estimates, the distances from the edge of water to the starting and stopping
points of eachtransect must be measured using a distance-measurement device (suchas a laseror
optical rangefinder), tagline, or some other accurate measurement device.

Placing markers on the Guideline Rope (zipties, carabiners, flagging, etc.) at the start and end points of
transects is advantageous for keeping consistent edges and ensuring that the same cross-section profile
is measured during eachtransect. If it is not possible to reach the opposite side of the river to measure
the edge distance, the “Distance MG [Made Good]” values displayed on the right side of the Composite
Tabular 1 window can be used to calculate the edge distance from transect end point to the edge of
water on the opposite bank.

Other notes on transect start and end points:

e Measurement uncertaintyincreases as the distance increases betweenthe start and end points
and the edges of water due toless measurements and more interpolation.

e Trytoensurethatthe velocity profile at the start and end locations are representative of the
velocity profiles leading up to the bank in order to limit interpolation bias.

e Inchannels that contain vertical walls at the edges, start and end points for transects should be
no closerto the wall thanthe depth of water at the wallto prevent acousticinterference from
the main beam or side lobes impinging on the wall.

o For example, if the depth at a vertical wall is 10 feet, transects should start or stop at least
10 feet awayfrom the wall.

e Ifthe cross-section has been measured previously at the same location, WinRiver Il “Locations”
can be utilized to help determine the start and end points that were previously used and to help
navigate the float across the channel.

o See Section F.11 for instructions on loading available locations and how to save new ones.

To establishtransect start and end points:
1. Move the trimaranfloat just off the edge of water on the near shore and into open water until
the ADCPtransducers are submerged.

2. Note the number of “Good Bins” listed in the Composite Tabular window shown in the right
panel of the main WinRiver Il screen (Figure 31).

a. Two “Good Bins” (or depth cells) are required in order to start and end the transect
measurement.

3. Using the Control Rope, move the float slowly away from the bank until the tabular display
indicates you are at a sufficient depth to set the transect start point (>2 Good Bins, closest to 2
is preferred).
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4. Markthis location on the Guideline Rope with a physical marker (ziptie, carabiner, flagging,

etc.).

5. Usingthe Control Rope, move the float slowly towards the opposite shore.

a. Travelsmoothly and slowly with the bow of the boat pointed upstream.

6. While moving the float across the channel, observe the Velocity Contour graphto view channel
conditions and ensure that the ADCP is working as expected with the loaded configuration.

a. Observe the Velocity Contour Profile located on the bottom panel of the WinRiver |l main
screen (Figure 32). This display illustrates water velocity and depth across the channel.

1) The very top and the very bottom of the channel will always be unmeasured by the

ADCP and discharge in these locations will be interpolated. The top unmeasured areaiis
a function of transducer depth and the blanking distance of the instrument, the bottom
unmeasured area is to prevent any side lobe interference which would adversely affect

the measurement.

2) Vertical white bands within the profile are unmeasured areas that canoccur for a

variety of reasons including biota, woody debris, physical structures, or simply moving

the float too fast or abruptly across the channel.

a) Work to limit the number of white bands in the profile as anincreasein
unmeasured area results in an increase in measurement uncertainty.

b) Ifthe unmeasured area within the cross-sectionis significant a different discharge

transect upstreamor downstream may be necessa ry.

3) Note regions where the channel depth changes abruptly.

a) Make a mental note to move more slowly across these regions during data

acquisition to help bottom tracking maintain a valid lock on the bottom.

7. Asthe float approaches the opposite shore note the Number of Good Bins in the Composite
Tabular window (Figure 31) and stop the float at the opposite edge of water where two good

bins are available.

8. Markthis location on the Guideline Rope with a physical marker (ziptie, carabiner, flagging,

etc.).

9. Proceed to the next step once transect start and end points are established at eachside of the

channel.
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4 Composite Tabular 1 - TRD! oo =]
Ens. Nmb. w Lost Ens
239 0
Bad Ens. %Bad Bins Delta Time
0 0% 064
November 13, 2018 16:10:13.74
Pitch Roll Heading
-8.21° 484 159.78°
Temp. Press Sensor
18.19°C

Discharge (Ref: B) Left to Right
TopQ 0000  [ms]
Measured Q 0003 [m¥s]
Bottom Q 0.001 {mérs]
Lefi Q 0000 [m¥s)
Right Q 0000 [ms]
[m¥s)
MET Corrected Q [m¥s]

Navigation (Ref: BT)

s
Boat Course 219.47 1
s
Water Dir. 187.60 [y
Calc. Depth 2303 m)
Length 0.01 [m)
m
Course MG 219.47 ]

uration 0.64 sl
GeoRef Latitude 31°10.989400° N
GeoRef Longitude 84° 26.297900° W

Latitude
Longitude

Figure 31. Composite Tabularwindow in WinRiver Il, green box: Number of Ensembles (hold until 10 attransect

start/end points); red box: Number of Good Bins (must be >2 to begintransect); purple box: Total Discharge; blue
boxes: Water and Boat speed; orange box: Distance made good (MG = total transect length); brown box: Duration
(total transect duration must be >180 seconds).

Distance Cell
Cell2
cells

-~
Cell4
—

* Velocity Contour 1 - TRDI
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™
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Un-measured
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streambed
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area at surface

i
m 22
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Figure 32. Unmeasuredareasin the ADCP profile where velocity is extrapolated. Top left: ADCP blanking distance
and cell size distribution (credit: SonTek); top right: unmeasuredareas of the profile relative to ADCPbeams
(credit: SonTek); below: the WinRiver Il velocity contour with unmeasured areas delineated.

3. EnterStaff Gauge Height Prior to Each Transect
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The staff gauge height must be entered prior to eachtransect measurement using the Fulcrum app. The

mean gauge height recorded prior to all transect measurements is the stage value associated with the
mean discharge measured during all transect measurements. Notes regarding conditions observed
during individual transects (high/low flows, changing gauge heights, wind conditions, the passage of

other vessels during measurement, any noteworthy events, etc.) can be enteredin the main Remarks
section of the Measurement Wizard as well as in the individual transect notes.

Gauge height observation and recording must immediately precede the transect discharge
measurement sothe stage level during the discharge measurement is accurately characterized.

To enter the staff gauge height prior to each transect measurement:

1.

10.
11.
12.
13.

14.

Open the (AOS) Field Metadata and Gauge Height [PROD] app in Fulcrum.
Enter the appropriate information in the Metadata, Spatial and Temporal Information tables.
In the Stage Height table, enter the current staff gauge height in the “Initial Stage Height (m)”
field.

a. Note that this does not necessary have to equal the staff gauge height prior to the first

measurement transect.

Under the Stage Height table note the “Collecting Discharge withan ADCP Today?” field and
select “Yes”.
Click the “ADCP Transect Stage Measurements” buttonthat appears.
Click the red plus (+) button at the top right of the window to create a record.
Enter the time the staff gauge is measuredin the Staff Gauge Height Reading Time field.

a. This must be done immediately preceding the discharge measurement.
Enter the Staff Gauge Asset Tag.

a. This islocated on the top of the staff gauge you are reading.
Enter the Transect Number.

a. This must correspond to the transect number generatedin WinRiver Il.

b. By default, transect numbers begin at 000 and increase to 001, 002, 003, etc.
Enter the Staff Gauge Height.
Enter the Staff Gauge Height units.
Click the greencheck button in the top right corner of the window to save the record.
Additional ADCP Transect Stage Measurements can be added by clicking the red plus button at
the top right of the window.
ADCPtransect stage measurements can be deleted by clicking the black X button to the left of
each record.

a. Records should be deleted if:

i. Errorsarepresentin any of the fields.
ii. The measurementtransectis not to be used in the calculation of total discharge
(the transect will remain unchecked in WinRiver |l due to measurement error,
the transect was started by mistake, etc.).

Page 94



n c) n Title: AOS Protocol and Procedure: DSC — Stream Discharge Date: 03/16/2022
e ®

Operated by Battelle [ yEoN poc, #: NEON.DOC.001085 | Author: N. Harrison Revision: H

15. The ADCP Transect Stage Measurements window should remain open throughout the discharge
survey so that staff gauge height can be measured prior to each transect measurement.

16. The window can be closed by clicking the green check mark at the top right of the window once
all transect discharge measurementsare complete.

17. Enter Weather Information, Post Fieldwork Observations, and General Comments information
to the record as needed.

18. Click the greencheck mark at the top right of the window to save the record.

19. Fulcrum data will load automatically when the recordis saved and the device receives a wireless
internet signal.

4. Measure Discharge Across the Channel (Minimum 4 Transects)

A “transect” is considered a single discharge measurement that begins at the transect start/end point
on one side of the channel and ends at the transect start/end point on the opposite side of the channel.
Each ADCP discharge survey must contain a reciprocal number of transects (i.e. ifa transect is measured
from the near bank to the opposite, another transect measurement must be included from the opposite
bank to the near bank). A minimum of four transects are required for each ADCP discharge survey but
more may be necessary. Eachtransect must last a minimum of 180 seconds and the total time for all
transects must be >720 seconds.

Complete the following steps to measure discharge during each transect:

1. Hold the position of the trimaran float steadyat one of the marked transect start or end points.

2. Usinga stadiarod, meter tape, or laser range finder, determine the distance from the transect
start point to the edge of water. This is referredto as the “edge distance”.

a. Measuretheareafrom the center of the ADCPto the edge of the water.

b. Ifusinga rangefinder make sure thatthe laseris not hitting leaves or branches hanging over
the channel. Take a few shots and make sure they are all the same.

c. Ifitis not possible to measure this distance with an instrument, use the “Distance MG
[Made Good]” values displayed on the right side of the Composite Tabular 1 window to
calculate the edge distance from beginning/end of the transect tothe adjacent edge of
water.

d. Ifyou startfromthe same location for each transect, this distance does not need to be
measured each time (it is recommended to mark the transect start point for this reason).

3. Click Acquire > Start Transect (shortcut: F5) to begin data recording.
a. Note that the measurement has now been initiated.
4. When prompted, enter the edge distance (measuredin Step 2).

5. Define whether you started the measurement from the left or right bank.
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a.

When facing downstream, the left bank is on your left side.

6. Hold the position of the float at the transect start point for at least 10 shore ensembles.

a.

This is equivalent to about 10 seconds.

b. The number of ensembles can be viewed in the Composite Tabular window (Figure 31).

7. Once 10 ensembles arerecorded at the transect start point use the Control Rope to slowly and
steadily move the float toward the opposite bank.

10.

11.

Move the float slowly and steadily across the channel.

a.

The total duration of eachtransect (moving the float from one side of the channel to the
other) must be > 180 seconds.

The cumulative time spent measuring each transect s directly correlated to measurement
quality.

1)

The slower and steadier the float crosses the channel the higher the data quality.

Maintainan average boat speedthatis less than or equal to the water velocity.

1)

2)

3)

Water vs. Boat speed can be monitored using the Water Speed vs Boat Speed graph.
a) Click View > Graphs >Time Series > Water/Boat Speed (Figure 33).

When water velocity is very slow, keeping the boat speed below the water velocity may
not be a possible (or practical) approach. Under these conditions the smoothness of
boat operation becomes critical.

Avoid fast and sudden accelerations.

The bow of the float should always be pointed upstream sothat the boat crabs , or moves
across the channel.

1)

If this is not occurring make necessary adjustments tothe Trimaran Rope.

Observe data displayed on other graphs as needed to monitor data quality.

1)

Click View > Graphs/Tabular to explore other graphical and tabular interfaces.

a) Graph display settings can be configured by right clicking on the graph and selecting
“Properties”.

Continue across the channel until you reachthe transect end point on the opposite shore.

Ensure that two good bins are available at this location using the Composite Tabular window

(Figure 31).

Hold the float steady at this location and wait until at least 10 shore ensembles have been

collected.

a.

This is equivalent to about 10 seconds.
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b.

The number of ensembles can be viewed in the Composite Tabular window (Figure 31).

12. Using a stadiarod, metertape, or laser range finder, determine the distance from the transect

13.

14.
15.

16.

end point to the edge of water. This is referred to as the “edge distance”.

a.

b.

Measure the area from the center of the ADCP to the edge of the water.

If using a rangefinder make sure that the laser is not hitting leaves or branches hanging over
the channel. Take a few shots and make sure they are all the same.

If it is not possible to measure this distance with an instrument, use the “Distance MG
[Made Good]” values displayed on the right side of the Composite Tabular 1 window to
calculate the edge distance from beginning/end of the transect tothe adjacent edge of
water.

If you end from the same location for each transect, this distance does not need to be
measured each time (it is recommended to mark the transect end point for this reason).

Click Acquire > Stop Transect (shortcut: F5) to stop data recording.

a.

Note that the measurement has now ended.

When prompted, enter the edge distance (measuredin Step 12).

Define whether you ended the measurement at the left or right bank.

a.

When facing downstream, the left bank is on your left side.

To add notes that document important information relating to each transect right clickon the
transect node in the Measurement Control window (upper left pane in the WinRiver Il main

scree)and select “Add Note”.

a.

Notes that describe individual transect measurements help explain the data that was
collected and are thus extremely beneficial to post-processing/data QAQC. Always provide
clear, descriptive documentation regarding the discharge measurement. Examples of
individual transect notes include:

1) “Abarge wentthrough prior to/following the transect measurement”.
2) “The wind picked up considerably during the transect measurement”.

3) “Itwas difficult to maintaina boat velocity less than the mean velocity of the river
during the transect measurement due to...”.

4) “Poor bottom tracking/GPS tracking occurred during this transect due this measurement
due to...”.

5) “Riverstage appearedto rise/fallduring this transect”.

6) “Highsediment concentrationwas present during this transect”.

17. The transect measurement is now complete.
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18. To view the data you collected during the transect openthe node (+) under the Transect name
in the Measurement Control window and double-click the disc button.
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Figure 33. Water Speed vs. Boat Speed graph. Above: Impropertechnique. The boat speed (purpleline) is erratic
and higher than the water velocity (red line). Below: Propertechnique. Maintain an evenboat speed so thatthe
purple and red lines are more in lineand boat speed remains generally lower than water speed.

Collect (At Least) Three Additional Transect Discharge Measurements (Minimum of Four Total)

Repeat the previous steps, moving the trimaran float across the channel from each transect startand
end point until a total of four transects have been measured (two in each direction). A minimum of four

transects (each lasting a minimum of 180 seconds) must be collected during each discharge
measurement, twoin each direction. The measured discharge is the average of the discharge collected
during each transect.

Enter the staff gauge height prior to eachtransect measurementinthe Fulcrum app. Record all other
notes in the individual transect notes and/or the Remarks window of the WinRiver Il Site Wizard
(typically notes that affect all transects can be enteredin the Site Wizard notes and notes that affect
individual transects are to be entered in the individual transect notes).

A new data file and Transect node will be createdin the Measurement Control window eachtime you
startand stop recording during eachtransect (ex: Transect 0000, Transect 001, Transect 002, Transect
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003). Once the fourth transect is complete stop data collection and evaluate whether additional
transects are needed.

5. Evaluate Whether Additional Transects Are Required

More than four transects must be measured if:

1. Totalduration of all transects does not exceed 720 seconds.

2. The discharge measured during at least one transectis greater than 5% of the average discharge
of all transect measured.

3. Anobserved gauge height change is associated with a notable change in discharge for a given
transect.

Evaluate the total duration of all transects:

1. Inthe Measurement Control window (top left panel in the WinRiver |l main sceen) ensure that
each transect measurement you wish to evaluate is checked.

a. Uncheck any Transects were measuredthat contained errors and are not meant to be
included in the evaluation.

b. A minimum of four reciprocal transects (that do not contain errors) must be checked.

2. Inthe WinRiver Il main screen, hitthe F12 button to bring up a summarytable that provides
information on each transect measured.

3. Scroll over to the fifth to last column, “Duration”.

Ensure that each transect durationis = 180 seconds and the sum of all transect durationis = 720
seconds.

4. |Ifindividual and total transect duration requirements are met, proceed to the next evaluation
step.

5. Ifanindividual transect durations is < 180 seconds or the sum of all transect durations are <720
seconds, collect two additional transect measurements (reciprocal pairs of transects must
always be measured, one that begins from eachside of the channel) and re-evaluate the
summary window.

Evaluate the discharge of each transect relative to average discharge of all transects:

1. Inthe Measurement Control window (top left panel in the WinRiver |l main sceen) ensure that
each transect measurement you wish to evaluate is checked.

a. Uncheck any Transects were measured that contained errors and are not meant to be
included in the evaluation.

b. A minimum of four reciprocal transects (that do not contain errors) must be checked.
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In the WinRiver Il main screen, hit the F12 button to bring up a summary table that provides

information on each transect measured (Figure 34).

Note the value listedin the fifth column, “Total Q”, for each transect row.

a.

This is the total discharge measured during each transect.

Note the value listedin the “Average” row of the “Total Q” column.

a.

This is the average discharge of all transects measured.

Note the value listedin the sixth column, “Delta Q”, for each transect row.

a.

This is the percent difference of total discharge measured during each transect relative to

the average discharge across alltransects.

If the Delta Q value for each transect is < 5%, discharge requirements are met and no additional

discharge transects are necessary.

a.

Proceed to the next evaluation step.

If the Delta Q value for any individual transect is >5%:

a.

b.

Collect two additional transect measurements (one from each side of the channel) and re-

evaluate the summarywindow (reciprocal pairs of transects must always be measured, one

that begins from each side of the channel).

1) Note that under changing hydrologic conditions (stage s rising or falling) Delta Q

requirements may be difficult to meet.

2) If streamstage was fluctuating dramatically throughout the transect measurements,

proceed to the next evaluation step.

3) Astotal measureddischarge values decrease during the low flow regime, achieving < 5%

Delta Q values becomes increasingly difficult.

a) Theinstrumentation approaches the lower limits of its measurement ability at low
stages andthereis anoverall increase in uncertainty when measuring low-flow

discharge (environmental factors such as bed and bank geometry exert a larger
influence on velocity paths and can adversely affect measurement ability).

b) A high level of precision is required to obtain repeatable discharge values per

transect.

c) Asmore measurements are collected a given site over time, Science and Field
Science staff can work together to develop applicable Delta Q thresholds based on

stage levels.

If Delta Q values still exceed 5% for a given transect collect two additional transect

measurements (reciprocal pairs of transects must always be measured, one that begins

from each side of the channel), and re-evaluate the summary window.
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c. If, aftercollecting a total of 10 transects, Delta Qvalues still exceed 5% for a given transect,
proceed to the next evaluation step.

1) Submit atrouble ticket to Science upon return to the office.

d. Keep in mind that the more transects that are measuredincreases the probability that the
true meandischarge will be measured but it alsoincreases the probability that an outlier
measurement will be collected.

3¢ Discharge Summary - TRDI (=R

Transect Start Bank #Ens Start Time Total Q Delta Q TopQ Meas. Q Bottom Q Left Q Left Dist. Right Q
mefs % me/s m¥s me/s m¥s m m¥fs

01000 Right 417 19:27:56 1151.505 1.92 67.125 957.347 120.280 2.978 9.00 3775
01001 Left 487 19:33:48 121.736 0.7 64.965 933.882 114.248 2344 9.00 6.297
01002 Right 469 19:45:47 1123.982 0.51 65.115 932.999 116.472 3.878 11.60 5.518
01003 Left 398 19:52:15 121.822 0.70 65.398 934.828 114.624 2.516 11.60 4.451
Average 442 1129.761 0.00 65.651 939.764 116.406 2.929 10.30 5.012
Std Dev. 42 14.533 129 0.999 11.746 2.760 0.687 1.50 1.17
Std.J| Avg.| (%) 9.50 1.29 0.00 1.52 1.25 2.37 23.46 14.57 22.29

Figure 34. Discharge summary window in WinRiver Il. The red box highlights Delta Q values. In this exampleall are
< 5%, an indication that no additional transect measurements are required.

Evaluate changes in transect discharge relative to changes in gauge height

Gauge height must be observed and recorded in the app prior to eachtransect measurementinorder to
calculate mean stage and assess unsteady flow conditions. Unsteady flow conditions occur during
periods of rising or falling stage which may occur during or immediately following heavy rain events,
upstream dam or lock flow regulation, tidal effects, downstream backwater effects, or flood waves.
Always document unsteady flow conditions in the main Remarks section and/or individual transect
notes.

If a gauge height change is associated with a notable change in discharge for a given transect (i.e. >~3%

of the mean):

1. Attemptto collect a pair of reciprocaltransects that correspond with a given gauge height.

2. If stageis changing too rapidly and this is not possible, save transect location files (if needed)
and proceed to Section F.12.

3. Submit atrouble ticket to Science upon return to the office.

6. Create Transect Location Files (Optional)

Location files use GPS data to save the location of transect start and end points sothat they can be
utilized during subsequent discharge surveys. This feature cannot be utilized if GPS data was not
integratedinto the measurement. Once a transect has been measured it appears in the WinRiver Il
Measurement Control window, and the location can be saved. Multiple transect locations can be saved
using unique files names (i.e. if discharge was measured 5 meters upstream during a particular survey).

To create a Transect Locationfile:
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Complete a discharge measurement at a given transect.

Identify the transect locationto be savedin the WinRiver || Measurement Control window.
a. The discharge measurement associated withthe transect must contain GPS data.
Rick-click on the transect node and select “Define Transect Location” (Figure 35).

The Edit Locations window will appear.

a. Click onthe map tozoom.

Enter a Location Name and any relevant notes about the transect.

Click the Save & Close button.

a. You must click the “Save & Close” button to create the location file.

b. Selecting Cancelor closing the Edit Locations window will not create the location file.
Click Save on the Save Location screen.

a. The *.dat location file will be savedto the C:\Measurements\Locations folder by default,

this location canalso be edited.

° MeasurementCtrl - TRDI EI@ ¢ Intensi

Miss at Knox Landing RR_0.mmt

i@ Site Information 0.
@ Site Discharge [)lr

: Transedt Reprocess Transect Shift+F5
Transect Subsection... Alt+F8
Transecl
W
Transed  pdd Note Ctrl+K

- Transec
Transecl Define Transect Location
Transect 006
+-[#] Transect 007
+ Transect 008

e

Figure 35. Defining transect locations In WinRiver Il.

F.12

Evaluating the Discharge Measurement in the Field

Following the completion of the discharge survey, the following data review steps must be completed:

1. Review, finalize, and save data in WinRiver II.
2. Check measureddischarge value against the stage-discharge rating equation (if available).
3. Reviewdata in Q-Rev.
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Data review must be conducted while still on site so that the discharge survey can be repeated if

necessary.

Review, Finalize, and Save Data in WinRiver Il:

1. Playback each measuredtransect andcheck parameters.

a.

b.

Open the node (+) under eachtransect.

Right click on the Transect number and select “Re-process Transect”. The transect data will

appearin all graphs that are currently on display.

Right click on Playback Configuration and select “Properties”.

1)

2)

3)

4)

In the Edge Estimates page onthe right, verify that the Begin Transect and End Transect
information was entered correctly.

In the Offsets page check that the ADCP transducer depth was entered correctly (this
depth should not have changed during the discharge survey).

In the Discharge page choose the correct Left Bankand Right Bank Edge Type.

a) A custom coefficient value canbe enteredif a given bank does not conform to
triangular or square shape.

b) Consult Science with any questions regarding bank coefficients. These values are
very important in estimating edge discharge.

Once any value has been enteredin the Playback Configuration > Properties window,
you can right click on the box and select “Apply to All Active Checked Transects” if you
wish to apply this value to all selected transects.

a) This will apply the setting to all transects inthe measurement that are checked.

b) Eachtransect will need to be re-processed for this change to be applied.

Enter all applicable notes in the general Remarks sectionand in individual transect notes, as

necessary.

2. Following the WinRiver Il review save the measurement file on the laptop and a USB dongle for

backup.

a.

An .MMT file will be created along with .PDOfiles that are unique to individual transects.

Each of these files must be contained in a folder on the laptop and backed up onto a USB
dongle.

Check the measured discharge value against the stage-discharge rating equation, if available:

Once a stage-dischargerating curve has been developed and validated for a site, a rating equation is

derived that predicts discharge given stream stage (supplementary information on rating curves is
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&

available in Appendix D). Once established, rating equations will be provided to field staff by Science.
Rating equations are commonly expressed as power relationships:

Q=C(G-a)f
Where:

Q=discharge;

G =the stage, or gauge height;

a = the gauge reading corresponding tozero discharge; and
C.and B = rating curve constants

Following the discharge measurement:

1. Enterthe streamstage (G)into the rating equation thatis associated with the site.
2. Calculate predicteddischarge.
3. Evaluate whether the measureddischargeis +10% of the discharge predicted by the equation.
a. Ifthe measureddischargeis <+10% than predicted discharge:
1) Another discharge surveyis not required.

b. Ifthe measureddischargeis >+10% than predicted discharge (and the stream stage did not
change during the site visit):

1) Conduct another discharge survey immediately.

2) If, aftera second attempt, the measured discharge remains >+10% the predicted rating
discharge:

a) Checkthesecond discharge measurement file for errors using steps provided in
previous sections.

b) Save both discharge measurements.
c) Submit atrouble ticket to Science.

(1) This mayindicate a shift in the rating, which, if validated by additional
measurements, would warrant anincrease in the frequency of discharge
measurements at the site.

Review, Finalize, and Save Data in Q-Rev:

QRev software (USGS) serves a final means to QAQC ADCP discharge data. The following procedures
must be done in the field prior to leaving the site.

1. Open Q-Rev.
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2. Open the.mmtfile (the file that was just savedin WinRiver) in Q-Rev.
a. Inthe main Q-Rev window: Select Data > TRDI >select the WinRiver Il .mmt file.

b. Note thatthe location where the .mmt file is stored must also contain all of the .PDOfiles
that correspond with the measurement.

3. Note the color of the buttons on the left side of the main window. These colors indicate data
quality for specific measurement parameters.

a. Green: Good, no investigationrequired.

b. Yellow: Problems could be presented and may be able to be corrected, investigationis
required.

c. Red:Problems are present that are negatively affecting measurement data, investigationis
required.

4. Select the “Options” button (this button will never be colored).
a. Ensurethat “Units” are settoSlI.
b. Click OK.
5. Inthe main window, select the “Moving Bed Test” button (regardless of color).
a. Uncheck any tests that are not valid in the “User Valid” column.
1) Note the “Quality” rating, and the text contained in the Messages window.

b. If anytests contain “Moving Bed” = “Yes” consider checking “Use for Correction” if the tests
were valid.

c. Note this will change the measured discharge value.
6. Evaluatethe remaining buttons if they are not green:
a. ADCP/Site Info
1) Herethe Station Name and Number can be edited.
b. SystemTest
1) Provides the results of the ADCP systemtest.
c. Compass/P/R
1) Provides heading, pitch and roll, and magnetic variation data for eachtransect.

a) If the pitch and roll time series data are too high and the extended compass
calibration was not performed, Q-Rev will apply a flag.

2) This button will be yellow if Compass CalibrationErroris > 1 degree.
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3)

4)

Here you can change the magnetic variation for some or all transects by clicking on the
Magnetic Variation value within the Heading, Pitch, & Roll table.

You can view the Compass Calibration data by clicking the “View” button under
Compass Cal/Error on the right side of the screen.

d. Temp/Salinity

1) Hereyou can evaluate the ADCP thermistor which controls temperature, salinity, and
speed of sound data.

a) Fluctuations in the time series data mayindicate (1) the ADCP was not allowed to
fully equilibrate to the water temperature prior to measurement, or (2) actual
temperature variations presentin the channel.

2) Checkthe Average Temperaturevs. the User Temperature (entered at the start of the
ADCP measurement).

3) The temperature source canbe changedfrom internal (ADCP)to User for one or all
transects by clicking on the Temperature Source value in the Speed of Sound Settings
table.

a) Note this will change speed of sound and discharge values.

e. BTFilters

1) If GPS datawas used as the reference navigationthis button never needs to be
evaluated. Reference the GPS Filters button instead.

2) Hereyou can evaluate time series velocity data, velocity errors, and how the data can be
adjusted using different filter and interpolation settings.

3) Consult with Science if you feel that BT Filters require adjustment.

f. GPSFilters

1) If Bottom Trackwas used as the reference navigation this button never needs to be
evaluated. Reference the BT Filters instead.

2) Hereyou can evaluate time series velocity data, velocity errors, and how the data can be
adjusted using different filter and interpolation settings.

3) The ATL-g Plot to Google Earth plots the transects for the discharge measurement tothe
Google Earth App. This will only work if the Google Earth App is installed on the
computer that QRev is running on.

4) Consult with Science if you feel that GPS Filters require adjustment.

g. Selected Reference
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1)

2)

3)

4)

5)

6)

7)

The Selected Reference button will be grayed out and this window will not be accessible
if there is no GPS data in the file loaded to QRev.

The summary table provides details on the navigation data available, and describes
changes in calculated discharge based on filter changes in QRev.

The Reference Used panel displays the navigationreference currently being used for the
transect selectedinthe summarytable.

The boat speedtime series shows the boat speed for each of the navigation reference
data types in the same graph per transect.

The ship tracktime series shows the ship track for each of the navigationreference data
types in the same graph per transect.

In the Selected Reference panel, the reference navigation data type used for computing
discharge canbe changed. Refer back to the summary table to see how a change affects
the calculated discharge.

The Composite Tracks feature can automatically substitute one of the other valid
navigation references for the selected navigation reference, if the selected navigation
reference s invalid.

a) Composite tracks default to off.

h. DepthFilters/Draft

1) Heredatafrom eachbeam can be reviewed and the combined cross-sectional value.

2) QRev defaults to using inverse depth weighting to compute the mean depth when the 4
slant beams are used.

3) The filter type canbe changedto eliminate erroneous spikes. Note this will change the
discharge value.

i. WT Filters
1) Hererawand processed water trackdata can be reviewed and adjusted.
2) Note thatthe errorand vertical velocity filters do not always perform well on data from

ADCPs with auto adaptive modes (the RiverPro being one such model) due to the
changein error velocity distribution for the different modes.

a) If this button is yellow or red try turning error and vertical velocity filters off. Note
the changein total discharge.

j- Extrapolation

1)

Default edge extrapolationsettings are determined automatically from algorithms
createdfor the Extrap program.
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k.

2) The data panel displays average normalized depths for segments of the channel, with

each segment equating to5 percent of the total discharge.

3) The Profile Panel is the primary panel in this window.

a)

b)

c)

d)

e)

f)

Edges

Gray Dots represent raw data, normalized discharge or velocity (depending on
which is selected)in each depth cell for all transects selected inthe Fit panel.

Greencircles represent the top cell for each ensemble, the cell at the water’s
surface.

The Red/Black Squares are median points for the raw data in each segment. They
are color coded:

(1) Red:contains less values in the segment than the threshold requires, and is not
used in the computation of extrapolation.

(2) Black: Median values of the composite of all the transects inthe measurements.

The horizontal Red/Blacklines (Whiskers) on either side of each median value
extend to the 25thand 75th percentile of all the data in that segment (i.e. 50% of
the raw data will fall inside the whiskers).

The center line, going through the median squares is the extrapolation line, which is
alsocolor coded:

(1) Magenta: transects collected while crossing the channel from left bank to right
bank (facing upstream).

(2) Blue:transects collected while crossing the channel from right bank to left bank
(facing upstream).

(3) Black:is a composite of all the transects.
The fit panel allows a separate fit edge for each transect.

(1) Leave “Fit” setto “Automatic” for default algorithms to be used (recommended
default setting).

(2) Change “Fit” to “Manual” to change the extrapolation method at the Top and
Bottom of the graphto different fit options — Power, Constant, or 3-Point (Top)
or Power or No-Slip (Bottom).

(@) Set the Exponent value incrementally for Power or No-Slip extrapolations.
The graph will update as the exponent is changed.

(3) Note thatdischarge values will change as extrapolation fits are adjusted.
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1) This window displays the edge settings for computing the left and right edge discharges
and displays graphs for evaluation.

2) The Edges button will be yellow if any of the extrapolated edge discharge contributes
>5% of the total measured discharge for the transect.

a)

b)

c)

Uncertaintyin the total estimated discharge increases with increased contribution
of edge discharge to the total estimate.

Check the “Left Distance (m)” and “Right Distance (m)” values to ensure the left and
right edge distances were entered correctly.

(1) Thesevalues are directly correlatedto the percentage of total discharge
contributed by the edges.

(2) To edit an edge distance click on the “Left/Right Distance (m)” value you wish to
edit. The new value canbe applied to a singular transect or all transects inthe
measurement.

If edge distances are correct but edge discharge remains >5% of the total measured
discharge, not much else can be done during post-processing other than re-
measuring additional transects during which you begin and end the measurement
closerto the edge of water.

7. Save the file and exit Q-Rev.
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SOPG Post-Field Sampling Tasks: Wadable Stream Sites using the ADCP Method

Once field verification of the measurement file is complete, the trimaranfloat with ADCP and GPS
antenna and all components of the Temporary High Line Assembly shall be cleaned following standard
operating procedures for cleaning field equipment used in aquatic systems. Batteriesforthe ADCP and
GPS antenna shall be charged or replaced as needed.

G.1 Document Incomplete Sampling Within a Site

Discharge sampling is scheduled to occur at the prescribed sampling location according to the frequency
and timing describedin Section 4. Ideally, sampling will occur at this sampling location for the lifetime of
the Observatory (core sites) or the duration of the site’s affiliation with the NEON project (gradient
sites). However, sampling may be shifted from one location to another when sampling is compromised.
In general, a sampling location is compromised when sampling becomes so limited that data quality is
significantly reduced.

There are two main pathways by which sampling can be compromised. First, sampling locations can
become inappropriately suited to answer meaningful biological questions — e.g., stream morphology
changes in such a waythat discharge measurement quality is reduced. Second, sampling locations may
be located in areas that are logisticallyimpossible to sample on a schedule that that is biologically
meaningful.

For the wadable stream discharge sampling program, a given discharge transect must be sampled during
100% of the bouts expected for the site (see Appendix E for the number of expected bouts and site-
specific sampling documentation) over a one-year period. Transects that cannot be sampled on this
schedule should be considered compromised.

If sampling at a given transect is not possible during a given bout a trouble ticket should be submitted by
Field Science staff.

To document a missed discharge bout:

1. Createanincident with the following naming convention to document the missed sampling:
‘A0S Sampling Incomplete: MOD — [Root Cause Description]’

a. Example: ‘A0S Sampling Incomplete: DSC — Could not access discharge location due to
flooding’

Staff scientists review incident tickets periodically to determine whether a sampling location is
compromised.
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SOPH Data Entry and Verification: Wadable Stream Sites Using the ADCP Method

Raw ADCP discharge measurement files (i.e. files that have been evaluated in WinRiver Il and Q-Rev but

not post-processed by Science) are stored on an online file storage page and post-processed by Science.
Complete the following steps to upload discharge measurement files.

1. Inthe office (or location with internet connection), store the measurement file on the cloud-

based Box.com folder.

d.

Navigate tothe main Box.com folder where raw ADCP files are stored.

1) “NEONADCP Discharge Measurement Files” https://app.box.com/folder/48084982589)

2) “Raw_Data”

Navigate tothe applicable Domain folder for raw files.

1) Ex:“Domain_03 Raw_Files”

Navigate tothe appropriate site folder.

1) Ex: “FLNT”

Navigate tothe appropriate calendar year.

Create a new folder that is unique to your discharge measurement.

1) Click the “New” dropdown and select “Folder”.

2) Ensurethatthe folder name is in a standardized format.
a) Ex:“SITE_YYYYMMDD” (FLNT_20180317)

Move all of the measurement files into this folder.

1) This includes .MMT, .PDOfiles, and _GPS.TXT file (StreamPro only) - everything that was
saved on the laptop/USB.

2) If any other relevant materials correspondto the discharge measurement (i.e. pictures,
screenshots, etc.) create a sub-folder here where they canbe stored.

3) Inadditionto.PDO and _GPS.TXT files (of which there will be many depending on the
number of transects measured), include only one (1) .MMT file (from WinRiver I1) and
one (1) .XMLfile in the sub-folder.

Once the all datais available on the Box folder, Science will assume it is ready for post-
processing.
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APPENDIXB  DISCHARGE MEASUREMENTS AT RIVER SITES USING THE REMOTE CONTROLLED BOAT
METHOD

The following sections provides instruction on how to complete discharge surveys at NEON river sites
using acoustic Doppler current profiler (ADCP) instrumentation deployed with a remoted controlled
boat.

B.1 Introduction

An acoustic Doppler current profiler (ADCP) uses sound to measure water velocity based on the Doppler
Effect, a principal of physics discovered by ChristianJohann Doppler in 1842. Doppler’s principal relates
the changein frequency of a source to the relative velocities between the source and the observer. An
ADCP applies the Doppler principle by reflecting an acoustic signal off small particles of sediment and
other material (scatterers)that are present in water. The velocity measured by the Doppler principle is
parallel to the direction of the transducer emitting the signal and receiving the backscattered acoustic
energy.

NEON utilizes ADCPs to measure discharge at NEON aquatic sites that contain wadable stream and
rivers. NEON stream discharge measurement collection at river sites can be facilitated using two unique
deployment methods: (1) mounting a RiverPro ADCP (TRDI)to a remote controlled boat (ARC-Boat by
HR Wallingford) or (2) mounting a RiverPro ADCP (TRDI) off the side of a piloted boat. In both instances
the boats are driven back and forth across the channel a number of times with the base the base of the
ADCP beneath the water surface. The ADCP contains four beams pointed at 20 degrees from the vertical
that can continuously measure water depth, water velocity, and instrument speed. Discharge and
velocity calculations performed by ADCPs during streamflow measurements are well-documentedin the
literature (Mueller et al., 2013; TRDI, 2015) but the basic premiseis as follows (Den Herder, 2018):

e The ADCPinstrument transmits short pulses of sound at fixed frequencies into the water.

e The transmitted sound bounces off scattered material suspendedin the water (sediment,
microscopic organisms, etc.). The returnedsignals from these scatterers are shiftedin
frequency.

e The returned signals from each beam are used to create the water currents in east, North, and
Vertical velocity vectors.

e Returnedsignals are continuously processedinto separate depth cells (or bins) to provide a
profile of the water column

e Binned velocity and depth areintegratedto calculate bin discharge, which are then summed to
calculate total discharge

e Multiple discharge transect measurements are completed and mean discharge across transect
measurements is calculated and reported as total discharge.

The ADCP measures the relative motion of the water to the ADCP by correcting the measured water
velocity with the measured velocity of the vessel used to deploy the instrument (boat, trimaran float,
etc.). The velocity of the vessel can be calculatedin two ways: externally via a global positioning system
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unit (GPS), or internally utilizing ADCP bottom tracking technology. The ADCP divides the water column
into depth cells (or bins) and reports a velocity for each depth cell.

The ADCP software integrates total bin velocity over the bin depth to obtain bin discharge. The resulting
sub-sectiondischarges are then summed over the width of the cross-sectionto obtain total measured
discharge for each transect. Certain areas within the channel cross-section profile cannot be measured
by the ADCP (at the water surface due to draft and flow disturbance around the instrument, near the
channel bed due to side-lobe interference, and near each bank due to shallow depths). These areas
must be estimated by the ADCP software. Discharge inthe unmeasured upper and lower portions of the
cross-section are typically estimated using a one-sixth power-curve estimation scheme while discharge
in the unmeasured portions of the cross-section near the bank edges are estimated using a ratio-
interpolation method (Simpson, 2001). Total stream discharge is the sum of the total channel discharge
(the sum of all discharge bin values calculated during the discharge measurement transect), the near-
shore discharge measurement onthe left side of the channel and the near-shore discharge estimate on
the right side of the channel. The total discharge associated with the measurement is the mean
discharge of all transects conducted during the sampling bout. On average it expectedto take an
experienced field crew 30-60 minutes to complete a stream discharge measurement from start tofinish.
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SOPI Preparing for Sampling: River Sites Using the Remote Controlled Boat Method

The RiverPro ADCP (Teledyne) (Figure 36) and ARC-Boat (Figure 37) remote controlled boat are the
preferred means to measure discharge at NEON river sites. Hemisphere V102 antenna units provide GPS
heading and positioning data during each ADCP measurement. Three software packages are required for
all ADCP discharge surveys: (1) WinRiver Il software (Teledyne), a discharge data application for data
collection and post-processing, and (2) QRev (USGS OSW), a Matlab program for advanced post-
processing of WinRiver Il measurement files, and (3) ParaniWin, an executable that sets upand
configures the Parani Bluetooth dongle. If an ARC-Boat deployment is not available, the Piloted Boat
method (AppendixC) can be used as an alternative means to capture ADCP data.

Figure 36. RiverPro ADCP. Left: base of the ADCP showing the five beam lenses; Right: top of the ADCP with
indicator lights and power cord.
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Figure 37.The ARC-Boatis the preferred deployment method to measure discharge at NEON river sites.

1.1 Preparing for Data Capture

Prior to leaving the office ensure that the following criteria are met (each point explained in detail

below):

e All necessaryequipment is gathered and prepared (Table 13).

e Attachthe RiverProADCPto the ARC-Boat ADCP Adapter.
e Setup and test Bluetooth communications.

e Setup and test GPS communications.

e |[fthe site has an approved stage-discharge rating curve, the current rating equation is available
for measurement comparison/validation.

1.2 Attaching the ADCPto the ARC-Boat ADCP Adapter

The ARC-Boat ADCP adapter powers the RiverPro ADCP and holds it in place within the ADCP

compartment of the boat (Figure 38). Prior to deploying the ARC-Boat into the water, always leave the
protective cover on the base of the ADCP so that the beam lenses (Figure 36) do not get scratched.
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1. Connecta fully charged 12V batteryto the internal compartment of the ADCP adapter. The
ADCP must be powered in order to communicate and collect measurements.

a. Toaccesstheinside of the ADCP adapter the GPS mount plate must first be removed by
disconnecting the four nuts on the base.

b. The ADCP adapter can be then be removed by loosening the four plastic screws at each of
the corners.

2. Attachone end of the long set screws into the top of the ADCP.

3. Attachthe other end of the long set screws to circular base plate of the ADCP adapter using the
wingnuts.

4. Connectthe ADCP cable coming out of the ADCP adapterto the ADCP. Lubricate the connection
with dielectric grease prior to connecting the cables.

Flip the adapter switchto “Power ON”. The red light on the ADCP adapter should light up.
One of the three LED lights on the ADCP will turn green when the instrument is powered.

Ared light on the ADCP indicates a system error. Contact Science if this light turns on.

© N o Wu

Attachthe circular base plate of the ADCP adapter to the hull of the ARC-Boat using the small
set screws.

Figure 38. The ARC-Boat setup with the RiverPro ADCP adapter. A: connect the long setscrews to the top of the
ADCP; B: connecta fully charged 12V battery inside the ADCP adapter; C: connect the long set screws to the
circular base plate of the adapter with the wingnuts, connect the ADCP cable coming out of the adapterto the
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ADCP, and flip the adapter switchto “PowerOn” (ADCP light should be green); D: the RiverPro ADCPand ARC-Boat
ADCP adapter fullyintegrated; E: set the ADCP adapter with the ADCPinto the ADCP compartment of the ARC-Boat
and connectthe circular base of the adapterto the boat using small set screws. Not shown: GPS mounting plate on
top of the ADCP adapter.

1.3 Attaching the GPS Antennato the ARC-Boat ADCP Adapter

A GPS mount plateis installed above the ARC-Boat ADCP adapter to hold the Hemisphere V102 GPS so
that GPS data is available during river discharge measurements. A3/16” Allen wrench is required to
installthe GPS antenna onto the GPS mount. The GPS antenna must be located directly above the ADCP
adapter and aligned with ADCP Beam 3 (Figure 39).

Toinstallthe Hemisphere V102 GPS antenna onto the GPS mount:

Connect the ADCP Adapter to the ARC-Boat withthe ADCP installed (Section 1.2).

2. Disconnectthe GPS cable at the back port of the GPS antenna.

a. Loosen the cable connector by twisting it clockwise.

b. Gently pull the cable so that it is released from the antenna.

3. Place the GPS antenna on top of the GPS mount, lining up the female threads in the antenna
and the male threads on the mount.

4. Gently turn the GPS antenna clockwise until it is fully seated on the GPS mount.

5. Adjust the GPS antenna so that the front of the antenna is aligned with ADCP Beam 3 and the
space betweenthe two small holes in the back of the antennais directly over the center of the
ADCP adapter (Figure 40).

a. The “front” of the GPS antenna is indicated by an arrow underneath the antenna.

i. It may be helpful to place a marker on top of the GPS antenna to ensure the
front is always facing the correct direction.

b. The areato be centered over the ADCPis indicated by the space between two small
screws in the back of the unit.

6. Once the GPS is properly oriented, use a 3/16” Allen wrenchto tighten each of the twoset
screws located on each side of the black base on the bottom of the GPS antenna.

a. Thesescrews setthe GPS antenna in place so that it cannot move on the mount.

7. Connect the GPS cable into the back port of the GPS antenna.

a. Make sureto line up the cable with the port properly. A small notch in the top of the
cable indicates the correct orientation (the cable should be placed into the port so this
notch is on the top)

b. Once lined up gently push the cable into the port.

c. Tightenthe cable connect sothat itis securely connected to the GPS antenna.

8. When not in use the GPS antenna should be disconnected from the GPS mount and storedin a
protected location during transportation.
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Threaded hole to
connect mount

Figure 39. Installing the Hemisphere V102 GPS antenna ontothe ARC-Boat GPS mount.

157.89 mm (6.21")

.\\ i _/
il SET SCREW

(2.717)
3/8-16 THREAD SIZE
2 PLACES

MOUNTING HOLE M8 “"(ﬁ;‘:;“ a MOUNTING HOLE
THREAD SIZE 4 : 1-14 UNS-2A THREAD SIZE

3175 mm
(1.257)

414,39 mm (16.31")

Figure 40. Hemisphere V102 GPS antenna schematics. Top: the back of the unit with cable port show; Middle: the
side of the unit showing one of two set screw locations; Bottom: the base of the unit, the redcircle to the right of
the unitindicates the location that must be centered over the ADCP, the white arrow to the left of the unit
indicates the direction the unit must face so thatitis oriented toward Beam 3 of the ADCP.

Page 118



n e c’ n Title: AOS Protocol and Procedure: DSC — Stream Discharge Date: 03/16/2022
®

Operated by Battelle [ yEoN poc, #: NEON.DOC.001085 | Author: N. Harrison Revision: H

The GPS antennais considered an external heading, i.e. the internal ADCP heading is not being used.
When an External Heading is applied, the Bottom Track reference assumes the External Heading device
is aligned with Beam 3 of the ADCP. Therefore the Bottom Trackreferenceis directly affected by the
relationship betweenthe GPS heading and the ADCP heading. The GPS antenna is not required to face
towards the bow of the boat but it must be aligned with the ADCP Beam 3.

If the GPS antennais not aligned with the ADCP Beam 3, a heading offset must be enteredto align the
External Heading and Bottom Track Ship Tracks in the WinRiver Il settings (Figure 41). This can be done
prior to the transect measurementinthe Field Configuration Settings or following the transect
measurement in the Playback Configuration settings.

To enter an External Heading offset:

1.
2.
3.
4.
5.
6.

Open the Transect node.

Select “Playback Configuration”.

Open the “DS/GPS/EH” tab.

Under the “External Heading” section, enter a Heading Offset value.
Right click on the value to apply to all transects (if required).
Playback the transect toapply the offset.
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Figure 41. Applying ExternalHeading offsets to align GPS and Bottom Track Ship Tracks.

.4 Establishing Bluetooth Connections forthe ADCPand GPS Antenna

The RiverPro ADCP and Hemisphere V102 GPS antenna communicate with WinRiver |l software
(installed on the laptop) wirelessly via a Bluetooth (wireless) connection. One ParaniSD1000U Bluetooth
transmitter, or dongle, is required to send ADCP and GPS data. It is best practice to have another one in
the field as a spare. The ParaniBluetooth dongle contains a USB interface adapter thatis pluggedinto a
laptop COM port. ParaniBluetooth dongles are setup and configured using ParaniWin software. This

executable must be downloaded and installed on the laptop used for ADCP discharge measurement.

If the same laptop is used for ADCP measurements (this is recommended for ease of communication
setup and software availability) the following setup should only need to occur prior to the initial
measurement. Following the initial setup, the ADCP and GPS antenna should automatically connect to
the laptop software via the dongle. These steps should also be used when troubleshooting connection
problems. Setup, testing, andtroubleshooting is best done in the office prior to deployment in casean
internet connection is needed. An ADCP discharge measurement cannot be completed if Bluetooth
communications are not configured.

Physically configure the Parani dongle (Figure 42):

1. The Paranidongle has a set of four DIP switches that are usedto set the Bluetooth adapter’s
baud rate and data flow control.
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2. These DIPswitches need to be in the correct physical configuration using a small screwdriver,
pocket knife, pen, or similar tool.

3. Move the DIP switches tothe correct position in order to set the Baud Rate to 11520Kb. The
diagramon the left of the dongle shows how the positions of each switchrelate to baud rate
configuration.

4. Set the first and second DIP switches tothe right.
5. Set the third switchto the left (115200 baud rate)

6. Set the fourth (bottom) switch to the left (HW Flow Control OFF).

(liactory Reset Eutton]

Pairing Button

Antenna

Cap USB Interface

Reset

Porcmu . SDT

Figure 42. Top: Parani-SD1000U USB Bluetooth Adapter with default settings. Bottom: Correct settings for ADCP
and GPS Bluetooth configuration.

Once physically configured, each dongle needs to be initially setup with the ParaniWin software.
Complete the following steps for the ADCP dongle, then repeat for the GPS dongle:
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Ensure thatthe ADCP and GPS units are powered and fully connected to the ARC-Boat ADCP
Adapter.

Plug the Paranidongle into a USB port on the laptop.

Use Windows Device Manager to determine the laptop COM (communication) port that the
Parani is assignedto.

a. Navigatetothe Windows Device Manager.
1) Start Menu > Search “Device Manager”
b. Open the “Ports (COM & LPT)” node.
c. Note the COM port number the Paranidongle is assignedto.

1) Unplug and re-connect the Paranidongle to note which COM Port number appears and
re-appears. This is the COM Port the Parani dongle is assigned to.

(1) If using Windows XP and later systems, the driver will likely load automatically
when you plug in the Parani dongle.

(2) If the Paraniis not showing up in the Ports (COM & LPT) node, it may show up in
the “Other Devices” node.

(a) Ifthisis the case anupdate to Parani firmware is required (under the
picture of the dongle, find the Downloads tab, click on the firmware link,

and click the download button to save the file to a known folder).

(b) Once complete, open Windows Device Manager, right clickon the
appropriate COM Port that the Parani is assigned toand navigate to the
Drivers window.

(c) Choose “Browse my computer software for driver software”. Click next and
it will respond with a message of success or failure.

(d) If successful, close this window and return to Windows Device Manager.
The Paranishould now appear under the COM Ports node.

(e) If unsuccessful contact Science for troubleshooting.
d. Select the Parani SD100U dongle COM Port and set the baud rate to 115200.

1) Rightclick on the COM port assignedtothe Parani dongle and select “Properties” >
“Port Settings”.

2) Configure Port Settings.
a) Bits per second =115200.

b) Databits=8
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c) Parity = None
d) Stop bits=1

e) Flow control = None

3) Click on the Advance Settings button.

a) Checkthe COM Port number assignedtothe Paraniin the top of the Advanced

Settings window.

b) Inthe BM Options section, select the Latency Timer drop down and set to 1msec.

c) Click OK twice to exit Windows Device Manager.

10. Note the LED indicators on the Parani dongle.

a.
b.

C.

11. Open ParaniWin software to configure the Bluetooth connection.

a.

The “Mode” LED indicates which mode the Parani dongle is currently configured to.

Ensure the Parani dongle is setto MODE1, the LED will blink green at 1 second intervals.

The “Connect” LED indicates whether the Parani dongle is connected to the ADCP/GPS unit,
the LED will blink green at 1 second intervals.

The UART Setting window will automatically pop up that displays the communication
settings between the Parani dongle and the laptop. Ensure that the configured settings are
set correctly. Notes: these settings must COM Port and physical dongle settings orthe

connection will not be possible.

1) Serial port: Select the laptop COM port number the Paranidongle is assignedto (as

shown in Windows Device Manager).

2) Baudrate: 115200
3) Parity: None

4) StopBit: 1

5) Click “OK”. Initial configuration should be complete.

Select the “Device Setting” tab.

1) Set “Operation Mode” to “Model”.

2) Check that Device Settings are the same as what was entered in the UART Setting

Window.

3) Under “Security Option” check the “Authentication” box and enter “0000” for the “Pin

Code”.
4) Click “Apply”.
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5) A “Completed Configuration” message should pop up.

a) If the connection was unsuccessful: review physical Parani dongle settings, COM
port settings in Windows Device manager, and settings enteredin ParaniWin and
repeat process.

12. Select the “Connection (out)” tab.

a. Click the “Search” button. This will ping all available wireless networks that are within range
of the laptop.

b. Chosethe desiredinstrument to connect to and click “Connect”.
1) The ADCPshould be shown as “RDI RPro”.
a) This label may vary.
2) Click “Connect”.
c. A window will pop up with a “Connected successfully message”.

d. One of the lights on the ADCP will turn blue, indicating that the Bluetooth connection was
successful.

1) If the connection was unsuccessful:

a) Review physical Parani dongle settings, COM port settings in Windows Device
Manager, and all settings enteredin ParaniWin.

b) Repeat process.

13. Once the dongle has successfully connected, close the ParaniWin program.

1.5

a. IftheParaniWin programis notclosed, WinRiver Il will not be ableto connectto the
ADCP.

Testing GPS and ADCP connectionsin WinRiverll

Once the ADCP/GPSdongle connection has been successfully connected via Bluetooth, the connection
must be testedin WinRiver Il in order to ensure that data can be transmittedtothe program. This must

be done prior to each discharge survey that utilizes ADCP instrumentation and is best completed in the

office in case additional troubleshooting is needed.

1.

Ensure thatthe ADCPis fully powered (greenlight on) and setup for Bluetooth communications
via the Paranidongle (blue light on).

Open WinRiver Il.
In the WinRiver Il main screen, click Configure > Peripherals.

a. Test ADCPcommunications.
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1)

2)

3)
4)
5)
6)

7)
8)

Ensurethat the ADCPis fully powered (green light should be on) and the Paranidongle
is installedin the designated COM Port.

In the “Peripheral Configuration Dialog” window, under the “Peripherals” node, double
click on “Read Serial Raw ADCP Data”

Double click on “Port: ADCP Serial Port”
Check that COM settings are correct and press OK.
With “Port: ADCP Serial Port” still highlighted, click the “Test Port” button on the right.

A dialogue box will open and you should see some information begin streaming
regarding Teledyne RiverPro firmware. This indicates that the ADCPis recognized by the
WinRiver |l program (Figure 43).

a) If nothing appears than WinRiver Il is not recognizing the ADCP.

b) Ensurethat ParaniWin is closed. Ifopen, close this program and repeat the
Peripheral test.

c) If ParaniWinis closedand the Bluetooth connection was successfulinthat program,
check COM settings in “Port: ADCP Serial Port” and repeat the Peripheral test.

d) If nothing appearsin the test window, further ADCP testing can be completed in the
Configuration Dialogue tab of the Measurement Wizard window.

Click “Stop” and “Close” to cease testing and close the test dialogue window.

Once all configuration and testing is complete the ADCP Adapter batteryshould be
switched off.

a) Note: because GPS datais wired through the RiverPro ADCP cables the GPS Port
cannot be testedin the WinRiver Il Peripheral environment. In most cases ADCP
data recognition in the Test Port Dialog indicates that GPS data is properly
configured. Confirmation of GPS data availabilityis covered in future steps.
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Figure 43. RiverPro ADCP Test Port Dialog indicating that ADCP data is streaming from the ADCP to the laptop.

1.6 Navigate to the Discharge Transect

If a discharge transect, or cross-section, has already been established, the bounds should be
permanently marked using stakes or plot markers (one on eachside of the stream). Navigate tothis
location and proceed to Section I.7.

If a discharge transect has not been established at the site proceed with the following steps:

1. Determinean appropriate location to establisha discharge transect.

a. Atriver sites, the transect location must be locatedin a straight reach inrelatively close
proximity of the staffgauge and pressure transducer. Consult with Science if the pressure
transducer location is unknown or has not yet been established.

b. Anideal discharge transect will:

1) Belocated in areasonably straight channel with velocity lines that are more or less
parallel to eachother.

2) Containvelocities that are, for the most part, > 0.15 m/s, and depths that are, for the
mostpart, > 0.15m.

3) Containa stable streambed free of obstructions that would create eddies, slack water,
and turbulence.

4) Containmeasurement sections that are roughly parabolic, trapezoidal, or rectangular.

5) Containa stable downstream control feature.
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C.

Take a picture of the transect location that best meets this criteria as well as the
downstream control feature and send to Science for consultation.

Assess the Discharge Transect

Prior to collecting the discharge measurement identify any instrumentation or environmental issues that
would negatively affect data quality. Document any temporary hydrologic conditions in the (AOS) Field
Metadata and Gauge Height [PROD] app in Fulcrum. If conditions are unfavorable to discharge
measurement collection, submit a trouble ticket and consult with Science.

Unfavorable conditions include, but are not limited to:

1.

The staff gauge is either not present or has been displacedin some way.

a.

A discharge measurement should not be collected if a staff gauge is not present at the site
or the gauge has been displaced in any way.

Submit atrouble ticket to Science that includes photos of the gauge.

If the staff gauge is topped during high flows and a discharge measurement can be safely
collected, attempt to markor in some way reference the elevation of the edge of water
(only do soif this can be accomplished in a safe manner). A future survey of this location
(relative to the staff gauge) can provide an estimate of gauge height during the
measurement.

Note that if a discharge surveyis associated with a reaeration sampling event, discharge
should still be measured regardless of staff gauge presence.

A pressure transducer is either not present or has been displaced in some way.

a.

A discharge measurement may be collected in the event that the pressure transducer is

missing or has been displaced. However the absence of this instrument prevents continuous
discharge from being estimated.

Submit a trouble ticket to Science immediately if the pressure transducer is missing or has
become displaced.

Streamflow is exceeding the banks causing unsafe conditions on the floodplain.

a.

Refer to NEON Operations Field Safety and Security Plan (AD[02]) for details.

There is an insufficient amount of water in the channel to conduct velocity measurements.

a.

See Section 4.2.1.

Refer to NEON Operations Field Safety and Security Plan (AD[02]) and NEON Operations Field
Safety and Security Plan (AD[02] for further details.
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Field Sampling: River Sites Using the Remote Controlled Boat Method

Start a New Measurement in WinRiver I

Once the discharge cross-section has been established or assessed, configure the ARC-Boat following

steps detailedin Sectionsl.2and I.3. Anew measurement file can now be createdin WinRiver Il using
the following steps:

1.

P
3.
4

Set the laptop system time zone to UTC (Coordinated Universal Time).
Start the WinRiver Il program.
In the WinRiver Il main screen, click Configure > Units > All S| to set units to metric.
In the WinRiver Il main screen, click File > New Measurement to run the Measurement Wizard.
Fill in all information in the Site Information tab:
a. Station Name: Four digit site code of where you will be measuring discharge (i.e. “TOMB”)
b. Station Number: Leave blank.
c. Measurement Number: The sequential discharge measurement number for the site
d. Agency: “NEON”.
e. District: Leave blank.
f.  Hydrologic Unit: Leave blank.
g. Field Party: Initials of all crew involved in measurement.
1) Separateinitials with a comma delimiter (i.e. NH, LFS).

h. ProcessedBy: Initials of technician operating the WinRiver Il software and evaluating data
collection.

i. Deployment Type: “RC Boat”.
j. Boat/Motor: Leave blank.

k. Meas. Location: If measured at the regular discharge cross-section enter “DSC1”, if
measured at a different cross-section within the site denote that with a different code here
(i.e. “DSC_US" if the cross-sectionis upstream of the regular location).

1) Make sureto alsoinclude notes in the main remarks sectionthat describe alternative
transect locations (be sure to include an estimate of how many meters awaythe
measurement was conducted from the regular location).

a) Toadd a note to the main Remarks section of the measurement file, right-click Site
Information on the Measurement Control window.

b) Enter notes into Remarks section.
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Grid Reference: Leave blank.

6. Select the “Rating Information” tab.

a.

b.

Inside Gage Height: Enter the water level measurement on inside of staff gauge.
Outside Gage Height: Same value as “Outside Gage Height”.

Rating Discharge: Enter the predicted discharge given gauge height from rating curve, if
available.

Index Velocity: Leave blank.
Rated Area: Leave blank.
Rating Number: Leave blank.

Water Temp: Enter the water temperature (°C) measured using a thermometer submerged
in the stream for atleast 5 minutes.

1) The measured water temperature should be within 2 degrees of the ADCP temperature
measurement.

a) Tocheck the temperature being measured by the ADCP, open the Test Result
dialogue box under the QAQC > ADCP node. The measured temperature will be
displayed along with other sensor data.

b) You canalsoview temperature time series data during or aftera transect
measurement by selecting View > Graphs > Time Series > Temperature.

c) The ADCP must be sittingin the water for at least 5 minutes to allow the instrument
to fully equilibrate to the water temperature.

d) Ingeneral ADCPtemperature measurements do not drift until there is a major issue.
If this does occur, the ADCP-measured temperature will deviate greatly from the
thermometer measurement. If this is the case make a note in the measurement
note window and contact Science following the measurement bout.

Tail Water Level: Leave blank.

Magn Variation Method: Model

Measurement Rating: fill this out at the end of the measurement based on your judgment of

the measurement quality

1) This is a subjective assessment. Discretionis givento the hydrographer who led the
survey. Include any relevant field notes that formulated the basis of this ratingin the
remarks section.

Control Codes: select any that apply to the measurement.

Wind Speed: Enter the measured wind speed (kph) using an anemometer.
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1)

If wind speed was entered in units other than kph, note the units used in the remarks
section.

m. Wind Direction: Enter the measured wind direction using an anemometer.

1)

If the anemometer does not provide a direction measurement enter:
a) “Upstream”:ifthe wind is blowing up river

b) “Downstream”:ifthe wind is blowing down river

c) “Cross-wind”:if the wind is blowing across the river

d) “Mixed”:if the wind is not blowing in any particular direction

n. Edge Method: Enter the method used for determining bank distances (i.e. laser rangefinder,

meter tape, eye estimate, etc.).

7. Select the “Configuration Dialogue” tab.

a. The software will immediately tryto recognize the ADCP (“Interrogating the ADCP...”).

1)

If the connection is successful, the button next to “ADCP” will eventually turn green.

a) This cantake afew minutes.

b) This means thatthe software recognizes the ADCP via the Parani Bluetooth dongle.
c) The connection should be successful if the ADCP Peripheral test was a success.

d) If awindow pops up thatsays “The ADCPis not responding...” this means that the
ADCP was not recognized by the software.

(1) Click “No” (clicking “Yes” will have the software cycle through all available
ports).
(2) Ensurethat ParaniWin configuration was successful for the dongle and that the

softwareis closed.

(3) Inthe “Serial Communication Settings” window, ensure that COM Port settings
match what was enteredin ParaniWin software. Click OK.

(4) If the “The ADCPis not responding...” message returns, click Cancel.

(5) Inthe “ADCP” dropdown, ensure that the correct ADCP model (RiverPro) is
selectedin the dropdown box. Click the “Check ADCP” button to re-test
configuration.

(6) The ADCP must be recognized by the software for the discharge measurement
to be conducted. If communication problems persist, submit a trouble ticket and
contact Science.

b. Check GPS configuration settings.
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1) Ensurethatthe GPS antenna is attached, powered and properly configured above the
ADCP adapter (Section 1.3).

2) Checkthe “Int. GPS” box.
(1) Set the baud rate to 19200.
3) Checkthe “Ext. Heading” box.
(1) Leavethe “Hdg Off [deg]” box blank.
(2) Anerror message willappear.
(3) Click cancel, this error can be ignored.
c. The DepthSounder box can be left blank.
d. Under Offsets:
1) EnterTransducer Depth.

a) Ensurethatthe boat is steadyand stable in the water column prior to taking this
measurement.

b) Measure from the water level to the center of the slantin the transducer faces with
a ruler or metric tape.

c) This is a very important measurement! Repeat it two or three times to ensure
accuracy.

e. Enter Magnetic Variation, the angle of declination relative to your location in the world.

1) For greatest accuracy, checkthe National Geophysical Data Center website tofind the
declination angle based on your latitude and longitude.

2) Some examples:
a) Butler,AL: -2°27" W (-2.27)
b) Newton, GA: -4°59’ W (-4.59)
c) Arcata, CA: +14° 16’ E (+14.16)
f. Enterthe MaxWater Depth.

1) This is an estimate of the maximum water depth (m) that is expectedto be measured
during the discharge measurement.

g. Enterthe Secondary Water Depth

1) This is an estimate of the minimum water depth (m) thatis expectedto be measured
during the discharge measurement.

h. Enterthe MaxBoat Speed
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1) This is an estimate of the maximum boat speed (m/s) that is expected during the
discharge measurement.

i.  All other values can be left as defaults.
8. Select the “Output Filename Options” tab.

a. Under the “Recording” section:

1) Inthe “Filename Prefix” box enter the four-digit side code.

a) Example: “LEWI”.

1) Ensurethe “Use Prefix in Filename” box is checked.

2) Leavethe output directory at the default location (C:\Measurements\).
g. Inthe “Include Filename Options” section:

1) Uncheck the “Measurement Number” box.

2) Leave “Transect Number” at “0”.

3) Leave “Geographic Current Survey” and “Sequence Number” boxes unchecked.
h. Inthe “Use Date/Timein Filename” section:

1) Select “Long (YY-MM-DD-hhmmess).
i. Inthe “Use Delimiterin File” section:

1) Select “Underscore” (default).

j- Checkin the Filename Preview section that the above settings are correctly applied (Figure
44).

k. Note thatthese settings canonly be entered at the start of a New Measurement. Once the
Measurement Wizardis closed, filename settings can only be changed by starting a new
measurement.

9. Open the Command Preview tab.
a. Reviewallinformation to ensure that is correct.
b. Ensurethatgreen checks are present for ADCP and GPS communications.
c. Click the Finish button to complete wizard.
10. Review the Summary Page tabto ensure all information was correctly entered.
11. Click Finish to exit the Measurement Wizard.
12. Verify that GPS data is being collected.

a. Once powered, allow a few minutes for the GPS to connect to available satellites.
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b. Onthe WinRiver Il main screen, Click Acquire > Start Pinging.

c. Click View > Tabular > GPS to confirm the availability of GPS data (Figure 23).

1)

2)

3)

External/Integrated (GGA) refers to differential GPS data collected by the external GPS
antenna (i.e. SX Blue Il or Hemisphere V102).

Internal (GGA2) refers to the georeferenced GPS data collected by the GPS unit that is
internal to the ADCP.

External GPS datais much more accurate thanthe internal data as reflectedin position
(latitude/longitude) digits.

The number of satellites will often be less in the external GPS column due to the higher
quality threshold for picking satellites (i.e. elevation angle) contained in the external
unit.

HDOPis the measure of possible error due to the geometry of the available satellites,
therefore as this value decreases the quality GPS data increases.

a) Ideally HDOP values should be < 2.

d. Click View > Time Series > Graphs > GPS data to confirm GPS data stream (Figure 45).

13. Once GPS data has been verified, end ADCP pinging by clicking Acquire > Stop Pinging.

Setup Dislog %
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= || 1Use Preficin Fizname
Output Directery.
[c:\Measureme: nis\LEWI Browse
Include Flename Options
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[ Sequence Number
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Output Filename (O Mo Date/Time i
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Figure 44.Required settings in the WinRiver Il Output Filename Options dialogue box within the Measurement

Wizard.
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Figure 45. Above: GPS Tabular window that confirms GPS data is available andis being collected; Below: GPS Time
Series window thatindicates GPS datais streaming.

J.2 Pre-Measurement QAQC: Overview

The following QAQC protocols are critical to quality data collection and must be initiated prior to the

first transect measurement of each ADCP discharge bout.

e Set the ADCP clock

e Setupthe ARC-Boat

e Deploy the ARC-Boat

e Practice operating the ARC-Boat

e Collect a temperature measurement

e Executean ADCPtest

e Calibrate theinternal ADCP compass

e Perform a moving bed test and assess moving bed test summary
e Configure the reference navigation

J.3 Pre-Measurement QAQC: Set the ADCP clock

Prior to the initial transect measurement the ADCP clock must be set to matchthe PC time (UTC).
Failure to properly set the ADCP clock will resultin data files with incorrect timestamps.
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Set the time zone on the PCto (UTC) Coordinated Universal Time (Figure 46).
a. Rightclick on the date time in the lower right corner of the screen.

b. Select “Adjust date/time”.

c. Inthe “Timezone” dropdown, select “(UTC) Coordinated Universal Time”.
In the WinRiver Il main screen, click on Acquire > Set ADCP Clock.

Set the ADCP clock to match the PC time (UTC).

Click the “Set Clock” button.

a. Note: only clicking the “OK” button will not set the clock, the “Set Clock” button must be

selected.
Settings - o X
@ Home Date & time
l Find a setting ; ' *Some of these settings are hidden or managed by your organization.

Time & Language Current date and time

3:24 PM, Friday, September 27, 2019
I Date & time

@ Region

A Llanguage Set time zone automatically
@D off

0 Speech

Set the date and time manually

Change

Synchronize your clock

(UTC-03:00) Salvador

(UTC-02:00) Coordinated Universal Time-02
(UTC-01:00) Azores

(UTC-01:00) Cabo Verde Is.

(UTC) Coordinated Universal Time

(UTC+00:00) Dublin, Edinburgh, Lisbon, London
(UTC+00:00) Monrovia, Reykjavik

(UTC+00:00) Sao Tome

(UTC+01:00) Casablanca

Figure 46.Setthe PCused forthe discharge measurement to (UTC) Coordinated Universal Time and match the
ADCP clock to this setting.

J.4

Pre-Measurement QAQC: Setup the ARC-Boat

Follow the steps below to configure components of the ARC-Boat (Figure 47) prior to additional QAQC
procedures.
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10.
11.
12.

Ensure thatthe ADCP adapteris connected to the ADCP and secured within the ADCP
compartment of the boat.

Installthe GPS antenna onto the GPS mount (Section 1.3).
Ensure that the detachable bow is connected to main body.

Ensure the bilge plug is in place and tightened. It must form a secure seal with the hull to
prevent the boat from filling with water and capsizing.

Set up the boat power supply.

a. Unlock and open the battery compartment.

b. Make sureall of the controls switches are in OFF or neutral position.
1) lIsolatorswitchisin OFF position.
2) Radio controller power switchis in the OFF position.
3) Both control sticks are centeredin the neutral position.

4) Main power switchon the “deck” or the top of the ARC-Boat bow near the front handles
is in the OFF position.

Place twofully charged batteries inthe battery compartment and connect them to the internal
wiring connections within the compartment.

Turn on theisolator switch.
a. The power LED will light up orange if power is connected.

Close the battery compartment and secure the latches, checking the watertight sealis in place.
Water in this compartment will cause damage tothe equipment.

Turn on the main power switch.

a. The ‘Props Live’ LED will turn red, indicating the ARC-Boat is powered ON and the props are
capable of movement.

b. Usecaution around the propellers and rudders when this switchis set to ON.
Ensure that the remote control batteryis fully charged.
If the remoteis not fully charged, insert fresh batteries prior to the discharge measurement.

Center both sticks on the radio controller againto put the ARC-Boat in neutral, so that the boat
can be moved safely.
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Detachable bow

Main power switch

Battery compartment

ADCP compartment

Control switches

Rear hatch

If found please phone 0800

Propeller Propeller

Bilge pump

Figure 47. Above: Top of the ARC-Boat (not pictured: ADCP Adapter with GPS mount); Below: Sternof the ARC-
Boat

J.5 Pre-Measurement QAQC: Deploy the ARC-Boat
1. Ensurethatthe ADCPand the Hemisphere GPS units are securely connected to the ARC-boat.

2. Remove the protective cover on the base of the ADCP.
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3. Before placing the boat in the water, test that the propellers and rudders are functioning
correctly with the radio controller.

4. Usingthe handles on the side of the boat, gently place the boat into the water. This is best done
with two people on solid footing.

5. Allow the ADCPtransducers tobe submerged in the water for at least 5 minutes prior to
discharge measurements in order to sufficiently equilibrate to the water temperature. Failure to
do sowill impact measurement accuracy.

J.6 Pre-Measurement QAQC: Practice Operating the ARC-Boat

Itis critical to become familiar with the ARC-Boat controller and comfortable with instrument operation
before continuing on with additional pre-measurement QA procedures and prior to measurement
collection.

ARC-Boat Operation

Consider the river conditions that are currently present. ARC-Boats are designedtowork in streamflow
conditions from low flows to floods (surface water velocities of up to 5 m/s). Surface velocities outside
of this range will cause the boat batteries todrain quickly and make controlling the boat very difficult. If
velocities are such that the boat cannot be operated in a safe and efficient manner, do not proceed with
the measurement and contact Science.

Practice using the remote control to drive and turn the boat. The remote control must always remain
strapped around the neck of the operator to prevent it from falling into the water.

If the batteries are too low or the signal between the radio controller and the ARC-Boat is lost, the
motor in the ARC-Boat will shut down stopping the rudders and propellers. The ARC-Boat is deliberately
programmed to shut down in these situations for safety reasons. It will drift withthe current and have
to be recovered. It is best practice to have a recovery plan in mind and an idea of where the boat could
end up prior to deployment.

If surface water velocity is sufficient, operate the ARC-Boat sothat the bow is pointed upstream and into
the velocity path during the discharge measurement (Figure 48). To obtain a sense of the velocity flow
paths try letting the boat drift momentarily in the streamflow, this usually allows the gauge which way
the velocity vectors are pointed within the discharge cross-section. Crabbing across the channel is not
always possible during periods of low flow, in these situations it is allowable to have the bow of the boat
pointed more towards the opposite shore (Figure 49).

The ARC-Boat rudders require motion in order to control the direction of the boat. In cases where the
boat is not in motion, the throttle will need to be activatedto change the boat direction using the
rudders. Standing slightly downstream of the ARC-Boat allows for easier orientation of how movements
with the remote control relate to the ARC-Boat. If operating the remote control from a piloted boat, it is
very important to remainfar enough downstreamso that the piloted boat motors and hull do not create
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velocity disturbances within the measurement transect. Operation of the remote controller will vary
based on where the boat is in the channel and the desired path of the boat (Table 9).

Ensure that all boat and remote control batteries are fully charged prior to the measurement and that
spares are on hand if needed. Charged batteries are critical for maintaining control of the boat during
operation. As remote control and ARC-Boat batteries become low (the radio has a voltage indicator, low
batteries in the boat can be observed by sluggish or lagging response to operation) operational
performance will decrease. At a certain point, low voltage in either the remote or the boat batteries will
resultin the total loss of control of the boat.

Figure 48. Whensurface water velocity is sufficient operate the ARC-Boatin suchaway that the bow s pointed
into the velocity vectors and the boatis crabbed across the channel.

Slower wat@

Faster wate

\/

|- 1-1-4-

Figure 49. lllustration on different ways to control the ARC-Boat in a variety of streamflow levels.
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Table 9. ARC-Boat controllertips during a variety of operation settings.

Operation

Controller Tips

Place the ARC-Boatin neutral (A)

Center the joy sticks on the radio controller.

Pulling awayfrom shore (A)

Use low throttle and move the left joy stickgently forward.
Move the rudder in the intended direction using the right joy
stick.

Operating in slow water (D)

Lower the throttle and reduce the direction of the rudder. This
allows the boat to remain steady.

Operating in fast water (B/C)

Increase the throttle to counter the increase in velocity and
move the rudder further in the desired direction until the boat
responds.

Approaching a bank (E)

Move the rudder stronglyin the current direction and use very
low throttle to make the stern come steadily towards the bank.

Making a smooth turn

Gently use the rudder and throttle controls at the same time.
The ARC-Boat was designed tobe capable of spinning on its own
axis.

Maintaining a steady pace

Set the throttle to a constant pace. This minimizes battery
consumption and overall wear on the boat.

1.7 Pre-Measurement QAQC: Collect a Temperature Measurement

1. Place thethermometerinto the waterto begin collecting a temperature measurement.

2. Enterthis value into the Measurement Wizard Rating Information Tab under “Water Temp”.

J.8 Pre-Measurement QAQC: Executean ADCP Test

This test verifies that the ADCP is functioning properly and communicating with WinRiver Il software.

1. Inthe WinRiver Il main screen, click on Acquire > Execute ADCP Test.

a. Note thatthe ADCP must be installedin the mount and submergedin non-flowing water to
obtain the best test results.

2. Aseries of six tests will be initiated that evaluate ROM, RAM, Communications, RTC, Compass,
and Temperature performance. Checkthat all tests pass onthe left pane of the dialog window.

3. After thetests have been run, sensor data will begin to be sampled and displayed in a loop.

4. Click the “Stop PC20” and “Stop PC40” buttons to end testing and close the dialog window.
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Pre-Measurement QAQC: Calibrate the Internal ADCP Compass

A calibrated compass is essential for conducting Moving Bed Tests and for using GPS data as the
navigation reference. This is a two person task, one personturns the boat slowly in the water while
another person monitors the data and communicates the test results.

1.

Ensurethatthe ADCPis secured within the ARC-Boat in the exact position it will remain
throughout the discharge measurement.

Ensure that the boat is not located near vehicles, steel bridges, or other large ferro-magnetic
masses.

a. Checkfor any materials near the boat that could disrupt the compass calibration — this
includes tools, tool boxes, cell phones, hot hands, etc.

b. Move these materials awayfrom the ADCP during calibration and throughout the discharge

measurement.
In the WinRiver Il main screen, click on Acquire > Execute Compass Calibration.
Select Use Pitch/Roll?

a. Click “No” if the ADCP will not be subject to pitch and roll (i.e. calm water). This calibration
test requires two rotations, one for calibration and one for verification.

b. Click “Yes” if the ADCP will be subject to very high pitch and roll conditions. This calibration
testrequires up to eight rotations, four for calibration and four for verification. Typically, no
pitch and roll calibrationis required.

Click the Start Calibration button and wait a moment until the compass is initialized by the
software.

Beginto slowly and smoothly rotate the ARC-Boat by hand in either direction.

a. Do not cause sudden accelerations or decelerations.

Rotate the boat until all of the red bars in the dialogue window have been replaced by a dark
green color (Figure 50).

a. The greenerthe bars, the better the data.
b. Ifabaris not dark green, rotate the boat more slowly and more smoothly.

c. Correctany non-dark greenbars when they occur by rotating the boat back 10-20° until that
bar is once again highlighted. Then, when it becomes dark green, proceed as before.

d. Clearand constant communication between the staff member moving the boat and the staff
member evaluating the test results on the laptop is critical during this period.

Once calibration rotations are complete, click OK and continue with the verification rotation.

a. If Pitch/Roll is selected there will be more initial rotations.
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9. Once the verification rotation is complete a calibration error will be calculated and presented.

a.

b.

Ensure that the calibration erroris less than 2°.
Aim for atotal error of < 1°.

If calibrationerror is < 2°, the compass calibrationis complete and the window can be
closed (< 1° is preferred — try to obtain this).

If calibrationerroris > 2°, do not accept the compass calibration.

Repeat calibration procedures.
1) Look around for magnetic materials that may be affecting the compass.

2) Move these materials awayfrom the ADCP or move the ADCP away from them, if
possible.

If, after three attempts, a calibration error of < 2° cannot be achieved, reference the
troubleshooting steps below.

1) If, following troubleshooting, a compass calibration of < 2° cannot be achieved, accept
the lowest calibration error possible and proceed.

2) Document this occurrence as a note in the Remarks Section, it will be a very important
component in evaluation the measurement during post-processing.

10. Once complete, check that the correct Magnetic Variation Correction value was entered by the

software during the measurement wizard setup (Section J.1).

Page 142



n e Cj n Title: AOS Protocol and Procedure: DSC — Stream Discharge Date: 03/16/2022
®

Operated by Battelle [ yEoN poc, #: NEON.DOC.001085 | Author: N. Harrison Revision: H

El

Compass Calibration Dialog

restruchons: rotate around unkl 21 Fed bars have been
splaced,

The gresnsr the bear the betber the dsts, [F vour bars sre
ot gresn, robate mone Siowsky.

.'.F_:IF_'..I [Rol? Headrg: |

{1 hice Pbch: [

) Yes i [
HEADTG

i 3 1 B Ja

o Il -

Thart Calbirstion

I'J:-:I:l:l":-'l.".-h:utl | == |

Figure 50. ADCP Compass Calibrationdialog box. The entirety of the horizontal bar is red uponinitiating the test.
Rotate the boat slowly and steadily so that bar is colored dark green throughout.

Troubleshooting Compass Calibration Issues

There may be too much magneticinterferencein the area you are attempting to calibrate the

compass.

o Ensurethat no magnetic materials are near the ADCP.

o Try moving the boat to a different area of the stream and repeating the calibration.

o Itmay be that material on the streambed (rebar, trash)is affecting the calibration.

Computational errors may occur during calibration. If you receive an error message indicating

thata computational error occurred, repeat the calibration and be sure to rotate the ADCP slow

and smooth.

o Ensurethatall points in the calibration display are of good quality (dark green).

o Rotating the ARC-Boat by hand in the water or removing the ADCP and rotating it on a Lazy
Susan are two ways to reduce compass error.

Communication errors may occur during calibration when using a slow communication Baud

rate.

o Ifyou receive a “Failed to get calibration data...” message verifythat all ADCP
communications are set to the 115200 Baud rate.

o Ifyou receive a “360 degrees” compass error message then the compass calibration test has
failed and needs to be performed again.

Disable GPS output (if enabled).

o This is the least preferred option and should be attemptedif all large errors are encountered
after all other solutions have been attempted.
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o Un-check the Ext. GPS box in the Measurement Window Configuration Dialog tab.
o Repeat Compass Calibrationtest.

J.10 Pre-Measurement QAQC: Perform a Moving Bed Test

Moving Bed Tests (MBT) are used to determine if the bed of the discharge cross-sectionis in motion. An
un-accounted for moving bed canlead to 5-10% bias in discharge measurements performed with the
RiverPro ADCP.

MBTs must be performed prior to each ADCP discharge bout. WinRiver |l software analyzes the data
collected during the MBT to assess the moving bed characteristics of the site and to detect common
error conditions, which may invalidate the test. The loop method is presented below as a means to test

whether a moving bed is present. The loop method must be applied properly, or it may produce
incorrect results.

Note that the accuracy of the loop method is not adequate for mean velocities less than 0.8 ft/second
(0.24 m/s). If mean velocity is below 0.8 ft/s (0.24 m/s), water velocity is low throughout the water
column and the probability that the bed is in motion is decreased. Ifthe bed is in fact in motion at these
velocities (or particles on the surface of the bed arein transit)it is likely that not accounting for it will
exert only a minimum bias in the overall discharge estimation.

A properly calibrated compass is critical to application of the loop method, the error caused by an
improperly or un-calibrated compass canbe in either direction, resulting in either more or less moving
bed than actually is present.

To perform a moving bed test:

1. Beginthe MBTfrom an initial point on the near shore where you will be able toreturn to with
precision (Figure 52).

a. Navigatethe boat to a starting location near the edge of the water on the near bank.
b. Markthis location using some physical reference for the starting point (anchored float, etc.).

2. When running the MBT it is optimal for the person using the radio controller to guide the ARC-
Boatso thatis slightly downstream of the controller.

a. This allows for easier orientation of how the controller movements affect the boat.

b. If operating the remote control from a piloted boat, it is very important to remain far
enough downstream so that the piloted boat motors and hull do not create velocity
disturbances within the measurement transect.

3. Inthe WinRiver Il main screen, click on Acquire > Start Pinging (shortcut key: F4).

4. Open the Ship Track graph. This allows for a better view of the boat path as it does not show the
velocity paths (Figure 51).
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a. View > Graphs > Ship Tracks > Ship Track.

b. The greensquareis where the float is located when the test starts.
5. Onthe Acquire menu, click Select Moving Bed Test.
6. Select “Loop Test” and click the Start button (shortcut key: F6).

7. Once you startthetest, immediately begin navigate the boat across theriver to the opposite
bankin a slow and steady manner.

a. Maintaina steadyspeed that, if possible, does not exceed the stream velocity.

b. Note thatthe greensquarein the Ship Track graph denotes your starting location.

9% Ship Track 1- TRDI EI@

Ship Track
—Ref: BT) ——{Ref: GGA) 1Ref: VIG)
4

Distance North [m]

-45.5)

i i
676
0.0 -196 209 613 M7
Distance East [m]

Figure 51. The WinRiver Il Ship Track window observed during aloop moving bedtest. The green boxindicates the
boat starting position, the line shows the boat path as itis navigating across the channel and turnedback around
toward the starting bank, and the red boxindicates the boat ending position.

8. The MBT Test must last a minimum of 180 seconds (3 minutes).

a. This duration encompasses the time spent moving the boat across the channel and back to
the near bank.

b. Itis helpful for a staff member using or nearby the laptop to call out the measurement
duration to the other staff member moving the boat sothe speed canbe adjustedif needed.

9. When the opposite bank is reached, gently turn the boat around (don’t stop) and head back to
the exact starting point where the test was initiated.

a. This is a critical part of the moving bed test, make sure this is a smooth and slow turn by
gently using the rudders and throttle together.
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Turn around
but do not stop

I
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Figure 52. lllustration of the Loop Moving Bed Test procedure.

10.

11.

Once the boat returns back to the exact starting point on the near shore where you beganthe

MBT, stop the test immediately (shortcut: F6 or Acquire > Stop Moving Bed Test).

a.

Note the green square in the Ship Track Graph indicating where the boat was located when
the test beganand the red square indicating where the boat was located when the test
ended.

If you don’t hit the F6 button right at the starting point this could falsely indicate that the
bed is moving.

Review the Ship Track window (Figure 53).

a.

If the track (red line) contains an “open mouth” (i.e. the green and red squares do not line
up and thered line is not connected) this may indicate that there is a moving bed.

If the track does not contain an “open mouth” (i.e. the greenand red squares are on top of
each other and thered line is connected), this indicates that a moving bed is likely not
present.

Moving bed conditions will always cause the ship trackto move upstream —if the ship track
moves downstream the loop testis not valid.

If the boat was not returned to the exact starting point it can result in the end point being
upstream or downstream of the starting point. This results in a potentially false positive for
moving bed conditions (endpoint is upstream of the starting point) or an invalid result
(endpoint is downstream of the starting point).
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Figure 53. Left: A moving bedis likely present as indicated by the open loop; Right: a moving bedis not likely
presentasindicated by the closed loop.

12. Document all relevant notes that apply to the MBT.

a. Toadd a note thatrelateto a specific MBT, right click on the test node (i.e. “Loop 000”) and
select “Add Note”.

13. Review the Moving Bed Test Result window to evaluate the results of the MBT (Figure 54).

a. Inthe Measurement Control window, under QA/QC, click on the Moving Bed Test node and

open the Test Resulticon for the test that was just completed (Loop tests beginas “Loop
000”).

b. The Test Result window provides metrics that describe the MBT. At the bottom of the
window reference the “NOTE” — it will indicate whether correction is recommended.

1) Ifacorrection is recommended, check the box to the left of the MBT (i.e. “Loop 000”).

This will apply a correction to the measured discharge to account for the moving bed
velocity.

a) Ifamoving bed is detected (and GPS data is valid), the Navigation Reference must
be changed from Bottom Track to GPS (Section J.11).

(1) Onthe main WinRiver Il screen select Configure > Reference and change
reference GPS (GGA)

b) If GPSis not available then Bottom Track should be used as the reference navigation
(SectionJ.11).

(1) Document this in the main measurement file remarks window.

(@) Toadd a note to the main Remarks section of the measurement file, right-
click Site Information on the Measurement Control window.

(b) Enter notes into Remarks section.
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c) Once the correction has been applied and the appropriate reference navigation has
been set, proceed with the next pre-measurement QAQC procedure.

2) Ifacorrection is not recommended and all other aspects of the MBT are valid then no
correction is needed and Bottom Track can be used as the reference navigation.

a) Proceed with the next pre-measurement QAQC procedure.

Test Result n

Resutt: Time:  18/05/02 15:56:47 Copy Close
Moving Bed Test Results Processed on: 05/02/2018

TIype: Loop Test

Filename: H:\NECN\Discharge\River_ Discharge\Post-Processing\Post-Processed Files\2018\DO3\F

Distance Made Good: 0.192 [m] i

Loop Time: 358.400 [s] = Loop time > 180 seconds
Moving Bed Velocity: 0.001 [m/s]

Moving Bed Direction: 144.767 [degrees]

Water Velocity: 0.657 [m/s]< Water Velocity > 0.24 m/s
Flow Direction: 239.021 [degrees]

Delta Flow Direction: 5.341 [degrees]

Percent Bad BT:
Estimated § Correct.:
Mean Near Bed Velocity:

.000 [percent]
.000 [percent]
.358 [m/s]

L= R}

NOTE: Moving Bed Vel. (MBV) < Minimum MBV Criteria
No Correction Recommended <= Test result: No moving bed

Figure 54. Moving Bed Loop Test Result window. In this example the required conditions were metin orderto
evaluate amoving bed (Loop time, watervelocity)and a moving be d was not detected (the moving bed velocity <
the moving bed velocity criteria), thus no correction was recommended.

14. If thereis confusion whether or not the MBT was completed correctly or questions arise
interpreting the results, consider the following common sources of errors associated with the
Loop Method.

a. Watervelocity must be >0.24 m/s in order for a moving bed to be evaluated.
1) If velocity is below this threshold a loop test cannot be evaluated by WinRiver Il.

2) At low velocities suchas theseit is likely that a moving bed is not present or is negligible
in terms of affecting measured discharge.

3) Conducting an additional loop test is not required.

4) Proceed with the pre-measurement QAQC procedures in this instance.
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b. Systematiccompasserrors.

1) Checkthedirection of the velocity vectors (blue lines) during the Loop Test in the Stick
Ship Trackwindow. They should be pointed in the same direction during both loop
paths.

2) If vectors arein opposite or in an erratic direction this is a symptom of poor compass
calibration.

3) Conducting another compass calibration followed by a second MBT may be helpful.
c. Bottom-tracking bias and uncertainty.
1) Check the Velocity Contour Profile associated withthe Loop Test.
2) Aretherelarge unmeasured areas along the streambed?
a) Ifsoa MBT may be difficult to validate.

3) Conducting another MBT along a different transect (upstream or downstream) may be
helpful.

d. Failure toreturn to theinitial starting point.
1) Ensurethatthe boat was returned tothe exact starting location at the end of the MBT.
2) Make surethatyou ended the MBT at the exact time you reachedthe starting location.

e. lIrregular orinsufficient sampling of the cross section because of loss of bottom track, non-
uniform boat speed, and loitering at the banks.

15. If any of the above criteria are in doubt:

a. Conduct another Moving Bed Loop Test in a slow, steady manner with a smooth transition
at the opposite bank.

b. It may be helpful to begin the second Loop Test from the opposite bank or from a different
transect location.

1) Besure not to gettoo far awayfrom where you will be collecting the discharge
measurement.

16. If, after the second Loop Test the results are still unclear, use the GPS as the reference method
(if available).

17. If, after the second Loop Test the results are stillunclear, and GPS is not available, conduct a
Stationary Moving Bed Test.

a. Stationary Moving Bed Tests canonly be used to determine if there is a moving bed, not
correct for one, therefore only use this if problems occur during the Loop Test and GPS data
is not available.
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b. Toconduct a Stationary Moving Bed Test:

1)
2)
3)
4)
5)
6)
7)

8)

Move the boat to the thalweg, or deepest section of the stream.

In the WinRiver Il main screen, click on Acquire > Start Pinging (F4).

On the Acquire menu, click Select Moving Bed Test.

Select “Stationary Test” and click the Start button (F6).

Hold the ADCPin that location for at least for 300 seconds (5 minutes).

Stop thetest (shortcut: F6 or Acquire > Stop Moving Bed Test).

Add any pertinent notes to the Stationary Moving Bed Test.

a) Rightclick on the test node (i.e. “Stationary 000”) and select “Add Note”.

b) Document that a moving bed was detected using a Stationary Test in the main
measurement file remarks window.

(1) To add a note to the main Remarks section of the measurement file, right-click
Site Information on the Measurement Control window.

(2) Enternotes into Remarks section.
c) Proceed with the next pre-measurement QAQC procedure.

If a moving bed is not detected proceed with the next pre-measurement QAQC
procedure.

J.11 Pre-Measurement QAQC: Configure the Reference Navigation

The reference navigation determines how the direction or bearing (heading) of the instrument s

measured. The following references are available during an ADCP discharge measurement:

e BottomTrack

o ADCPBottom-Trackvelocity (standard configuration).

o This is primary choice for the reference navigationif a moving bed was not detected.
o The ability of the ADCP to Bottom Track can become compromised during periods of high
turbidity and suspended sediment concentrations (SSC). An overload of scaterrersare

produced in these conditions which prevent the ADCP beams from reaching the bottom and
measuring velocity throughout the channel profile. If turbidity is high and the ADCPis having
difficultly bottom tracking (this is evidenced by a large bands of missing ensembles in the

velocity contour profile and warnings in the Measurement Control Window), consider using
GPS as the reference navigation.
e GPS(GGA)
o Differential GPS position from NMEA GGA string (WinRiver Il will differentiate position to

calculate velocity).
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If amoving bed is detected and/or during periods of high turbidity and suspended sediment
concentration, this is the primary choice for GPS reference as GGA data contains more
information thanVTG.

o GGAmessages canbe affected by multipath errors caused by large trees or structures

nearby the measurement site.
e GPS(VTG)

o GPSvelocity from NMEA 0183 VTG string.

o Ifamoving bed is detected, and/or during periods of high turbidity and suspended sediment
concentration, this is the secondary choice for GPS reference as VTG data serves as a backup
for GGA.

o VTG messages are not affected by multipath errors but VTG GPS data is oftentimes less

accurate than GGA, particularly when moving at lower speeds.

If a moving bed was not detected during pre-measurement QAQC procedures (Section J.10) and

turbidity/SSC levels are low, it is always preferred to use Bottom Track as the reference navigation. This
allows for the boat movement and water movement to both be referencedto the instrument. Note that
GPS data should stillbe configured and collected even if it is not used as the reference navigation.

If amoving bed was detected and/or turbidity/SSC levels are high enough to adversely affect bottom
tracking, GPS reference is preferred. GPS data can also be used as a good quality indicator of the Bottom

Trackdata as well.

To change the reference navigation:

1. Inthe WinRiver Il main screen, click on Configure > Reference.

a.

b.

If amoving bed is not present, ensure that “Bottom Track” is selected from the list.

When bottom trackis used as the velocity reference, the speed of the ADCP over ground is
subtracted from the measured relative velocity to give true Earth referenced water velocity.

If, following a moving bed test, a moving bed is present and GPS can be utilized, choose GPS
(GGA\) as the reference navigation.

If GPS does not have enough satellites toacquire a strong signal, Bottom Track should be
used as the reference navigation.

1) The number of available GPS satellites is shown by selecting View > Tabular > GPS
(Figure 45).

2) The absolute minimum number of satellites neededto provide a position is 3.

3) Position will not be as accurate until at least 4 satellites are available due to timing
limitations of GPS receivers.

4) The greater the number of satellites, the greater the positionaccuracy, 7+is preferred.
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e. GPSlatency canbe detected using the Ship Trackwindows (View > Graphs > Ship Tracks)

(Figure 55).

1) Comparethe red lines (Bottom Track) vs the blue and green lines (GPS).
2) Separation between GPS and Bottom Track may denote:

a) GPSlatency.
b) Thatan offset is required to the External Heading.

(1) See Section 1.3 for details on applying External Heading offsets.
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Figure 55. Above: Ship Track graphs to evaluate Bottom Track vs GPS data. Above: Trackand GPS data are in good
agreement, indicating proper compass calibration, an accurate Magnetic Variation value, and low GPS latency;

Below: Bottom Track and GPS data are in pooragreement, indicating poor compass calibration, an inaccurate
Magnetic Variation value, and/or high GPS latency.

J.12 Conduct Discharge Measurements with the ADCP and ARC-Boat

WinRiver |l software calculates discharge using real-time velocity measurements acquired during
transects across the stream. Perform the following steps in order to successfully collect a high-quality

stream discharge measurement using the remote controlled boat method at river sites. Eachstepis
presentedin greater detail throughout this section.

1. Start ADCPpinging.

2. Establishtransect start and end points.
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3. Enterstaffgauge height prior to each transect measurement.
4. Measuredischarge across the channel (minimum 4 transects).
5. Evaluate whether additional transects are required.

6. Save transect locations (optional).

1. Start ADCP Pinging

Setting the ADCP to start pinging enables ADCP and GPS data collection. In general, after you have
started the ADCP pinging, there is no reasonto stop pinging until you are finished the entire discharge
survey and ready to remove the ADCP from the water. An exception would be if you were operating
with batteries of limited capacity, under that circumstance stopping ADCP pinging will conserve power.

1. Ensurethatthe ARC-Boatisin the waterand the ADCP and GPS antenna are powered on.
2. PressFA4to startthe ADCP pinging (or Acquire > Start Pinging).

3. Inafew seconds, ensembles will begin tobe generated and changing values will appear within
several of the WinRiver Il data windows.

a. Anensemble is the data output generated by multiple ADCP pings that are averaged
together. Ensembles are trackedin numerical order, timestamp, and position.

b. Ifthe ADCPis positioned in sufficient depth, velocity profiles will become available.
c. Note that WinRiver Il will not display meaningful data unless the Arc-Boatis in the water.

4. If enabled, GPS positions will be displayed at the bottom of the Composite Tabular display
window and valid GGA positions are being received from the GPS system. External Heading data
will be displayed if that functionality is enabled.

5. The ADCP can continue pinging when it is not in the water.

2. Establish Transect Start and End Points

The locations at eachside of the channel where the discharge measurement begins and ends must be
established before recording discharge transect data. Because stream depths eventually become too
shallow for valid data collection as the ADCP approaches a bank, it is necessaryto estimate dischargein
the near-shore unmeasured zones using the WinRiver Il and Q-Rev software. To ensure the accuracy of
near-shore discharge estimates, the distances from the edge of water to the starting and stopping
points of eachtransect must be measured using a distance-measurement device (suchas a laser or
optical rangefinder), tagline, or some other accurate measurement device.

Placing anchored marker buoys at the start and end points of transects is advantageous for keeping
consistent edges and ensuring that the same cross-section profile is measured during eachtransect. If
placing marker buoys in the channel is not possible tryto remember these locations using some physical
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reference. Ifit is not possible to reach the opposite side of the river to measure the edge distance, the

“Distance MG [Made Good]” values displayed on the right side of the Composite Tabular 1 window can
be used to calculate the edge distance from transect end point to the edge of water on the opposite
bank Be careful not to accidently beachthe ARC-Boat by getting tooclose to the opposite bank.

Other notes on transect start and end points:

Measurement uncertaintyincreases as the distance increases between the start and end points
and the edges of water due toless measurements and more interpolation.

Try to ensure that the velocity profile at the start and end locations are representative of the
velocity profiles leading up to the bank in order to limit interpolation bias.

In channels that contain vertical walls at the edges, start and end points for transects should be

no closer to the wall thanthe depth of water at the wallto prevent acousticinterference from

the main beam or side lobes impinging on the wall.

o For example, if the depth at a vertical wall is 10 feet, transects should start or stop at least
10 feet away from the wall.

If the cross-section has been measured previously at the same location, WinRiver |l “Locations”

can be utilized to help determine the start and end points that were previously used and to help

navigate the float across the channel.

o See Section J.12 Step 6 for instructions on loading available locations and how to save new
ones.

To establishtransect start and end points:

1.

Navigate the boat just off the edge of water on the near shore and into open water until the
ADCP transducers are submerged.

Note the number of “Good Bins” listed in the Composite Tabular window shown in the right
panel of the main WinRiver Il screen (Figure 56).

a. Two “Good Bins” (or depth cells) are required in order to start and end the transect
measurement.

Navigate the boat slowly away from the bank until the tabular display indicates you are at a
sufficient depth to set the transect start point (>2 Good Bins, closest to 2 is preferred).

If possible, mark this location with a marker buoy or weighted float. Otherwise try to remember
this position by using some physical reference.

Navigate the boat slowly towards the opposite shore.
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a. Travelsmoothly and slowly with the bow of the boat pointed upstream (note this may be

difficult during periods of low flow, see Section J.6 for boat operation tips).

6. While moving across the channel observe the Velocity Contour graphto view channel conditions

and ensure that the ADCPis working as expected with the loaded configuration.

a. Observe the Velocity Contour Profile located on the bottom panel of the WinRiver |l main
screen (Figure 57). This display illustrates water velocity and depth across the channel.

1) The very top and the very bottom of the channel will always be unmeasured by the
ADCP and discharge in these locations will be interpolated. The top unmeasured areais

a function of transducer depth, or how low the ADCPis in the water column.

2) Vertical white bands within the profile are unmeasured areas that canoccur for a
variety of reasons including biota, woody debris, physical structures, or simply moving

the float too fast or abruptly across the channel.

a) Work to limit the number of white bands in the profile as anincreasein
unmeasured area results in an increase in measurement uncertainty.

b) If the unmeasured area within the cross-sectionis significant a different discharge

transect upstreamor downstream may be necessa ry.

3) Note regions where the channel depth changes abruptly.

a) Make a mental note to move more slowly across these regions during data

acquisition to help bottom tracking maintain a valid lock on the bottom.

7. Asthe boat approaches the opposite shore note the Number of Good Bins in the Composite
Tabular window (Figure 56) and stop the boat at the opposite edge of water where two good

bins are available.

8. |If possible, mark this location with a marker buoy or weighted float.

9. Proceed to the nextstep once transect start and end points are established at eachside of the

channel.
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0 0% 0.64
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8.27° 4.84° 159.78°
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Discharge (Ref: BT) Left to Right
[Good Bins 13 ]
TopQ 0.000 [ms)
Measured Q 0.003 [m#s]
Bottom Q 0.001 [m¥/s]
Left @ -0.000 [m?¥s]
Right Q 0.000 [m¥s]
Im*/s]
MBT Corrected Q [m*s]
Navigation (Ref: BT)
Boat Speed 0.020 | [m/s]
Boat Course 21947 1
ater Speed 0.316 [m/s]
Water Dir. 187.60 I
Calc. Depth 2.303 [m]
Length 0.01 [m]
Pistance MG 001 | [m]
Course MG 219.47 1
uration 064 | [s]
GeoRef Latitude 317 10.989400° N
GeoRef Longitude 84° 26.297900° W
Latitude
Longitude

Figure 56. Composite Tabularwindow in WinRiver Il, green box: number of ensembles (hold until 10 attransect

start/end points); red box: Number of Good Bins (mustbe >2 to begintransect); purple box: total discharge; blue
boxes: water andboat speed; orange box: distance made good (total transect length); brown box: duration (total
transectdurationmust be 2180seconds).
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Figure 57.Unmeasured areas in the ADCP profile where velocity is extrapolated. Top left: ADCP blanking distance
and cell size distribution (credit: SonTek); top right: unmeasured areas of the profile relative to ADCPbeams
(credit: SonTek); below: the WinRiver |l velocity contour with unmeasuredareas delineated.
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3. Enter Staff Gauge Height Prior to Measuring Discharge at Each Transect

The staff gauge height must be entered prior to each transect measurement using the Fulcrum app. The

mean gauge height recorded prior to all transect measurements is the stage value associated with the
mean discharge measured during all transect measurements. Notes regarding conditions observed

during individual transects (high/low flows, changing gauge heights, wind conditions, the passage of
other vessels during measurement, any noteworthy events, etc.) can be enteredin the main Remarks

section of the Measurement Wizard as well as in the individual transect notes.

Gauge height observation and recording must immediately precede the transect discharge sothe stage
level during the discharge measurement is accurately characterized.

To enter the staffgauge height prior to each transect measurement:

10.
11.
12.
13.

14.

Open the (AOS) Field Metadata and Gauge Height [PROD] app in Fulcrum.
Enter the appropriate information in the Metadata, Spatialand Temporal Information tables.
In the Stage Height table, enter the current staff gauge height in the “Initial Stage Height (m)”
field.

a. Note that this does not necessary have to equal the staff gauge height prior to the first

measurement transect.

Under the Stage Height table note the “Collecting Discharge withan ADCP Today?” field and
select “Yes”.
Click the “ADCP Transect Stage Measurements” button that appears.
Click the red plus (+) button at the top right of the window to create a record.
Enter the time the staffgauge is measuredin the Staff Gauge Height Reading Time field.

a. This must be done immediately preceding the discharge measurement.
Enter the Staff Gauge Asset Tag.

a. This islocated on the top of the staff gauge you are reading.
Enter the Transect Number.

a. This must correspond to the transect number generatedin WinRiver II.

b. By default, transect numbers begin at 000 and increase to 001, 002, 003, etc.
Enter the Staff Gauge Height.
Enter the Staff Gauge Height units.
Click the green check button in the top right corner of the window to save the record.
Additional ADCP Transect Stage Measurements can be added by clicking the red plus button at
the top right of the window.
ADCP transect stage measurements can be deleted by clicking the black X button to the left of
each record.

a. Records should be deleted if:

i. Errorsarepresentin any of the fields.
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ii. The measurementtransectis notto be used in the calculation of total discharge
(the transect will remain unchecked in WinRiver Il due to measurement error,
the transect was started by mistake, etc.).

15. The ADCP Transect Stage Measurements window should remain open throughout the discharge

survey so that staff gauge height can be measured prior to each transect measurement.
16. The window can be closed by clicking the green check mark at the top right of the window once
all transect discharge measurementsare complete.

17. Enter Weather Information, Post Fieldwork Observations, and General Comments information
to the record as needed.
18. Click the green check mark at the top right of the window to save the record.

19. Fulcrum data will load automatically when the recordis saved and the device receives a wireless

internet signal.

4. Measure Discharge Across the Channel (Minimum 4 Transects)

A “transect” is considered a single discharge measurement that begins at the transect start/end point on
one side of the channel and ends at the transect start/end point on the opposite side of the channel.

Each ADCP discharge survey must contain a reciprocal number of transects (i.e. ifa transect is measured
from the near bank to the opposite bank, another transect measurement must be included from the
opposite bank to the near bank). A minimum of four transects are required for each ADCP discharge

survey but more may be necessary. Eachtransect must last a minimum of 180 seconds and the total
time for all transects must be >720 seconds.

Complete the following steps to measure discharge during each transect:

1. Hold the position of the boat steady at one of the markedtransect start or end points.

2. Usinga stadiarod, metertape, or laser range finder, determine the distance from the transect

start point to the edge of water. This is referred to as the “edge distance”.

a.

b.

Measure the area from the center of the ADCPto the edge of the water.

If using a rangefinder make sure that the laseris not hitting leaves or branches hanging over
the channel. Take a few shots and make sure they are all the same.

If it is not possible to measure this distance with an instrument, use the “Distance MG
[Made Good]” values displayed on the right side of the Composite Tabular 1 window to
calculate the edge distance from beginning/end of the transect tothe adjacent edge of
water. Be careful not to accidently beach the ARC-Boat by getting tooclose to the opposite
bank.

If you start fromthe same location for each transect, this distance does not need to be
measured each time (it is recommended to mark the transect start point for this reason).

3. Click Acquire > Start Transect (shortcut: F5) to begin data recording.
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a. Note that the measurement has now been initiated.
4. When prompted, enter the edge distance (measuredin Step 2).
5. Define whether you started the measurement from the left or right bank.
a. When facing downstream, the left bank is on your left side.
6. Hold the position of the boat at the transect start point for at least 10 shore ensembles.
a. This is equivalent to about 10 seconds.
b. The number of ensembles can be viewed in the Composite Tabular window (Figure 56).

7. Once 10 ensembles are recorded at the transect start point slowly and steadily navigate the
boat towardthe opposite bank.

8. Move the boat slowly and steadily across the channel.

a. The totalduration of eachtransect (moving the boat from one side of the channel to the
other) must be > 180 seconds.

b. The cumulative time spent measuring eachtransect is directly correlated to measurement
quality.

1) The slowerand steadier the float crosses the channel the higher the data quality.
¢. Maintainan average boat speedthatis less than or equal to the water velocity.
1) Watervs. Boat speed can be monitored using the Water Speed vs Boat Speed graph.
a) Click View > Graphs >Time Series > Water/Boat Speed (Figure 58).

2) When water velocity is very slow, keeping the boat speed below the water velocity may
not be a possible (or practical) approach. Under these conditions the smoothness of
boat operation becomes critical.

3) Avoid fast and sudden accelerations.
d. Attemptto point the bow of the ARC-Boat upriver and crab across the channel.

1) Ifthisis not possible due to low surface water velocities, point the bow of the boat
towardthe opposite shore and slowly move towards it.

e. Observe data displayed on other graphs as needed to monitor data quality.
1) Click View > Graphs/Tabularto explore other graphical and tabular interfaces.

a) Graph display settings can be configured by right clicking on the graphand selecting
“Properties”.

9. Continue across the channel until you reachthe transect end point on the opposite shore.

Page 159



n c) n Title: AOS Protocol and Procedure: DSC — Stream Discharge Date: 03/16/2022
e ®

Operated by Battelle [ yEoN poc, #: NEON.DOC.001085 | Author: N. Harrison Revision: H

10.

11.

12.

13.

14.

15.

16.

Ensure that two good bins are available at this location using the Composite Tabular window
(Figure 56).

Hold the boat steadyat this location and wait until at least 10 shore ensembles have been
collected.

a. This is equivalent to about 10 seconds.
b. The number of ensembles can be viewed in the Composite Tabular window (Figure 56).

Using a stadia rod, metertape, or laser range finder, determine the distance from the transect
end point to the edge of water. This is referred to as the “edge distance”.

a. Measuretheareafrom the center of the ADCPto the edge of the water.

b. Ifusinga rangefinder make sure thatthe laseris not hitting leaves or branches hanging over
the channel. Take a few shots and make sure they are all the same.

c. Ifitis not possible to measure this distance with an instrument, use the “Distance MG
[Made Good]” values displayed on the right side of the Composite Tabular 1 window to
calculate the edge distance from beginning/end of the transect tothe adjacent edge of
water. Be careful not to accidently beach the ARC-Boat by getting too close to the opposite
bank.

d. Ifyou end from the same location for each transect, this distance does not need to be
measured each time (it is recommended to mark the transect end point for this reason).

Click Acquire > Stop Transect (shortcut: F5) to stop data recording.

a. Note thatthe measurement has now ended.

When prompted, enter the edge distance (measuredin Step 12).
Define whether you ended the measurement at the left or right bank.
a. When facing downstream, the left bank is on your left side.

To add notes that document important information relating to each transect right click on the
transect node in the Measurement Control window (upper left pane in the WinRiver [l main
scree)and select “Add Note”.

a. Notes that describe individual transect measurements help explain the data that was
collected and are thus extremely beneficial to post-processing/data QAQC. Always provide
clear, descriptive documentation regarding the discharge measurement. Examples of
individual transect notes include:

1) “Abarge wentthrough prior to/following the transect measurement”.

2) “The wind picked up considerably during the transect measurement”.
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3)
during the transect measurement due to...”.

4)

due to...”.
5) “Riverstage appearedto rise/fall during this transect”.
6) “Highsediment concentrationwas present during this transect”.

17. The transect measurement is now complete.

“It was difficult to maintaina boat velocity less than the mean velocity of the river

“Poor bottom tracking/GPS tracking occurred during this transect due this measurement

18. To view the data you collected during the transect openthe node (+) under the Transect name

in the Measurement Control window and double-click the disc button.
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Figure 58. Water Speed vs. Boat Speed graph. Above: Impropertechnique. The boat speed (purpleline) is erratic
and higher than the water velocity (red line). Below: Proper technique. Maintain an evenboat speed so that the
purple and red lines are more in line and boat speed remains generally lower than water speed.

Collect (At Least) Three Additional Transect Discharge Measurements (Minimum of Four Total)

Repeat the previous steps, navigating the boat across the channel from eachtransect startandend
point until a total of four transects have been measured (two in each direction). A minimum of four
transects (each lasting a minimum of 180 seconds) must be collected during each discharge
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measurement, two in each direction. The measured discharge is the average of the discharge collected
during each transect.

Enter the staff gauge height prior to eachtransect measurementinthe Fulcrum app. Record all other
notes in the individual transect notes and/or the Remarks window of the Site Wizard (typically notes
that affect all transects canbe enteredin the Site Wizard notes and notes that affect individual transects
areto be entered in the individual transect notes).

A new data file and Transect node will be createdin the Measurement Control window eachtime you
start and stop recording during eachtransect (ex: Transect 0000, Transect 001, Transect 002, Transect
003). Once the fourth transect is complete stop data collection and evaluate whether additional
transects are needed.

5. Evaluate Whether Additional Transects Are Required

More than four transects must be measuredif:

1. Totalduration of all transects does not exceed 720 seconds.

2. The discharge measured during at least one transect is greater than 5% of the average discharge
of all transect measured.

3. Anobserved gauge height change is associated with a notable change in discharge for a given

transect.

Evaluate the total duration of all transects:

1. Inthe Measurement Control window (top left panel in the WinRiver |l main screen) ensure that
each transect measurement you wish to evaluate is checked.

a. Uncheck any Transects were measuredthat contained errors and are not meant to be
included in the evaluation.

b. A minimum of four reciprocal transects (that do not contain errors) must be checked.

2. Inthe WinRiver Il main screen, hitthe F12 button to bring up a summarytable that provides
information on each transect measured.

3. Scroll over to the fifth to last column, “Duration”.

4. Ensurethateach transect durationis = 180 seconds and the sum of all transect durationis > 720
seconds.

5. Ifindividual and total transect duration requirements are met, proceed to the next evaluation
step.

6. If anindividual transectis < 180 seconds or the sum of all transect durations is < 720 seconds,
collect two additional transect measurements (reciprocal pairs of transects must always be
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measured, one that begins from each side of the channel) and re-evaluate the summary

window.

1.

In the Measurement Control window (top left panel in the WinRiver |l main screen) ensure that

each transect measurement you wish to evaluate is checked.

a.

Uncheck any Transects were measured that contained errors and are not meant to be

included in the evaluation.

b. A minimum of four reciprocal transects (that do not contain errors) must be checked.

In the WinRiver Il main screen, hit the F12 button to bring up a summarytable that provides

information on each transect measured (Figure 59).

Note the value listedin the fifth column, “Total Q”, for each transect row.
a.
Note the value listedin the “Average” row of the “Total Q” column.
a.
Note the value listedin the sixth column, “Delta Q”, for each transect row.

a.

This is the total discharge measured during each transect.

This is the average discharge of all transects measured.

This is the percent difference of total discharge measured during each transect relative to

the average discharge across all transects.

If the Delta Q value for each transect is < 5%, discharge requirements are met and no additional
discharge transects are necessary.

a.

Proceed to the next evaluation step.

If the Delta Q value for any individual transect is >5%:

a.

Collect two additional transect measurements (one from each side of the channel) and re-

evaluate the summarywindow (reciprocal pairs of transects must always be measured, one
that begins from each side of the channel).

1)

2)

3)

Note that under changing hydrologic conditions (stageis rising or falling) Delta Q

requirements may be difficult to meet.

If river stage was fluctuating dramatically throughout the transect measurements,

proceed to the next evaluation step.

As total measured discharge values decrease during the low flow regime, achieving < 5%

Delta Q values becomes increasingly difficult.

a) The instrumentationapproaches the lower limits of its measurement ability at low
stages andthereis anoverall increase in uncertainty when measuring low-flow
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discharge (environmental factors such as bed and bank geometry exert a larger
influence on velocity paths and can adversely affect measurement ability).

b) A high level of precision is required to obtain repeatable discharge values per
transect.

c) Asmore measurements are collected a given site over time, Science and Field
Science staff can work together to develop applicable Delta Q thresholds based on
stage levels.

b. If Delta Qvalues still exceed 5% for a given transect collect two additional transect
measurements (reciprocal pairs of transects must always be measured, one that begins
from each side of the channel), and re-evaluate the summary window.

c. If aftercollecting a total of 10 transects, Delta Qvalues still exceed 5% for a given transect,
proceed to the next evaluation step.

1) Submit atrouble ticketto Science upon return to the office.

d. Keep in mind that the more transects that are measuredincreases the probability that the
true meandischarge will be measured but it alsoincreases the probability that an outlier
measurement will be collected.

3¢ Discharge Summary - TRDI [r=l-E- =]

Transect Start Bank #Ens. Start Time Total @ Delta Q@ TopQ Meas. Q Bottom Q Left @ Left Dist. Right Q
mis % m¥s méis m¥s méis m més

01000 Right 417 19:27:56 1151.505 192 67.125 957.347 120.280 2978 9.00 3775
01001 Left 487 19:33:48 121.736 0.7 64.965 933.882 114.248 2.344 9.00 6.297
01002 Right 469 19:45:47 1123.982 £0.51 65.115 932.999 116.472 3.878 11.60 5.518
01003 Left 398 19:52:15 121.822 £0.70 65.398 934.828 114.624 2.516 11.60 4.457
Average 442 1129.761 0.00 65.651 939.764 116.406 2.929 10.30 5.012
Std Dev. 42 14.533 129 0.999 11.746 2.760 0.687 1.50 117
Std.J| Avg.| (%) 9.50 1.29 0.00 1.52 1.25 2.37 23.46 14.57 22.29

Figure 59. Discharge summary window in WinRiver Il. The red box highlights Delta Q values. In this exampleall are
< 5%, an indication that no additional transect measurements are required.

Evaluate changes in transect discharge relative to changes in gauge height

Gauge height must be observed and recorded in the app prior to eachtransect measurementinorder to
calculate mean stage and assess unsteady flow conditions. Unsteady flow conditions occur during
periods of rising or falling stage which may occur during or immediately following heavy rain events,
upstream dam or lock flow regulation, tidal effects, downstream backwater effects, or flood waves.
Always document unsteady flow conditions in the main Remarks section and/or in individual transect
notes.

If changes in gauge height are associated with a notable changein discharge for a given transect (i.e. >
~3% of the mean):

1. Attemptto collect a pair of reciprocaltransects that correspond with a given gauge height.

Page 164



) Title: AOS Protocol and Procedure: DSC — Stream Discharge Date: 03/16/2022
lneen

3.
6.

Operated by Battelle [ yEoN poc, #: NEON.DOC.001085 | Author: N. Harrison Revision: H

If stageis changing too rapidly and this is not possible, save transect locationfiles (if needed)
and proceed to Section J.13.

Submit a trouble ticket to Science upon return to the office.

Create Transect LocationFiles (Optional)

Location files use GPS data to save the location of transect start and end points sothat they can be

utilized during subsequent discharge surveys. This feature cannot be utilized if GPS data was not

integratedinto the measurement. Once a transect has been measured it appears in the WinRiver Il

Measurement Control window, and the location can be saved. Multiple transect locations can be saved

using unique files names (i.e. if discharge was measured 5 meters upstream during a particular survey).

To create a Transect Location file:

Complete a discharge measurement at a given transect.

Identify the transect locationto be savedin the WinRiver || Measurement Control window.
a. The discharge measurement associated withthe transect must contain GPS data.
Rick-click on the transect node and select “Define Transect Location” (Figure 60).

The Edit Locations window will appear.

a. Click onthe maptozoom.

Enter a Location Name and any relevant notes about the transect.

Click the Save & Close button.

a. You must click the “Save & Close” button to create the location file.

b. Selecting Cancelor closing the Edit Locations window will not create the location file.
Click Save on the Save Location screen.

a. The *.datlocation file will be savedto the C:\Measurements\Locations folder by default,
this location canalso be edited.
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Figure 60. Defining transect locations in WinRiver II.

J.13 Evaluating the Discharge Measurement in the Field

Following the completion of the discharge survey, the following data review steps must be completed:

1. Review, finalize, and save data in WinRiver II.
2. Check measureddischarge value against the stage-discharge rating equation (if available).
3. Reviewdata in Q-Rev.

Data review must be conducted while still on site so that the discharge survey can be repeated if
necessary.

Review, Finalize, and Save Data in WinRiver IlI:

1. Playback each measuredtransect and check parameters.
a. Open the node (+) under eachtransect.

b. Rightclick on the Transect number and select “Re-process Transect”.The transect data will
appearin all graphs that are currently on display.

c. Rightclick on Playback Configuration and select “Properties”.

1) Inthe Edge Estimates page onthe right, verify that the Begin Transect and End Transect
information was entered correctly.

2) Inthe Offsets page check thatthe ADCPtransducer depth was entered correctly (this
depth should not have changed during the discharge survey).

3) Inthe Discharge page choose the correct Left Bankand Right Bank Edge Type.

a) A custom coefficient value canbe enteredif a given bank does not conform to
triangular or square shape.
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b) Consult Science with any questions regarding bank coefficients. These values are
very important in estimating edge discharge.

4) Once any value has been enteredin the Playback Configuration> Properties window,
you can right click on the box and select “Apply to All Active Checked Transects” if you
wish to apply this value to all selected transects.

a) This will apply the setting to all transects inthe measurement that are checked.
b) Eachtransect will need to be re-processed for this change to be applied.

d. Enterall applicable notes in the general Remarks sectionand in individual transect notes, as
necessary.

2. Following the WinRiver Il review save the measurement file on the laptop and a USB dongle for
backup.

a. An.MMT file will be createdalong with .PDOfiles that are unique to individual transects.
Each of these files must be contained in a folder on the laptop and backed up onto a USB
dongle.

Check the measured discharge value against the stage-discharge rating equation, if available:

Once a stage-dischargerating curve has been developed and validated for a site, a rating equation is
derived that predicts discharge given stream stage (supplementary information on rating curves is
available in (AppendixD). Once established, rating equations will be provided to field staff by Science.
Rating equations are commonly expressed as power relationships:

Q=C/(G- a)B
Where:

Q= discharge;

G = the stage, or gauge height;

o = the gauge reading corresponding to zero discharge; and
C.and B = rating curve constants

Following the discharge measurement:

3. Enterthe streamstage (G)into the rating equation that is associated with the site.

4. Calculate predicted discharge.

5. Evaluate whether the measureddischargeis +10% of the discharge predicted by the equation.
a. Ifthe measureddischargeis <+10% than predicted discharge:

1) Another discharge surveyis not required.
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b. Ifthe measureddischargeis >+10% than predicted discharge (and the stream stage did not
change during the site visit):

1) Conduct another discharge survey immediately.

2) If, aftera second attempt, the measured discharge remains >+10% the predicted rating
discharge:

a) Checkthesecond discharge measurement file for errors using steps provided in
previous sections.

b) Save both discharge measurements.
c) Submit atrouble ticket to Science.

(1) This mayindicate a shift in the rating, which, if validated by additional
measurements, would warrant anincrease in the frequency of discharge
measurements at the site.

Review, Finalize, and Save Datain Q-Rev:

QRev software (USGS) serves a final means to QAQC ADCP discharge data. The following procedures

must be done in the field prior to leaving the site.

1.
2.

Open Q-Rev.
Open the .mmt file (the file that was just savedin WinRiver Il)in Q-Rev.
a. Inthe main Q-Rev window: Select Data > TRDI > select the WinRiver Il .mmt file.

b. Note thatthe location where the .mmt file is stored must also contain all of the .PDOfiles
that correspond with the measurement.

Note the color of the buttons on the left side of the main window. These colors indicate data
quality for specific measurement parameters.

a. Green: Good, no investigation required.

b. Yellow: Problems could be presentedand may be able to be corrected, investigationis
required.

c. Red:Problems are present that are negatively affecting measurement data, investigationis
required.

Select the “Options” button (this button will never be colored).

a. Ensurethat “Units” are settoSl.

b. Click OK.

In the main window, select the “Moving Bed Test” button (regardless of color).

a. Uncheck any tests that are not valid in the “User Valid” column.
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C.

1) Note the “Quality” rating, and the text contained in the Messages window.

If any tests contain “Moving Bed” = “Yes” consider checking “Use for Correction” if the tests
were valid.

Note this will change the measured discharge value.

6. Evaluate the remaining buttons if they are not green:

a.

e.

ADCP/Site Info

1) Herethe Station Name and Number can be edited, but this is not required.
System Test

1) Provides the results of the ADCP system test.

Compass/P/R

1) Provides heading, pitch and roll, and magnetic variation data for eachtransect.

a) If the pitch and roll time series data are too high and the extended compass
calibration was not performed, Q-Rev will apply a flag.

2) This button will be yellow if Compass Calibration Erroris > 1 degree.

3) Hereyou can change the magnetic variation for some or all transects by clicking on the
Magnetic Variation value within the Heading, Pitch, & Roll table.

4) You can view the Compass Calibration data by clicking the “View” button under
Compass Cal/Error on the right side of the screen.

Temp/Salinity

1) Hereyou can evaluate the ADCP thermistor which controls temperature, salinity, and
speed of sound data.

a) Fluctuations in the time series data mayindicate (1) the ADCP was not allowed to
fully equilibrate to the water temperature prior to measurement, or (2) actual
temperature variations presentin the channel.

2) Checkthe Average Temperaturevs. the User Temperature (entered at the start of the
ADCP measurement).

3) The temperature source canbe changedfrom internal (ADCP)to User for one or all
transects by clicking on the Temperature Source value in the Speed of Sound Settings
table.

a) Note this will change speed of sound and discharge values.

BT Filters
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1)

2)

3)

If GPS data was used as the reference navigation this button never needs to be
evaluated. Referencethe GPS Filters button instead.

Here you can evaluate time series velocity data, velocity errors, and how the data can be
adjusted using different filter and interpolation settings.

Consult with Science if you feel that BT Filters require adjustment.

f. GPSFilters

1)

2)

3)

4)

If Bottom Track was used as the reference navigation this button never needs to be
evaluated. Referencethe BT Filters instead.

Here you can evaluate time series velocity data, velocity errors, and how the data can be
adjusted using different filter and interpolation settings.

The ATL-g Plot to Google Earth plots the transects for the discharge measurement tothe
Google Earth App. This will only work if the Google Earth App is installed on the
computer that QRev is running on.

Consult with Science if you feel that GPS Filters require adjustment.

g. Selected Reference

1)

2)

3)

4)

5)

6)

7)

The Selected Reference button will be grayed out and this window will not be accessible
if there is no GPS data in the file loaded to QRev.

The summarytable provides details on the navigation data available, and describes
changes in calculated discharge based on filter changes in QRev.

The Reference Used panel displays the navigation reference currently being used for the
transect selectedinthe summarytable.

The boat speedtime series shows the boat speed for each of the navigation reference
data types in the same graph per transect.

The ship tracktime series shows the ship track for each of the navigationreference data
types in the same graph per transect.

In the Selected Reference panel, the reference navigation data type used for computing
discharge canbe changed. Refer back to the summary table to see how a change affects
the calculated discharge.

The Composite Tracks feature can automatically substitute one of the other valid
navigation references for the selected navigation reference, if the selected navigation
reference is invalid.

a) Composite tracks default to off.

h. DepthFilters/Draft
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1) Heredatafrom eachbeam can be reviewed and the combined cross-sectional value.

2) QRev defaults to using inverse depth weighting to compute the mean depth when the 4
slant beams are used.

3) The filter type canbe changedto eliminate erroneous spikes. Note this will change the
discharge value.

i. WT Filters
1) Hererawand processed water trackdata can be reviewed and adjusted.
2) Note thatthe errorand vertical velocity filters do not always perform well on data from

ADCPs with auto adaptive modes (the RiverPro being one such model) due to the
changein error velocity distribution for the different modes.

a) If this button is yellow or red try turning error and vertical velocity filters off. Note
the changein totaldischarge.

j-  Extrapolation

1) Default edge extrapolationsettings are determined automatically from algorithms

created for the Extrap program.

2) The data panel displays average normalized depths for segments of the channel, with

each segment equatingto5 percent of the total discharge.

3) The Profile Panel is the primary panel in this window.

a) GrayDots represent raw data, normalized discharge or velocity (depending on
which is selected) in each depth cell for all transects selected inthe Fit panel.

b) Greencircles represent the top cell for each ensembile, the cell at the water’s

surface.

c) The Red/BlackSquares are median points for the raw data in each segment. They
are color coded:

(1) Red:contains less values in the segment than the threshold requires, and is not
used in the computation of extrapolation.

(2) Black: Median values of the composite of all the transects inthe measurements.

d) The horizontal Red/Blacklines (Whiskers)on either side of each median value
extend to the 25thand 75th percentile of all the datain that segment (i.e. 50% of
the raw data will fall inside the whiskers).

e) The centerline, going through the median squares is the extrapolation line, which is
alsocolor coded:
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(1) Magenta: transects collected while crossing the channel from left bank to right
bank (facing upstream).

(2) Blue:transects collected while crossing the channel from right bank to left bank
(facing upstream).

(3) Black:is a composite of all the transects.
f) The fit panel allows a separate fit edge for each transect.

(1) Leave “Fit” setto “Automatic” for default algorithms to be used (recommended
default setting).

(2) Change “Fit” to “Manual” to change the extrapolation method at the Top and
Bottom of the graphto different fit options — Power, Constant, or 3-Point (Top)
or Power or No-Slip (Bottom).

(@) Set the Exponent value incrementally for Power or No-Slip extrapolations.
The graph will update as the exponent is changed.

(3) Note thatdischarge values will change as extrapolation fits are adjusted.
k. Edges

1) This window displays the edge settings for computing the left and right edge discharges
and displays graphs for evaluation.

2) The Edges button will be yellow if any of the extrapolated edge discharge contributes
>5% of the total measured discharge for the transect.

a) Uncertaintyin the total estimated discharge increases with increased contribution
of edge discharge to the total estimate.

b) Check the “Left Distance (m)” and “Right Distance (m)” values to ensure the left and
right edge distances were entered correctly.

(1) Thesevalues are directly correlatedto the percentage of total discharge
contributed by the edges.

(2) To edit an edge distance click on the “Left/Right Distance (m)” value you wish to
edit. The new value canbe applied to a singular transect or all transects inthe
measurement.

c) If edgedistances are correct but edge discharge remains >5% of the total measured
discharge, not much else can be done during post-processing other than re-
measuring additional transects during which you begin and end the measurement
closerto the edge of water.

7. Save the file and exit Q-Rev.
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SOPK Post-Field Sampling Tasks: River Sites using the Remote Controlled Boat Method

Once field verification of the measurement file is complete, the ARC-Boat and GPS antenna shall be
cleaned following standard operating procedures for cleaning field equipment used in aquatic systems.
Batteries for the ARC-Boat and ADCP/GPSantenna shall be charged or replaced as needed.

K.1 Document Incomplete Sampling Within a Site

Discharge sampling is scheduled to occur at the prescribed sampling location according to the frequency
and timing describedin Section 4and AppendixE.1. Ideally, sampling will occur at this sampling location
for the lifetime of the Observatory (core sites) or the duration of the site’s affiliation with the NEON
project (gradient sites). However, sampling may be shifted from one location to another when sampling
is compromised. In general, a sampling location is compromised when sampling becomes so limited that
data quality is significantly reduced.

There are two main pathways by which sampling canbe compromised. First, sampling locations can
become inappropriately suited to answer meaningful biological questions — e.g., stream morphology
changes in such a waythat discharge measurement quality is r educed. Second, sampling locations may
be located in areas that are logisticallyimpossible to sample on a schedule that that is biologically
meaningful.

For the river discharge sampling program, a given discharge transect must be sampled during 100% of
the bouts expectedfor the site (see Appendix E for the number of expected bouts and site-specific
documentation) over a one-year period. Transects that cannot be sampled on this schedule should be
considered compromised.

If sampling at a given transect is not possible during a given bout a trouble ticket should be submitted by
Field Science staff.

To document a missed discharge bout:

1. Createanincident with the following naming convention to document the missed sampling:
‘AOS/TOS Sampling Incomplete: MOD — [Root Cause Description]’

a. Example: ‘TOS Sampling Incomplete: CDW — Could not access plot due to permanently
closed road’

Staff scientists review incident tickets periodically to determine whether a sampling location is
compromised.
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SOPL Data Entry and Verification: River Sites Using the Remote Controlled Boat Method

Raw ADCP discharge measurement files (i.e. files that have been evaluated in WinRiver Il and Q-Rev but

not post-processed by Science) are stored on an online file storage page and post-processed by Science.
Complete the following steps toupload discharge measurement files.

1. Inthe office (or location with internet connection), store the measurement file on the cloud-

based Box.com folder.

d.

Navigate tothe main Box.com folder where raw ADCP files are stored.

1) “NEONADCP Discharge Measurement Files” https://app.box.com/folder/48084982589)

2) “Raw_Data”

Navigate tothe applicable Domain folder for raw files.

1) Ex:“Domain_03 Raw_Files”

Navigate tothe appropriate site folder.

1) Ex: “FLNT”

Navigate tothe appropriate calendar year.

Create a new folder that is unique to your discharge measurement.

1) Click the “New” dropdown and select “Folder”.

2) Ensurethatthe folder name is in a standardized format.
a) Ex:“SITE_YYYYMMDD” (FLNT_20180317)

Move all of the measurement files into this folder.

1) This includes .MMT, .PDOfiles, and _GPS.TXT file (StreamPro only) - everything that was
saved on the laptop/USB.

2) If any other relevant materials correspondto the discharge measurement (i.e. pictures,
screenshots, etc.) create a sub-folder here where they canbe stored.

3) Inadditionto.PDO and _GPS.TXT files (of which there will be many depending on the
number of transects measured), include only one (1) .MMT file (from WinRiver Il) and
one (1) .XML file in the sub-folder.

Once the all datais available on the Box folder, Science will assume it is ready for post-
processing.
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APPENDIXC  DISCHARGE MEASUREMENTS ATRIVERSITESUSING THE PILOTED BOAT METHOD

The following sections provides instruction on how to complete discharge surveys at NEON river sites
using acoustic Doppler current profiler (ADCP) instrumentation deployed with a piloted boat.

C.1 Introduction

An acoustic Doppler current profiler (ADCP) uses sound to measure water velocity based on the Doppler
Effect, a principal of physics discovered by ChristianJohann Doppler in 1842. Doppler’s principal relates
the changein frequency of a source to the relative velocities between the source and the observer. An
ADCP applies the Doppler principle by reflecting an acoustic signal off small particles of sediment and
other material (scatterers)that are present in water. The velocity measured by the Doppler principle is
parallel to the direction of the transducer emitting the signaland receiving the backscattered acoustic
energy.

NEON utilizes ADCPs to measure discharge at NEON aquatic sites that contain wadable streamand
rivers. NEON stream discharge measurement collection at river sites can be facilitated using two unique
deployment methods: (1) mounting a RiverPro ADCP (TRDI)to a remote controlled boat (ARC-Boat by
HR Wallingford) or (2) mounting a RiverPro ADCP (TRDI) off the side of a piloted boat. In both instances
the boats are driven back and forth across the channel a number of times with the base the base of the
ADCP beneath the water surface. The ADCP contains four beams pointed at 20 degrees from the vertical
that can continuously measure water depth, water velocity, and instrument speed. Discharge and
velocity calculations performed by ADCPs during streamflow measurements are well-documentedin the
literature (Mueller et al., 2013; TRDI, 2015) but the basic premise s as follows (Den Herder, 2018):

e The ADCPinstrument transmits short pulses of sound at fixed frequencies into the water.

e The transmitted sound bounces off scattered material suspendedin the water (sediment,
microscopic organisms, etc.). The returned signals fromthese scatterers are shiftedin
frequency.

e The returned signals from each beam are used to create the water currents in east, North, and
Vertical velocity vectors.

e Returnedsignals are continuously processedinto separate depth cells (or bins) to provide a
profile of the water column

e Binned velocity and depth areintegratedto calculate bin discharge, which are then summed to
calculate total discharge

e Multiple discharge transect measurements are completed and mean discharge across transect
measurements is calculated and reported as total discharge.

The ADCP measures the relative motion of the water to the ADCP by correcting the measured water
velocity with the measured velocity of the vesselusedto deploy the instrument (boat, trimaranfloat,
etc.). The velocity of the vesselcan be calculatedin two ways: externally via a global positioning system
unit (GPS), or internally utilizing ADCP bottom tracking technology. The ADCP divides the water column
into depth cells (or bins) and reports a velocity for each depth cell.
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The ADCP software integrates total bin velocity over the bin depth to obtain bin discharge. The resulting
sub-sectiondischarges are then summed over the width of the cross-sectionto obtain total measured
discharge for each transect. Certain areas within the channel cross-section profile cannot be measured
by the ADCP (at the water surface due to draft and flow disturbance around the instrument, near the
channel bed due to side-lobe interference, and near each bank due to shallow depths). These areas
must be estimated by the ADCP software. Discharge inthe unmeasured upper and lower portions of the
cross-section are typically estimated using a one-sixth power-curve estimation scheme while discharge
in the unmeasured portions of the cross-section near the bank edges are estimated using a ratio-
interpolation method (Simpson, 2001). Total stream discharge is the sum of the total channel discharge
(the sum of all discharge bin values calculated during the discharge measurement transect), the near-
shore discharge measurement onthe left side of the channel and the near-shore discharge estimate on
the right side of the channel. The total discharge associated with the measurement is the mean
discharge of all transects conducted during the sampling bout. On average it expectedto take an
experienced field crew 30-60 minutes to complete a stream discharge measurement from start tofinish.
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SOPM Preparing for Sampling: River Sites Using the Piloted Boat Method

The RiverPro ADCP (Teledyne) (Figure 61) and Kentucky Il mount (originally developed by the USGS)
(Figure 62) are used to measure discharge at NEON river sites from a piloted boat when an ARC-Boat
deployment is not available. Two software packages are required for all ADCP discharge surveys using
this method: (1) WinRiver |l software (Teledyne), a discharge data application for data collection and
post-processing, and (2) QRev (USGS OSW), a Matlab program for advanced post-processing of WinRiver

Il measurement files.

Figure 61. RiverPro ADCP. Left: base of the ADCP showing the five beam lenses; Right: top of the ADCP with

indicator lights and power cord.
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Figure 62. The Kentucky Il mount (USGS) is used to deploythe ADCP when measuring discharge at NEON river sites
using the piloted boat method.

M.1 Preparing for Data Capture

Prior to leaving the office ensure that the following criteria are met (each point explained in detail
below):

e All necessaryequipment is gathered and prepared (Table 14).

e Setup and test ADCP serial communications.

e Ifthe site has an approved stage-discharge rating curve, the current rating equation is available
for measurement comparison/validation.

M.2 Setup and Test ADCP Serial Communications

The RiverPro ADCP communicates with WinRiver Il software (installed on the laptop) via a serial cable
that connects the ADCP and the laptop. An RS-232 9-pin male to USB (with FTDI) adapteris used to
connect the ADCP serial cableto a USB port in the laptop (Figure 63).
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If the same laptop is used for ADCP measurements (this is recommended for ease of communication
setup and software availability) the following setup should only need to occur prior to the initial
measurement. Following the initial setup, the ADCP should automatically connect to the laptop software
via the serial cable. Setup, testing, and troubleshooting is best done in the office prior to deployment in
case an internet connection is needed. An ADCP discharge measurement cannot be completed if serial
communications are not configured.

To date there is not a means to integrate GPS data into discharge measurements collected using the
Piloted Boat method. As this method is meant as a back-up to the Remote Controlled Boat for discharge
measurements at river sites, it is expected it will only be used sporadically. If use of this method
becomes more common work can be conducted toincorporate GPS instrumentation.

Figure 63. Serial cables that connectthe ADCPto the 12V batteryand the laptop PC. Note the white RS-232 USB
adapter that must be included in the set.

To setupthe ADCP serial connection:

1. Remove the black cover plug from the ADCP serial cable and lubricate the end lightly with
silicate lubricant.

2. Connectthe ADCPserial cable to the ADCPsothatthe Teledyne logos are matched up.

3. Attachthe RS-232 cable to the other end of the ADCP serial cable and connect the USB end of
the RS-232 to alaptop port.

4. Use Windows Device Manager todetermine the laptop COM (communication) port that the
serial cable is assigned to.

a. Navigatetothe Windows Device Manager.
1) Start Menu > Search “Device Manager”

b. Open the “Ports (COM & LPT)” node.
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c. Note the COM port number the serial cable assignedto.

1) Unplug and re-connect the serial cable to note which COM Port number appears andre-
appears. This is the COM Port the serial cable is assignedto.

5. Select the RS-232 COM Port and set the baud rateto 115200.

a. Rightclick on the COM port assignedtothe serial cable and select “Properties” > “Port
Settings”.

b. Configure Port Settings.
1) Bits per second =115200.
2) Databits=8
3) Parity = None
4) Stop bits=1
5) Flow control = None
c. Click on the Advance Settings button.

1) Check the COM Port number assignedtothe serial cable in the top of the Advanced
Settings window.

2) Inthe BM Options section, select the Latency Timer drop down and setto 1msec.
3) Click OK twice to exit Windows Device Manager.
6. Connectthe ADCPserial cable terminal ends to a fully charged 12V 7AH battery.

a. The greenlight on the ADCPshould turn on to indicate that the instrument is receiving
power.

7. Open WinRiver Il software.
8. Inthe WinRiver Il main screen, click Configure > Peripherals.
a. Test ADCPcommunications.

1) Ensurethatthe ADCPis fully powered (greenlight should be on) and the serialcableis
installedin the designated COM Port.

2) Inthe “Peripheral Configuration Dialog” window, under the “Peripherals” node, double
click on “Read Serial Raw ADCP Data”

3) Double click on “Port: ADCP Serial Port”
4) Check that COM settings are correct and press OK.

5) With “Port: ADCP Serial Port” still highlighted, click the “Test Port” button on the right.
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6) A dialogue box will open and you should see some information begin streaming
regarding Teledyne RiverPro firmware. This indicates that the ADCPis recognized by the
WinRiver |l program (Figure 64).

a) If nothing appears than WinRiver Ilis not recognizing the ADCP.

b) Check that COM settings are correct in both Windows Device Manager and WinRiver
Peripherals setup.

c) If nothing appearsin the test window, further ADCP testing can be completed in the
Configuration Dialogue tab of the Measurement Wizard window.

7) Click “Stop” and “Close” to cease testing and close the test dialogue window.

9. Once all configuration and testing is complete the ADCP should be powered off by disconnecting
the terminals from the 12V battery.

:- j' 1 Teadal M

i || Test Port Dialog X
: || |cBREAK
b <LF> Ll
1 RiverPro<LF>

E Teledyne RD Instruments (c) 2017<LF>

' All rights reserved .<LF>

Firmware Version: 56.06 <LF>

B8 <LF>

fex

Ve

bpth
ma

| Flow Dir.

Figure 64. RiverPro ADCP Test Port Dialog indicating that ADCP data is streaming from the ADCP to the laptop.

M.3 Navigate to the Discharge Transect

If a discharge transect, or cross-section, has already been established, the bounds should be
permanently marked using stakes or plot markers (one on eachside of the river ). Navigate tothis
location and proceed to Section M.4.

If a discharge transect has not been established at the site proceed with the following steps:

1. Determinean appropriate location to establisha discharge transect.
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a. Atriver sites, thetransect location must be locatedin a straight reachinrelatively close
proximity of the staffgauge and pressure transducer. Consult with Science if the pressure
transducer location is unknown or has not yet been established.

b. Anideal discharge transect will:

1) Belocated in areasonably straight channel with velocity lines that are more or less
parallel to eachother.

2) Containvelocities that are, for the most part, > 0.15 m/s, and depths that are, for the
most part, > 0.15m.

3) Containa stable streambed free of obstructions that would create eddies, slack water,
and turbulence.

4) Containmeasurement sections that are roughly parabolic, trapezoidal, or rectangular.
5) Containa stable downstream control feature.
c. Take a picture of the transect locationthat best meets this criteria as well as the

downstream control feature and send to Science for consultation.

M.4 Assess the Discharge Transect

Prior to collecting the discharge measurement identify any instrumentation or environmental issues that
would negatively affect data quality. Document any temporary hydrologic conditions in the (AOS) Field
Metadata and Gauge Height [PROD] app in Fulcrum. If conditions are unfavorable to discharge
measurement collection, submit a trouble ticket and consult with Science.

Unfavorable conditions include, but are not limited to:

1. The staffgaugeis either not present or has been displacedin some way.

a. Adischarge measurement must not be collected ifa staffgaugeis not present atthe site or
the gauge has been displaced in any way.

b. Submit atrouble ticket to Science that includes photos of the gauge.

c. Ifthe staffgaugeis topped during high flows and a discharge measurement can be safely
collected, attempt to markor in some way reference the elevation of the edge of water
(only do soif this can be accomplished in a safe manner). A future survey of this location
(relative to the staff gauge) can provide an estimate of gauge height during the
measurement.

d. Note thatif a discharge survey is associated with a reaeration sampling event, discharge
should stillbe measured regardless of staff gauge presence.

2. Apressuretransduceris either not present or has been displaced in some way.
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a. Adischarge measurement may be collected in the event that the pressure transduceris

missing or has been displaced. However the absence of this instrument prevents

continuous discharge from being estimated.

b. Submit atrouble ticket to Science immediately if the pressure transducer is missing or has

become displaced.

3. Streamflow is exceeding the banks causing unsafe conditions on the floodplain.

a. Referto NEON Operations Field Safety and Security Plan (AD[02]) for details.

4. There is an insufficient amount of water in the channel to conduct velocity measurements.

a. SeeSection4.2.1.

5. Referto NEON Operations Field Safety and Security Plan (AD[02]) and NEON Operations Field

Safety and Security Plan (AD[02]) for further details.
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SOPN Field Sampling: River Sites Using the Piloted Boat Method

N.1

Assemble the ADCP Mount to the Piloted Boat and Attach the ADCP

Once the discharge transect has been established or assessed, configure the ADCP mount on the boat
and attachthe ADCP. The ADCP mount deploys the ADCP over the side of the piloted boat during the
discharge measurement. Prior to deploying the ADCP, always leave the protective cover on the base of
the ADCPsothat the beam lenses (Figure 61) do not get scratched.

To assemble the ADCP mount (Figure 65):

1.

10.

11.
12.
13.

14.

Ensure that the boat mount base plate s installed at the proper location of the boat where the
ADCP can be securely deployed over the side and interference (proximity of magnetic materials,
hull/motor effect) is minimized.

Install the boat mount coupler into the boat mount base plate.
Insert the short vertical pipe into the boat mount coupler.

Assemble the lower square section by attaching sections of pipe to the 90 degree elbows.
Tighten each elbow with an Allen wrench. Place a vertical coupler at each end of the square.

Attachthe lower square sectionto the short pipe in the boat mount base plate by sliding one of
the vertical couplers on the lower square section over the short pipe in the boat mount base
plate. Use an Allen wrenchto tighten the vertical coupler to secure the lower square sectionto
the short pipe. One end of the lower square section should now be sitting off the side of the
boat.

Slide the long vertical pipe through the opposite vertical coupler (the one that is off the side of
the boat) and secureit in place by tightening the vertical coupler with an Allen wrench.

Attach the tether hook to the ADCP coupler.

Attachthe ADCP coupler (with tether hook) to the circular ADCP base plate using an adjustable
wrench to tightenthe screws, nuts, and washers together.

Attachthe ADCP base plate with ADCP coupler to the base of the ADCP.

Attachthe ADCP coupler to the end of the long vertical pipe sothatthe ADCPis securely
deployed over the side of the boat.

Using a carabiner, attach a rope tetherto the tether hook next to the ADCP coupler.
Attachthe tether rope to secure location on or inside the boat.

The ADCP depth can be adjusted by adjusting the ADCP coupler and moving the long vertical
pipe up or down.

Remove the protective cover from the ADCP transducer lense and lower the sensor into the
water.
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a. Adjust the depth of the long vertical pipe so that the base of the ADCPis fully submerged.

b. Do not lower the ADCPtoo far into the water column as this increases the unmeasured area
at the top of the profile and creates a drag that negatively impacts velocity measurement.

c. Allow the ADCPtransducers tobe submergedin the water for at least 5 minutes prior to
discharge measurements in order to sufficiently equilibrate to the water temperature.

1) Failure to do sowill impact measurement accuracy.
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Figure 65. Assembly of the ADCP mount on a piloted boat.
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Start a New Measurement in WinRiver I

Once the discharge cross-section has been established or assessed, the ADCP mount has been
configured and the ADCPis submergedin the water, a new measurement file can be createdin WinRiver
I by using the following steps:

1.

Set the laptop system time zone to UTC (Coordinated Universal Time).
Start the WinRiver Il program.
In the WinRiver Il main screen, click Configure > Units > All SI to set units to metric.
In the WinRiver |l main screen, click File > New Measurement torun the Measurement Wizard.
Fill in all information in the Site Information tab:
a. Station Name: Four digit site code of where you will be measuring discharge (i.e. “TOMB”)
b. Station Number: Leave blank.
c. Measurement Number: The sequential discharge measurement number for the site.
d. Agency: “NEON”.
e. District: Leave blank.
f. Hydrologic Unit: Leave blank.
g. Field Party: Initials of all crew involved in measurement.
1) Separateinitials with a comma delimiter (i.e. NH, LFS).

h. Processed By: Initials of technician operating the WinRiver |l software and evaluating data
collection.

i. Deployment Type: “Piloted Boat”.
j- Boat/Motor: Leave blank.

k. Meas. Location: If measured at the regular discharge cross-section enter “DSC1”, if
measured at a different cross-section within the site denote that with a different code here
(i.e. “DSC_US" if the cross-sectionis upstream of the regular location).

1) Make sureto alsoinclude notes in the main remarks sectionthat describe alternative
transect locations (be sureto include an estimate of how many meters awaythe
measurement was conducted from the regular location).

a) Toadd a note to the main Remarks section of the measurement file, right-click Site
Information on the Measurement Control window.

b) Enter notes into Remarks section.

I.  Grid Reference: Leave blank.
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6. Select the “Rating Information” tab.

a.

b.

Inside Gage Height: Enter the water level measurement on inside of staff gauge.
Outside Gage Height: Same value as “Outside Gage Height”.

Rating Discharge: Enter the predicted discharge given gauge height from rating curve, if
available.

Index Velocity: Leave blank.
Rated Area: Leave blank.
Rating Number: Leave blank.

Water Temp: Enter the water temperature (°C) measured using a thermometer submerged
in the stream for at least 5 minutes.

1) The measured watertemperature should be within 2 degrees of the ADCP temperature
measurement.

a) Tocheck the temperature being measured by the ADCP, open the Test Result
dialogue box under the QAQC > ADCP node. The measuredtemperature will be
displayed along with other sensor data.

b) You canalsoview temperature time series data during or after a transect
measurement by selecting View > Graphs > Time Series > Temperature.

c) The ADCP must be sitting in the water for at least 5 minutes to allow the instrument
to fully equilibrate to the water temperature.

d) Ingeneral ADCPtemperature measurements donot drift until there is a major issue.
If this does occur, the ADCP-measured temperature will deviate greatly from the
thermometer measurement. Ifthis is the case make a note in the measurement
note window and contact Science following the measurement bout.

Tail Water Level: Leave blank.
Magn Variation Method: Model

Measurement Rating: fill this out at the end of the measurement based on your judgment of
the measurement quality

1) This is a subjective assessment. Discretionis given to the hydrographer who led the
survey. Include any relevant field notes that formulated the basis of this rating in the
remarks section.

Control Codes: select any that apply to the measurement.

Wind Speed: Enter the measured wind speed (kph) using an anemometer.
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1) If wind speed was enteredin units other than kph, note the units used in the remarks

section.

m. Wind Direction: Enter the measured wind direction using an anemometer.

1)

If the anemometer does not provide a direction measurement enter:
a) “Upstream”:ifthe wind is blowing up river.

b) “Downstream”:ifthe wind is blowing down river.

c) “Cross-wind”:if the wind is blowing across the river.

d) “Mixed”:if the wind is not blowing in any particular direction.

n. Edge Method: Enter the method used for determining bank distances (i.e. laser rangefinder,

meter tape, eye estimate, etc.).

7. Select the “Configuration Dialogue” tab.

a. The software will immediately tryto recognize the ADCP (“Interrogating the ADCP...”).

1)

If the connection is successful, the button next to “ADCP” will eventually turn green.
a) This cantake afew minutes.
b) This means thatthe software recognizes the ADCP via the serial cable.

c) If awindow pops up thatsays “The ADCPis not responding...” this means that the
ADCP was not recognized by the software.

(1) Click “No” (clicking “Yes” will have the software cycle through all available
ports).

(2) Inthe “Serial Communication Settings” window, ensure that COM Port settings
match what was determined using Windows Device Manager. Click OK.

(3) Ifthe “The ADCPis not responding...” message returns, click Cancel.

(4) Inthe “ADCP” dropdown, ensure that the correct ADCP model (RiverPro) is
selectedin the dropdown box. Click the “Check ADCP” button to re-test
configuration.

(5) The ADCP must be recognized by the software for the discharge measurement
to be conducted. If communication problems persist, submit a trouble ticket and
contact Science.

b. The DepthSounder box can be left blank.

c. Under Offsets:

1) EnterTransducer Depth.
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h.

a) Ensurethatthe boat is steadyand stable in the water column prior to taking this
measurement.

b) Measure from the water level to the center of the slantin the transducer faces with
a ruler or metric tape.

c) This is a very important measurement! Repeat it two or three times to ensure
accuracy.

Enter Magnetic Variation, the angle of declination relative to your location in the world.

1) For greatest accuracy, checkthe National Geophysical Data Center website tofind the

declination angle based on your latitude and longitude.
2) Some examples:

a) Butler, AL: -2°27" W (-2.27)

b) Newton, GA: -4°59’W (-4.59)

c) Arcata,CA: +14° 16’ E (+14.16)
Enter the Max Water Depth.

1) This is an estimate of the maximum water depth (m) that is expected to be measured
during the discharge measurement.

Enter the Secondary Water Depth.

1) This is an estimate of the minimum water depth (m) thatis expectedto be measured
during the discharge measurement.

Enter the Max Boat Speed.

1) This is an estimate of the maximum boat speed (m/s) that is expected during the
discharge measurement.

All other values canbe left as defaults.

8. Select the “Output Filename Options” tab.

9. Under the “Recording” section:

a.

In the “Filename Prefix” box enter the four-digit side code.

1) Example: “LEWI”".

Ensure the “Use Prefix in Filename” box is checked.

Leave the output directory at the default location (C:\Measurements\).
In the “Include Filename Options” section:

1) Uncheck the “Measurement Number” box.
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2) Leave “Transect Number” at “0”.

3) Leave “Geographic Current Survey” and “Sequence Number” boxes unchecked.

e. Inthe “Use Date/Timein Filename” section:
1) Select “Long (YY-MM-DD-hhmmess).
f. Inthe “Use Delimiterin File” section:

1) Select “Underscore” (default).

g. Checkinthe Filename Preview sectionthat the above settings are correctly applied (Figure

66).

h. Note thatthese settings canonly be entered at the start of a New Measurement. Once the

Measurement Wizardis closed, filename settings can only be changed by starting a new

measurement.
10. Open the Command Preview tab.

a. Reviewallinformation to ensure that is correct.

b. Ensurethatgreen checks are present for ADCP and GPS communications.

c. Click the Finish button to complete wizard.

11. Review the Summary Page tabto ensure all information was correctly entered.

12. Click Finish to exit the Measurement Wizard.
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Figure 66. Required settings in the WinRiver Output Filename Options dialogue box withinthe Measurement
Wizard.

N.3 Pre-Measurement QAQC: Overview

The following QAQC protocols are critical to quality data collection and must be initiated prior to the

first transect measurement of each ADCP discharge bout.

e Set the ADCPclock

e Collecta temperature measurement

e Executean ADCPtest

e (Calibratetheinternal ADCP compass

e Perform a moving bed test and assess moving bed test summary
e Configure the reference navigation

N.4 Pre-Measurement QAQC: Set the ADCP clock

Prior to the initial transect measurement the ADCP clock must be set to match the PC time (UTC).
Failure to properly set the ADCP clock will resultin data files with incorrect timestamps.

1. Set the timezone on the PCto (UTC) Coordinated Universal Time (Figure 67).
a. Rightclick on the datetime in the lower right corner of the screen.

b. Select “Adjust date/time”
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In the “Time zone” dropdown, select “(UTC) Coordinated Universal Time”

2. Inthe WinRiver Il main screen, click on Acquire > Set ADCP Clock.

3. Set the ADCP clock to matchthe PC time (UTC).

4. Click the “Set Clock” button.

a.

Note: only clicking the “OK” button will not set the clock, the “Set Clock” button must be

selected.

Settings

@ Home Date & time

l Find a setting *Some of these settings are hidden or managed by your organization.

Time & Language

Date & time

@ Region

Z

Language

Speech

(=]

Current date and time

3:24 PM, Friday, September 27, 2019

Set time zone automatically
@D off

Set the date and time manually

Synchronize your clock

(UTC-03:00) Salvador

(UTC-02:00) Coordinated Universal Time-02
(UTC-01:00) Azores

(UTC-01:00) Cabo Verde Is.

(UTC) Coordinated Universal Time

(UTC+00:00) Dublin, Edinburgh, Lisbon, London
(UTC+00:00) Monrovia, Reykjavik

(UTC+00:00) Sao Tome

(UTC+01:00) Casablanca

Figure 67.Setthe PCused forthe discharge measurement to (UTC) Coordinated Universal Time and match the

ADCP clock to this setting.

N.5

Pre-Measurement QAQC: Collect a Temperature Measurement

1. Place thethermometerinto the waterto begin collecting a temperature measurement.

2. Enterthis value into the Measurement Wizard Rating Information Tab under “Water Temp”.

N.6

Pre-Measurement QAQC: Execute an ADCP Test

This test verifies that the ADCPis functioning properly and communicating with WinRiver Il software.

1. Inthe WinRiver Il main screen, click on Acquire > Execute ADCP Test.

d.

Note that the ADCP must be installedin the mount and submergedin non-flowing water to
obtain the best test results.
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A series of six tests will be initiated that evaluate ROM, RAM, Communications, RTC, Compass,

and Temperature performance. Checkthat all tests pass onthe left pane of the dialog window.

After the tests have been run, sensor data will begin to be sampled and displayed in a loop.

Click the “Stop PC20” and “Stop PC40” buttons to end testing and close the dialog window.

Pre-Measurement QAQC: Calibrate the Internal ADCP Compass

A calibrated compass is essential for conducting Moving Bed Tests and for using GPS data as the
navigation reference. This is a two person task, one personturning the boat slowly in the water while

another person monitors the data and communicates the test results.

1.

Ensure thatthe ADCPis secured within the ADCP mount in the exact position it will remain

throughout the discharge measurement.

Ensure that the boat is not located near vehicles, steel bridges, or other large ferro-magnetic

masses.

a.

Check for any materials near the boat that could disrupt the compass calibration — this
includes tools, tool boxes, cell phones, hot hands, etc.

Move these materials away from the ADCP during calibration and throughout the discharge

measurement.

In the WinRiver Il main screen, click on Acquire > Execute Compass Calibration.

Select Use Pitch/Roll?

a.

Click “No” if the ADCP will not be subject to pitch and roll (i.e. calm water). This calibration
test requires two rotations, one for calibration and one for verification.

Click “Yes” if the ADCP will be subject to very high pitch and roll conditions. This calibration
testrequires up to eight rotations, four for calibration and four for verification. Typically, no
pitch and roll calibrationis required.

Click the Start Calibration button and wait a moment until the compass is initialized by the

software.

Beginto slowly and smoothly rotate the boat in either direction.

a.

b.

If it is safe to enter the waterandrotate the boat by hand, do soas this allows for a much
easier compass calibration. Ifit is not safe to enter the water, operate the boat using the
motor.

Do not cause sudden accelerations or decelerations.

Rotate the boat until all of the red bars in the dialogue window have been replaced by a dark
green color (Figure 68).

a.

The greener the bars, the better the data.
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b. Ifabaris not dark green, rotate the boat more slowly and more smoothly.

c. Correctany non-dark greenbars when they occur by rotating the boat back 10-20° until that
bar is once again highlighted. Then, when it becomes dark green, proceed as before.

d. Clearand constant communication between the staff member moving the boat and the staff
member evaluating the test results onthe laptop is critical during this period.

8. Once calibration rotations are complete, click OK and continue with the verification rotation.
a. If Pitch/Roll is selected there will be more initial rotations.

9. Once the verification rotation is complete a calibration error will be calculated and presented.
a. Ensurethatthe calibration erroris less than 2°.
b. Aim for atotal error of < 1°.

c. If calibrationerroris < 2°, the compass calibrationis complete and the window can be
closed (< 1° is preferred — try to obtain this).

d. If calibrationerroris > 2°, do not accept the compass calibration.

e. Repeat calibration procedures.
1) Look around for magnetic materials that may be affecting the compass.

2) Move these materials awayfrom the ADCP or move the ADCP awayfrom them, if
possible.

f. If, afterthree attempts, a calibration error of < 2° cannot be achieved, reference the
troubleshooting steps below.

1) If, following troubleshooting, a compass calibration of < 2° cannot be achieved, accept
the lowest calibration error possible and proceed.

2) Document this occurrence as a note in the Remarks Section, it will be a very important
component in evaluation the measurement during post-processing.

10. Once complete, check that the correct Magnetic Variation Correction value was entered by the
software during the measurement wizard setup (Section N.2).
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Figure 68. ADCP Compass Calibrationdialog box. The entirety of the horizontal bar is red uponinitiating the test.
Rotate the boat slowly and steadily so that bar is colored dark green throughout.

Troubleshooting Compass Calibration Issues

There may be too much magneticinterferencein the areayou are attempting tocalibrate the

compass.
o Ensurethat no magnetic materials are near the ADCP.

o Try moving the boat to a different area of the stream and repeating the calibration.
o Itmay be that material on the streambed (rebar, trash)is affecting the calibration.

Computational errors may occur during calibration. If you receive an error message indicating

that a computational error occurred, repeat the calibration and be sure to rotate the ADCP slow

and smooth.
o Ensurethatall points in the calibration display are of good quality (dark green).

Communication errors may occur during calibration when using a slow communication Baud

rate.
o Ifyou receive a “Failed to get calibration data...” message verify that all ADCP
communications are set to the 115200 Baud rate.

o Ifyou receivea “360 degrees” compass error message then the compass calibration test has

failed and needs to be performed again.
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N.8 Pre-Measurement QAQC: Perform a Moving Bed Test

Moving Bed Tests (MBT) are used to determine if the bed of the discharge cross-sectionis in motion. An
un-accounted for moving bed canlead to 5-10% bias in discharge measurements performed with the
RiverPro ADCP.

MBTs must be performed prior to each ADCP discharge bout. WinRiver Il software analyzes the data
collected during the MBT to assess the moving bed characteristics of the site and to detect common

error conditions, which may invalidate the test. The loop method is presented below as a means to test
whether a moving bed is present. The loop method must be applied properly, or it may produce
incorrect results.

Note that the accuracy of the loop method is not adequate for mean velocities less than 0.8 ft/second
(0.24 m/s). If mean velocity is below 0.8 ft/s (0.24 m/s), water velocity is low throughout the water
column and the probability that the bed is in motion is decreased. Ifthe bed is in fact in motion at these
velocities (or particles on the surface of the bed arein transit) it is likely that not accounting for it will
exert only a minimum bias in the overall discharge estimation.

A properly calibrated compass is critical to application of the loop method, the error caused by an
improperly or un-calibrated compass can be in either direction, resulting in either more or less moving
bed than actually is present.

To perform a moving bed test:

1. Beginthe MBT from an initial point on the near shore where you will be able toreturn to with
precision (Figure 70).

a. Navigatethe boat to a starting location near the edge of the water on the near bank.
b. Markthis location using some physical reference for the starting point (anchored float, etc.).

2. When running the MBT it is optimal for the person using the radio controller to guide the ARC-
Boat so thatis slightly downstream of the controller.

a. This allows for easier orientation of how the controller movements affect the boat.

b. If operating the remote control from a piloted boat, it is very important to remain far
enough downstreamso that the piloted boat motors and hull do not create velocity
disturbances within the measurement transect.

3. Inthe WinRiver [l main screen, click on Acquire > Start Pinging (shortcut key: F4).

4. Open the Ship Track graph. This allows for a better view of the boat path as it does not show
the velocity paths (Figure 69).

a. View > Graphs > Ship Tracks > Ship Track

b. The greensquareis where the float is located when the test starts.
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5. Onthe Acquire menu, click Select Moving Bed Test.
6. Select “Loop Test” and click the Start button (shortcut key: F6).

7. Once you startthe test, immediately begin navigate the boat across the river to the opposite
bankin a slow and steady manner.

a. Maintaina steadyspeed that, if possible, does not exceed the stream velocity.

b. Note thatthe greensquarein the Ship Track graph denotes your starting location.

% Ship Track 1 - TRDI

=8 HoR =5

Ship Track
—{Ref: BT) ——(Ref: GGA) {Ref: VTG)
4

=
b

Distance North [m]
&
b

-43.5)

576 ' ' '
0.0 -196 209 61.3
Distance East [m]

101.7

Figure 69. The WinRiver Il Ship Track window observed during aloop moving bedtest. The green boxindicates the

boat starting position, the line shows the boat path as itis navigating across the channel and turned back around
toward the starting bank, and the red boxindicates the boat ending position.

8. The MBT Test must last a minimum of 180 seconds (3 minutes).

a. This duration encompasses the time spent moving the boat across the channel and back to
the near bank.

b. Itis helpful for a staff member using or nearby the laptop to call out the measurement
duration to the other staff member moving the boat sothe speed canbe adjustedif needed.

9. When the opposite bank is reached, gently turn the boat around (don’t stop) and head back to
the exact starting point where the test was initiated.

a. This is a critical part of the moving bed test, make sure this is a smooth and slow turn by
gently using the rudders and throttle together.
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Figure 70. lllustration of the Loop Moving Bed Test procedure.

10.

11.

Once the boat returns back to the exact starting point on the near shore where you beganthe

MBT, stop the test immediately (shortcut: F6 or Acquire > Stop Moving Bed Test).

a. Note thegreensquarein the Ship Track Graph indicating where the boat was located when

the test beganand the red square indicating where the boat was located when the test

ended.

b. If you don’t hit the F6 button right at the starting point this could falsely indicate that the

bed is moving.

Review the Ship Track window (Figure 71).

a. Ifthe track(red line) contains an “open mouth” (i.e. the green and red squares do not line

up and thered line is not connected) this may indicate that there is a moving bed.

b. Ifthe trackdoes not contain an “open mouth” (i.e. the greenand red squares are on top of

each other and thered line is connected), this indicates that a moving bed is likely not

present.

c. Moving bed conditions will always cause the ship trackto move upstream —if the ship track
moves downstream the loop test is not valid.

d. Ifthe boat was not returned to the exact starting point it can resultin the end point being

upstream or downstream of the starting point. This results in a potentially false positive for

moving bed conditions (endpoint is upstream of the starting point) or an invalid result

(endpoint is downstream of the starting point).
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Figure 71. Left: A moving bedis likely present as indicated by the open loop; Right: a moving bedis not likely

presentasindicated by the closed loop.

12. Document all relevant notes that apply to the MBT.

a. Toadd a note thatrelate to a specific MBT, right click on the test node (i.e. “Loop 000”), and

select “Add Note”.

13. Review the Moving Bed Test Result window to evaluate the results of the MBT (Figure 72).

a. Inthe Measurement Control window, under QA/QC, click on the Moving Bed Test node and
open the Test Resulticon for the test that was just completed (Loop tests beginas “Loop

000”).

b. The Test Result window provides metrics that describe the MBT. Atthe bottom of the
window reference the “NOTE” — it will indicate whether correction is recommended.

1) If acorrectionis recommended, check the box to the left of the MBT (i.e. “Loop 000”).
This will apply a correction to the measured discharge toaccount for the moving bed

velocity.

a) Once the correction has been applied, proceed with the next pre-measurement

QAQC procedure.

2) If acorrection is not recommended and all other aspects of the MBT are valid then no

correction is needed.

a) Proceed with the next pre-measurement QAQC procedure.

14. If thereis confusion whether or not the MBT was completed correctly or questions arise

interpreting the results, consider the following common sources of errors associated with the

Loop Method.

a. Watervelocity must be >0.24 m/s in order for a moving bed to be evaluated.

1) If velocity is below this threshold a loop test cannot be evaluated by WinRiver II.
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2) At low velocities suchas theseit is likely that a moving bed is not present or is negligible
in terms of affecting measured discharge.

3) Conducting an additional loop test is not required.
4) Proceed with the pre-measurement QAQC procedures in this instance.
Systematic compass errors.

1) Checkthedirection of the velocity vectors (blue lines) during the Loop Test in the Stick
Ship Trackwindow. They should be pointed in the same direction during both loop
paths.

2) Ifvectors arein opposite or in an erratic direction this is a symptom of poor compass
calibration.

3) Conducting another compass calibration followed by a second MBT may be helpful.
Bottom-tracking bias and uncertainty.
1) Check the Velocity Contour Profile associated withthe Loop Test.
2) Aretherelarge unmeasured areas along the streambed?
a) If soa MBT may be difficult to validate.

3) Conducting another MBT along a different transect (upstream or downstream) may be
helpful.

Failure to return to theinitial starting point.
1) Ensurethatthe boat was returned tothe exact starting location at the end of the MBT.
2) Make surethat you ended the MBT at the exact time you reachedthe starting location.

Irregular or insufficient sampling of the cross section because of loss of bottom track, non-
uniform boat speed, and loitering at the banks.

15. If any of the above criteria are in doubt:

a.

Conduct another Moving Bed Loop Test in a slow, steady manner witha smooth transition
at the opposite bank.

It may be helpful to begin the second Loop Test from the opposite bank or from a different
transect location.

1) Besure not to gettoo far awayfrom where you will be collecting the discharge
measurement.

2) Thorough notes are critical, always document all relevant information regarding MBT
issues.
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Loop Time: 358.400 [s] @ Loop time > 180 seconds
Moving Bed Velocity: 0.001 [m/s]
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Delta Flow Direction: 5.341 [degrees]

Percent Bad BT: 0.000 [percent]

Estimated § Correct.: 0.000 [percent]
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NOTE: Moving Bed Vel. (MBV) < Minimum MBV Criteria
No Correction Recommended <= Test result: No moving bed

Figure 72. Moving Bed Loop Test Result window. In this example the required conditions were metin orderto
evaluate amoving bed (Loop time, watervelocity)and a moving bed was not detected (the moving bed velocity <
the moving bed velocity criteria), thus no correction was recommended.

N.9 Pre-Measurement QAQC: Configure the Reference Navigation

The reference navigation determines how the direction or bearing (heading) of the instrument is
measured. While measuring discharge from a piloted boat, Bottom Trackis the default and currently the
only available choice for the reference navigation. If a moving bed was detected using a Loop Test,
discharge canbe corrected using the MBT results. The ability of the ADCP to Bottom Track can become
compromised during periods of high turbidity and suspended sediment concentration (SSC). An overload
of scaterrersare produced in these conditions which prevent the ADCP beams from reaching the bottom
and measuring velocity throughout the channel profile. If turbidity is high and the ADCPis having
difficultly bottom tracking (this is evidenced by a large bands of missing ensembles in the velocity
contour profile and warnings in the Measurement Control Window), conducting a measurement may
not be possible. Submit a trouble ticket to Science in this instance.

N.10 Conduct Discharge Measurements with the ADCP and Piloted Boat

WinRiver |l software calculates discharge using real-time velocity measurements acquired during
transects across the stream. Perform the following steps in order to successfully collect a high-quality
stream discharge measurement using the piloted boat method at river sites. Eachstepis presentedin
greater detail throughout this section.

1. Start ADCP pinging.

2. Establishtransect start and end points.
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3. Enterstaffgauge height prior to each transect measurement.
4. Measuredischarge across the channel (minimum 4 transects).

5. Evaluate whether additional transects are required.

1. Start ADCP Pinging

Setting the ADCP to start pinging enables ADCP data collection. In general, after you have startedthe
ADCP pinging, there is no reasonto stop pinging until you are finished the entire discharge survey and
ready to remove the ADCP from the water. An exception would be if you were operating with batteries
of limited capacity, under that circumstance stopping ADCP pinging will conserve power.

1. Ensurethatthe ADCPis in the water powered on.
2. PressF4tostartthe ADCP pinging (or Acquire > Start Pinging).

3. Inafew seconds, ensembles will begin tobe generated and changing values will appear within
several of the WinRiver Il data windows.

a. Anensemble is the data output generated by multiple ADCP pings that are averaged
together. Ensembles are tracked in numerical order, timestamp, and position.

b. Ifthe ADCPis positioned in sufficient depth, velocity profiles will become available.

c. Note that WinRiver Il will not display meaningful data unless the trimaranfloat isin the
water.

d. The ADCP can continue pinging when it is not in the water.

2. Establish Transect Start and End Points

The locations at eachside of the channel where the discharge measurement begins and ends must be
established before recording discharge transect data. Because stream depths eventually become too
shallow for valid data collection as the ADCP approaches a bank, it is necessaryto estimate dischargein
the near-shore unmeasured zones using the WinRiver Il and Q-Rev software. To ensure the accuracy of
near-shore discharge estimates, the distances from the edge of water to the starting and stopping
points of eachtransect must be measured using a distance-measurement device (suchas a laser or
optical rangefinder), tagline, or some other accurate measurement device.

Placing anchored marker buoys at the start and end points of transects is advantageous for keeping
consistent edges and ensuring that the same cross-section profile is measured during eachtransect. If
placing marker buoys in the channel is not possible tryto remember these locations using some physical
reference.

Other notes on transect start and end points:
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e Measurement uncertaintyincreases as the distance increases betweenthe start and end points
and the edges of water due toless measurements and more interpolation.

e Trytoensurethatthe velocity profile at the start and end locations are representative of the
velocity profiles leading up to the bank in order to limit interpolation bias.

e Inchannels that contain vertical walls at the edges, start and end points for transects should be
no closer to the wall thanthe depth of water at the wallto prevent acousticinterference from
the main beam or side lobes impinging on the wall.

o For example, if the depth at a vertical wall is 10 feet, transects should start or stop at least
10 feet awayfrom the wall.

e |fthe cross-section has been measured previously at the same location, WinRiver Il “Locations”
can be utilized to help determine the start and end points that were previously used and to help
navigate the float across the channel.

o See for instructions on loading available locations and how to save new ones.

To establishtransect start and end points:

1. Navigate the boat just off the edge of water on the near shore and into open water until the
ADCPtransducers are submerged.

2. Note the number of “Good Bins” listed in the Composite Tabular window shown in the right
panel of the main WinRiver Il screen (Figure 73).

a. Two “Good Bins” (or depth cells) are required in order to start and end the transect
measurement.

3. Navigate the boat slowly awayfrom the bank until the tabular display indicates you are ata
sufficient depth to set the transect start point (>2 Good Bins, closestto2 is preferred).

4. If possible, mark this location with a marker buoy or weighted float. Otherwise try to remember
this position by using some physical reference.

5. Navigate the boat slowly towards the opposite shore.
a. Travelsmoothly and slowly with the bow of the boat pointed upstream.

1) Crabbing across the channel may be difficult during periods of low flow, in those
instances point the bow towards the opposite bank.

2) Note any navigational challenges in the measurement notes.

6. While moving across the channel observe the Velocity Contour graphto view channel conditions
and ensure that the ADCPis working as expected with the loaded configuration.
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a. Observe the Velocity Contour Profile located on the bottom panel of the WinRiver Il main
screen (Figure 74). This display illustrates water velocity and depth across the channel.

1) The very top and the very bottom of the channel will always be unmeasured by the
ADCP and discharge in these locations will be interpolated. The top unmeasured areais
a function of transducer depth, or how low the ADCPis in the water column.

2) Vertical white bands within the profile are unmeasured areas that canoccur for a
variety of reasons including biota, woody debris, physical structures, or simply moving
the float too fast or abruptly across the channel.

a) Work to limit the number of white bands in the profile as anincreasein

unmeasured arearesults in an increase in measurement uncertainty.

b) Ifthe unmeasuredarea within the cross-sectionis significant a different discharge
transect upstream or downstream may be necessary.

3) Note regions where the channel depth changes abruptly.

a) Make a mental note to move more slowly across these regions during data
acquisition to help bottom tracking maintain a valid lock on the bottom.

7. Asthe boat approaches the opposite shore note the Number of Good Bins in the Composite

Tabular window (Figure 73) and stop the boat at the opposite edge of water where two good
bins are available.

8. |If possible, mark this location with a marker buoy or weighted float.

9. Proceed to the next step once transect start and end points are established at eachside of the
channel.
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Figure 73. Composite Tabular window in WinRiver I, green box: number of ensembles (hold until 10 at transect

start/end points); redbox: Number of Good Bins (mustbe >2 to begintransect); purple box: total discharge; blue
boxes: water andboat speed; orange box: distance made good (total transect length); brown box: duration (total
transectdurationmust be 2180seconds).
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Figure 74. Unmeasured areas in the ADCP profile where velocity is extrapolated. Top left: ADCP blanking distance
and cell size distribution (credit: SonTek); top right: unmeasured areas of the profile relative to ADCPbeams
(credit: SonTek); below: the WinRiver Il velocity contour with unmeasuredareas delineated.
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Enter Staff Gauge Height Prior to Measuring Discharge at Each Transect

The staff gauge height must be entered prior to eachtransect measurement using the Fulcrum app. The

mean gauge height recorded prior to all transect measurements is the stage value associated with the
mean discharge measured during all transect measurements. Notes regarding conditions observed

during individual transects (high/low flows, changing gauge heights, wind conditions, the passage of
other vessels during measurement, any noteworthy events, etc.) can be enteredin the main Remarks

section of the Measurement Wizard as well as in the individual transect notes.

Gauge height observation and recording must immediately precede the transect discharge sothe stage

level during the discharge measurementis accurately characterized.

To enter the staff gauge height prior to each transect measurement:

10.
11.
12.
13.

14.

Open the (AOS) Field Metadata and Gauge Height [PROD] app in Fulcrum.
Enter the appropriate information in the Metadata, Spatialand Temporal Information tables.
In the Stage Height table, enter the current staff gauge height in the “Initial Stage Height (m)”
field.

a. Note that this does not necessary have to equal the staff gauge height prior to the first

measurement transect.

Under the Stage Height table note the “Collecting Discharge withan ADCP Today?” field and
select “Yes”.
Click the “ADCP Transect Stage Measurements” buttonthat appears.
Click the red plus (+) button at the top right of the window to create arecord.
Enter the time the staff gauge is measuredin the Staff Gauge Height Reading Time field.

a. This must be done immediately preceding the discharge measurement.
Enter the Staff Gauge Asset Tag.

a. This islocated on the top of the staff gauge you are reading.
Enter the Transect Number.

a. This must correspond to the transect number generatedin WinRiver Il.

b. By default, transect numbers begin at 000 and increase to 001, 002, 003, etc.
Enter the Staff Gauge Height.
Enter the Staff Gauge Height units.
Click the green check button in the top right corner of the window to save the record.
Additional ADCP Transect Stage Measurementscan be added by clicking the red plus button at
the top right of the window.
ADCPtransect stage measurements can be deleted by clicking the black X button to the left of
each record.

a. Records should be deletedif:

i. Errorsarepresentin any of the fields.
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15.

16.

17.

18.
19.

4.

ii. The measurementtransectis notto be used in the calculation of total discharge
(the transect will remain unchecked in WinRiver Il due to measurementerror,
the transect was started by mistake, etc.).

The ADCP Transect Stage Measurements window should remain open throughout the discharge

survey so that staff gauge height can be measured prior to each transect measurement.
The window can be closed by clicking the green check mark at the top right of the window once
all transect discharge measurementsare complete.

Enter Weather Information, Post Fieldwork Observations, and General Comments information
to the record as needed.
Click the greencheck mark at the top right of the window to save the record.

Fulcrum data will load automatically when the recordis saved and the device receives a wireless

internet signal.

Measure Discharge Across the Channel (Minimum 4 Transects)

A “transect” is considered a single discharge measurement that begins at the transect start/end point on
one side of the channel and ends at the transect start/end point on the opposite side of the channel.
Each ADCP discharge survey must contain a reciprocal number of transects (i.e. ifa transect is measured

from the near bank to the opposite bank, another transect measurement must be included from the
opposite bank to the near bank). A minimum of four transects are required for each ADCP discharge
survey but more may be necessary. Eachtransect must last a minimum of 180 seconds and the total

time for all transects must be >720 seconds.

Complete the following steps to measure discharge during each transect:

1.
2.

Hold the position of the boat steady at one of the markedtransect start or end points.

Using a stadia rod, meter tape, or laser range finder, determine the distance from the transect
start point to the edge of water. Thisis referredto as the “edge distance”.

a.

b.

Measure the area from the center of the ADCPto the edge of the water.

If using a rangefinder make sure that the laseris not hitting leaves or branches hanging over
the channel. Take a few shots and make sure they are all the same.

If it is not possible to measure this distance with an instrument, use the “Distance MG
[Made Good]” values displayed on the right side of the Composite Tabular 1 window to
calculate the edge distance from beginning/end of the transect tothe adjacent edge of
water. Be careful not to accidently beach the ARC-Boat by getting too close to the opposite
bank.

Click Acquire > Start Transect (shortcut: F5) to begin data recording.

a.

Note that the measurement has now been initiated.

When prompted, enter the edge distance (measuredin Step 2).
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Define whether you started the measurement from the left or right bank.

a.

When facing downstream, the left bank is on your left side.

Hold the position of the boat at the transect start point for at least 10 shore ensembles.

a.

This is equivalent to about 10 seconds.

b. The number of ensembles can be viewed in the Composite Tabular window (Figure 73).

Once 10 ensembles are recorded at the transect start point slowly and steadily navigate the
boat towardthe opposite bank.

Move the boat slowly and steadily across the channel.

a.

The total duration of eachtransect (moving the boat from one side of the channel to the
other) must be > 180 seconds.

The cumulative time spent measuring each transect s directly correlated to measurement
quality.

1) The slowerand steadier the float crosses the channel the higher the data quality.

Maintainan average boat speedthatis less than or equal to the water velocity.

1) Watervs. Boat speed can be monitored using the Water Speed vs Boat Speed graph.
a) Click View > Graphs >Time Series > Water/Boat Speed (Figure 75).

2) When water velocity is very slow, keeping the boat speed below the water velocity may
not be a possible (or practical) approach. Under these conditions the smoothness of
boat operation becomes critical.

3) Avoid fastand sudden accelerations.
Attempt to point the bow of the boat upriver and crab across the channel.

1) Ifthisis not possible due to low surface water velocities, point the bow of the boat
towardthe opposite shore and slowly move towards it.

Observe data displayed on other graphs as needed to monitor data quality.
1) Click View > Graphs/Tabularto explore other graphical and tabular interfaces.

a) Graph display settings canbe configured by right clicking on the graph and selecting
“Properties”.

Continue across the channel until you reachthe transect end point on the opposite shore.

Ensure that two good bins are available at this location using the Composite Tabular window

(Figure 73).

Hold the boat steadyat this location and wait until at least 10 shore ensembles have been

collected.
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a.

b.

This is equivalent to about 10 seconds.

The number of ensembles can be viewed in the Composite Tabular window (Figure 73).

12. Using a stadia rod, metertape, or laser range finder, determine the distance from the transect
end point to the edge of water. This is referred to as the “edge distance”.

13.

14.
15.

16.

a.

b.

Measure the area from the center of the ADCP to the edge of the water.

If using a rangefinder make sure that the laser is not hitting leaves or branches hanging over
the channel. Take a few shots and make sure they are all the same.

If it is not possible to measure this distance with an instrument, use the “Distance MG
[Made Good]” values displayed on the right side of the Composite Tabular 1 window to
calculate the edge distance from beginning/end of the transect to the adjacent edge of
water. Be careful not to accidently beach the ARC-Boat by getting too close to the opposite
bank.

Click Acquire > Stop Transect (shortcut: F5) to stop data recording.

a.

Note that the measurement has now ended.

When prompted, enter the edge distance (measuredin Step 12).

Define whether you ended the measurement at the left or right bank.

a.

When facing downstream, the left bank is on your left side.

To add notes that document important information relating to each transect right clickon the
transect node in the Measurement Control window (upper left pane in the WinRiver Il main

scree)and select “Add Note”.

a.

Notes that describe individual transect measurements help explain the data that was
collected and are thus extremely beneficial to post-processing/data QAQC. Always provide
clear, descriptive documentation regarding the discharge measurement. Examples of
individual transect notes include:

1) “Abarge wentthrough prior to/following the transect measurement”.
2) “The wind picked up considerably during the transect measurement”.

3) “Itwas difficult to maintaina boat velocity less than the mean velocity of the river
during the transect measurement due to...”.

4) “Poor bottom tracking/GPS tracking occurred during this transect due this measurement
due to...”.

5) “Riverstage appearedto rise/fall during this transect”.

6) “Highsediment concentrationwas present during this transect”.

17. The transect measurement is now complete.
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18. To view the data you collected during the transect openthe node (+) under the Transect name
in the Measurement Control window and double-click the disc button.
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Figure 75. Water Speed vs. Boat Speed graph. Above: Improper technique. The boat speed (purpleline) is erratic
and higher than the water velocity (red line). Below: Propertechnique. Maintain an evenboat speed so that the
purple and red lines are more in line and boat speed remains generally lower than water speed.

Collect (At Least) Three Additional Transect Discharge Measurements (Minimum of Four Total)

Repeat the previous steps, navigating the boat across the channel from eachtransectstartandend
point until a total of four transects have been measured (two in each direction). A minimum of four

transects (each lasting a minimum of 180 seconds) must be collected during each discharge
measurement, twoin each direction. The measured discharge is the average of the discharge collected
during each transect.

Enter the staff gauge height prior to eachtransect measurementinthe Fulcrum app. Record all other
notes in the individual transect notes and/or the Remarks window of the Site Wizard (typically notes
that affect all transects can be enteredin the Site Wizard notes and notes that affect individual transects
areto be entered in the individual transect notes).

A new data file and Transect node will be createdin the Measurement Control window eachtime you
startand stop recording during eachtransect (ex: Transect 0000, Transect 001, Transect 002, Transect
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003). Once the fourth transect is complete stop data collection and evaluate whether additional

transects are needed.

5.

Evaluate Whether Additional Transects Are Required

More than four transects must be measuredif:

Total duration of all transects does not exceed 720 seconds.

The discharge measured during at least one transect is greater than 5% of the average discharge
of all transect measured.

An observed gauge height change is associated with a notable change in discharge for a given
transect.

Evaluate the total duration of all transects:

1.

In the Measurement Control window (top left panel in the WinRiver Il main screen) ensure that
each transect measurement you wish to evaluate is checked.

a. Uncheck any Transects were measuredthat contained errors and are not meant to be
included in the evaluation.

b. A minimum of four reciprocal transects (that do not contain errors) must be checked.

In the WinRiver Il main screen, hit the F12 button to bring up a summarytable that provides
information on each transect measured.

Scroll over to the fifth to last column, “Duration”.

Ensure that each transect durationis > 180 seconds and the sum of all transect durationis > 720
seconds.

If individual and total transect duration requirements are met, proceed to the next evaluation
step.

If an individual transectis < 180 seconds or the sum of all transect durationsis < 720 seconds,
collect two additional transect measurements (one from each side of the channel) and re-
evaluate the summary window.

Evaluate the discharge of each transect relative to average discharge of all transects:

1.

In the Measurement Control window (top left panel in the WinRiver Il main screen) ensure that
each transect measurement you wish to evaluate is checked.

a. Uncheck any Transects were measuredthat contained errors and are not meant to be
included in the evaluation.

b. A minimum of four reciprocal transects (that do not contain errors) must be checked.
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In the WinRiver Il main screen, hit the F12 button to bring up a summarytable that provides

information on each transect measured (Figure 76).

Note the value listedin the fifth column, “Total Q”, for each transect row.
a.
Note the value listedin the “Average” row of the “Total Q” column.
a.
Note the value listedin the sixth column, “Delta Q”, for each transect row.

a.

This is the total discharge measured during each transect.

This is the average discharge of all transects measured.

This is the percent difference of total discharge measured during each transect relative to

the average discharge across all transects.

If the Delta Q value for each transect is < 5%, discharge requirements are met and no additional

discharge transects are necessary.

a.

Proceed to the next evaluation step.

If the Delta Q value for any individual transect is >5%:

a.

b.

Collect two additional transect measurements (one from each side of the channel) and re-

evaluate the summarywindow (reciprocal pairs of transects must always be measured, one

that begins from eachside of the channel).

1) Note that under changing hydrologic conditions (stage s rising or falling) Delta Q

requirements may be difficult to meet.

2) If streamstage was fluctuating dramatically throughout the transect measurements,

proceed to the next evaluation step.

3) Astotal measureddischarge values decrease during the low flow regime, achieving < 5%

Delta Q values becomes increasingly difficult.

a) The instrumentation approaches the lower limits of its measurement ability at low
stages andthereis an overall increase in uncertainty when measuring low-flow

discharge (environmental factors such as bed and bank geometry exert a larger
influence on velocity paths and can adversely affect measurement ability).

b) A high level of precision is required to obtain repeatable discharge values per

transect.

c) Asmore measurements are collected a given site over time, Science and Field
Science staff can work together to develop applicable Delta Q thresholds based on

stage levels.

If Delta Q values still exceed 5% for a given transect collect two additional transect

measurements (one from eachside of the channel) and re-evaluate the summary window.
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c. If, aftercollecting a total of 10 transects, Delta Qvalues still exceed 5% for a given transect,

proceed to the next evaluation step.
1) Submit atrouble ticket to Science upon return to the office.

d. Keep in mind that the more transects that are measuredincreases the probability that the
true meandischarge will be measured but it alsoincreases the probability that an outlier
measurement will be collected.

3¢ Discharge Summary - TRDI (=R

Transect Start Bank #Ens Start Time Total Q Delta Q TopQ Meas. Q Bottom Q Left Q Left Dist. Right Q
mefs % me/s m¥s me/s m¥s m m¥fs

01000 Right 417 19:27:56 1151.505 1.92 67.125 957.347 120.280 2.978 9.00 3775
01001 Left 487 19:33:48 121.736 0.7 64.965 933.882 114.248 2344 9.00 6.297
01002 Right 469 19:45:47 1123.982 0.51 65.115 932.999 116.472 3.878 11.60 5.518
01003 Left 398 19:52:15 121.822 0.70 65.398 934.828 114.624 2.516 11.60 4.451
Average 442 1129.761 0.00 65.651 939.764 116.406 2.929 10.30 5.012
Std Dev. 42 14.533 129 0.999 11.746 2.760 0.687 1.50 1.17
Std.J| Avg.| (%) 9.50 1.29 0.00 1.52 1.25 2.37 23.46 14.57 22.29

Figure 76. Discharge summary window in WinRiver Il. The red box highlights Delta Q values. In this example all are
< 5%, an indication that no additional transect measurements are required.

Evaluate changes in transect discharge relative to changes in gauge height

Gauge height must be observed and recorded in the app prior to eachtransect measurementinorder to
calculate mean stage and assess unsteady flow conditions. Unsteady flow conditions occur during
periods of rising or falling stage which may occur during or immediately following heavy rain events,
upstream dam or lock flow regulation, tidal effects, downstream backwater effects, or flood waves.
Always document unsteady flow conditions in the main Remarks sectionand/or in individual transect
notes.

If changes in gauge height are associated with a notable change in discharge for a given transect (i.e. >
~3% of the mean):

1. Attemptto collect a pair of reciprocaltransects that correspond with a given gauge height.
2. |If stageis changingtoo rapidly and this is not possible proceed to Section N.11.

3. Submit atrouble ticket to Science upon return to the office.

N.11 Evaluating the Discharge Measurement in the Field

Following the completion of the discharge survey, the following data review steps must be completed:

1. Review, finalize, and save data in WinRiver II.
2. Check measureddischarge value against the stage-discharge rating equation (if available).

3. Reviewdata in Q-Rev.

Data review must be conducted while still on site so that the discharge survey can be repeated if

necessary.
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Review, Finalize, and Save Data in WinRiver Il:

1. Playback each measuredtransect and check parameters.

a.

b.

Open the node (+) under eachtransect.

Right click on the Transect number and select “Re-process Transect”. The transect data will
appearin all graphs that are currently on display.

Right click on Playback Configuration and select “Properties”.

1)

2)

3)

4)

In the Edge Estimates page onthe right, verify that the Begin Transect and End Transect
information was entered correctly.

In the Offsets page check that the ADCP transducer depth was entered correctly (this
depth should not have changed during the discharge survey).

In the Discharge page choose the correct Left Bankand Right Bank Edge Type.

a) A custom coefficient value canbe enteredif a given bank does not conform to
triangular or square shape.

b) Consult Science with any questions regarding bank coefficients. These values are
very important in estimating edge discharge.

Once any value has been enteredin the Playback Configuration > Properties window,
you can right click on the box and select “Apply to All Active Checked Transects” if you
wish to apply this value to all selected transects.

a) This will apply the setting to all transects inthe measurement that are checked.

b) Eachtransect will need to be re-processedfor this change to be applied.

Enter all applicable notes in the general Remarks sectionand in individual transect notes, as

necessary.

2. Following the WinRiver Il review save the measurement file on the laptop and a USB dongle for

backup.

a.

An .MMT file will be created along with .PDOfiles that are unique to individual transects.
Each of these files must be contained in a folder on the laptop and backed up onto a USB

dongle.

Check the measured discharge value against the stage-discharge rating equation, if available:

Once a stage-dischargerating curve has been developed and validated for a site, a rating equation is

derived that predicts discharge given stream stage (supplementary information on rating curves is
available in Appendix D). Once established, rating equations will be provided to field staff by Science.

Rating equations are commonly expressed as power relationships:
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Q=C/(G- a)B
Where:

Q= discharge;

G =the stage, or gauge height;

a =the gauge reading corresponding tozero discharge; and
C.and B = rating curve constants

Following the discharge measurement:

1. Enterthe streamstage (G)into the rating equation that is associated with the site.
2. Calculate predicted discharge.
3. Evaluate whether the measured dischargeis £10% of the discharge predicted by the equation.
a. Ifthe measureddischargeis <¥10% than predicted discharge:
1) Another discharge surveyis not required.

b. Ifthe measureddischargeis >+10% than predicted discharge (and the stream stage did not
change during the site visit):

1) Conduct another discharge survey immediately.

2) If, aftera second attempt, the measureddischarge remains >+10% the predicted rating
discharge:

a) Checkthesecond discharge measurement file for errors using steps provided in
previous sections.

b) Save both discharge measurements.
c) Submit atrouble ticket to Science.

(1) This mayindicate a shift in the rating, which, if validated by additional
measurements, would warrant anincrease in the frequency of discharge
measurements at the site.

Review, Finalize, and Save Datain Q-Rev:

QRev software (USGS) serves a final means to QAQC ADCP discharge data. The following procedures
must be done in the field prior to leaving the site.

1. Open Q-Rev.
2. Open the.mmtfile (the file that was just savedin WinRiver Il)in Q-Rev.

a. Inthe main Q-Rev window: Select Data >TRDI > select the WinRiver Il .mmt file.
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b.

Note that the location where the .mmt file is stored must also contain all of the .PDOfiles
that correspond with the measurement.

3. Note the color of the buttons on the left side of the main window. These colors indicate data

quality for specific measurement parameters.

a.

b.

Green: Good, no investigationrequired.

Yellow: Problems could be presented and may be able to be corrected, investigationis
required.

Red: Problems are present that are negatively affecting measurement data, investigationis
required.

4. Select the “Options” button (this button will never be colored).

a.

b.

Ensure that “Units” are settoSl.

Click OK.

5. Inthe main window, select the “Moving Bed Test” button (regardless of color).

a.

C.

Uncheck any tests that are not valid in the “User Valid” column.
1) Note the “Quality” rating, and the text contained in the Messages window.

If any tests contain “Moving Bed” = “Yes” consider checking “Use for Correction” if the tests
were valid.

Note this will change the measureddischarge value.

6. Evaluatethe remaining buttons if they are not green:

a.

b.

ADCP/Site Info

1) Herethe Station Name and Number can be edited.

System Test

1) Provides the results of the ADCP systemtest.

Compass/P/R

1) Provides heading, pitch and roll, and magnetic variation data for eachtransect.

a) If the pitch and roll time series data are too high and the extended compass
calibration was not performed, Q-Rev will apply a flag.

2) This button will be yellow if Compass CalibrationErroris > 1 degree.

3) Hereyou can change the magnetic variationfor some or all transects by clicking on the
Magnetic Variation value within the Heading, Pitch, & Roll table.
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4) You can view the Compass Calibration data by clicking the “View” button under

Compass Cal/Error on the right side of the screen.

d. Temp/Salinity

1) Hereyou can evaluate the ADCP thermistor which controls temperature, salinity, and
speed of sound data.

a) Fluctuations in the time series data mayindicate (1) the ADCP was not allowed to
fully equilibrate to the water temperature prior to measurement, or (2) actual
temperature variations presentin the channel.

2) Check the Average Temperaturevs. the User Temperature (entered at the start of the
ADCP measurement).

3) The temperature source canbe changedfrom internal (ADCP) to User for one or all
transects by clicking on the Temperature Source value in the Speed of Sound Settings
table.

a) Note this will change speed of sound and discharge values.

e. BTFilters

1) If GPS datawas used as the reference navigationthis button never needs to be
evaluated. Reference the GPS Filters button instead.

2) Hereyou can evaluate time series velocity data, velocity errors, and how the data can be
adjusted using different filter and interpolation settings.

3) Consult with Science if you feel that BT Filters require adjustment.

f. GPSFilters

1) If Bottom Trackwas used as the reference navigation this button never needs to be
evaluated. Reference the BT Filters instead.

2) Hereyou can evaluate time series velocity data, velocity errors, and how the data can be
adjusted using different filter and interpolation settings.

3) The ATL-g Plot to Google Earth plots the transects for the discharge measurement tothe
Google Earth App. This will only work if the Google Earth App is installed on the
computer that QRev is running on.

4) Consult with Science if you feel that GPS Filters require adjustment.

g. Selected Reference

1)

The Selected Reference button will be grayed out and this window will not be accessible
if there is no GPS datain the file loaded to QRev.
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2) The summarytable provides details on the navigation data available, and describes
changes in calculated discharge based on filter changes in QRev.

3) The Reference Used panel displays the navigation reference currently being used for the
transect selectedinthe summarytable.

4) The boat speedtime series shows the boat speed for each of the navigation reference
data types in the same graph per transect.

5) The ship tracktime series shows the ship track for each of the navigationreference data
types in the same graph per transect.

6) Inthe Selected Reference panel, the reference navigation data type used for computing
discharge can be changed. Refer back to the summary table to see how a change affects
the calculated discharge.

7) The Composite Tracks feature can automatically substitute one of the other valid
navigation references for the selected navigation reference, if the selected navigation
referenceis invalid.

a) Composite tracks default to off.
h. DepthFilters/Draft
1) Heredatafrom eachbeam can be reviewed and the combined cross-sectional value.

2) QRev defaults to using inverse depth weighting to compute the mean depth when the 4
slant beams are used.

3) The filter type canbe changedto eliminate erroneous spikes. Note this will change the
discharge value.

i. WT Filters
1) Hererawand processed water trackdata can be reviewed and adjusted.

2) Note thatthe errorand vertical velocity filters do not always perform well on data from
ADCPs with auto adaptive modes (the RiverPro being one such model) due to the
changein error velocity distribution for the different modes.

a) If this button is yellow or red try turning error and vertical velocity filters off. Note
the changein total discharge.

j. Extrapolation

1) Default edge extrapolationsettings are determined automatically from algorithms
createdfor the Extrap program.

2) The data panel displays average normalized depths for segments of the channel, with
each segment equating to5 percent of the total discharge.
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3) The Profile Panel is the primary panel in this window.

a)

b)

c)

d)

f)

k. Edges

GrayDots represent raw data, normalized discharge or velocity (depending on
which is selected)in each depth cell for all transects selectedinthe Fit panel.

Greencircles represent the top cell for each ensemble, the cell at the water’s
surface.

The Red/Black Squares are median points for the raw data in each segment. They
are color coded:

(1) Red:contains less values in the segment than the threshold requires, and is not
used in the computation of extrapolation.

(2) Black: Median values of the composite of all the transects inthe measurements.

The horizontal Red/Blacklines (Whiskers) on either side of each median value
extend to the 25thand 75th percentile of all the data in that segment (i.e. 50% of
the raw data will fall inside the whiskers).

The center line, going through the median squares is the extrapolation line, which is
alsocolor coded:

(1) Magenta:transects collected while crossing the channel from left bank to right
bank (facing upstream).

(2) Blue:transects collected while crossing the channel from right bank to left bank
(facing upstream).

(3) Black:is a composite of all the transects.
The fit panel allows a separate fit edge for each transect.

(1) Leave “Fit” setto “Automatic” for default algorithms to be used (recommended
default setting).

(2) Change “Fit” to “Manual” to change the extrapolation method at the Top and
Bottom of the graphto different fit options — Power, Constant, or 3-Point (Top)
or Power or No-Slip (Bottom).

(a) Set the Exponent value incrementally for Power or No-Slip extrapolations.
The graph will update as the exponent is changed.

(3) Note thatdischarge values will change as extrapolation fits are adjusted.

1) This window displays the edge settings for computing the left and right edge discharges
and displays graphs for evaluation.
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2) The Edges button will be yellow if any of the extrapolated edge discharge contributes
>5% of the total measured discharge for the transect.

a)

b)

Uncertaintyin the total estimated discharge increases with increased contribution
of edge discharge to the total estimate.

Check the “Left Distance (m)” and “Right Distance (m)” values to ensure the left and
right edge distances were entered correctly.

(1) Thesevalues are directly correlatedto the percentage of total discharge
contributed by the edges.

(2) To edit an edge distance click on the “Left/Right Distance (m)” value you wish to
edit. The new value canbe applied to a singulartransect or all transectsinthe
measurement.

If edge distances are correct but edge discharge remains >5% of the total measured
discharge, not much else can be done during post-processing other than re-
measuring additional transects during which you begin and end the measurement
closerto the edge of water.

7. Save the file and exit Q-Rev.
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SOPO Post-Field Sampling Tasks: River Sites using the Piloted Boat Method

Once field verification of the measurement file is complete, all instrumentation be cleaned following
standard operating procedures for cleaning field equipment usedin aquatic systems. Batteries for the
ADCP shall be charged or replaced as needed.

0.1 Document Incomplete Sampling Within a Site

Discharge sampling is scheduled to occur at the prescribed sampling location according to the frequency
and timing describedin Section 4. Ideally, sampling will occur at this sampling location for the lifetime of
the Observatory (core sites) or the duration of the site’s affiliation with the NEON project (gradient
sites). However, sampling may be shifted from one location to another when sampling is compromised.
In general, a sampling location is compromised when sampling becomes so limited that data quality is
significantly reduced.

There are two main pathways by which sampling can be compromised. First, sampling locations can
become inappropriately suited to answer meaningful biological questions — e.g., stream morphology
changes in such a waythat discharge measurement quality is r educed. Second, sampling locations may
be located in areas that are logisticallyimpossible to sample on a schedule that that is biologically
meaningful.

For the river discharge sampling program, a given discharge transect must be sampled during 100% of
the bouts expectedfor the site (See AppendixE.1for the number of expected bouts and site-specific
documentation) over a one-year period. Transects that cannot be sampled on this schedule should be
considered compromised.

If sampling at a given transect is not possible during a given bout a trouble ticket should be submitted by
Field Science staff.

To document a missed discharge bout:

1. Createanincident with the following naming convention to document the missed sampling:
‘AOS/TOS Sampling Incomplete: MOD — [Root Cause Description]’

a. Example: ‘TOS Sampling Incomplete: CDW — Could not access plot due to permanently
closed road’

Staff scientists review incident tickets periodically to determine whether a sampling location is
compromised.
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Raw ADCP discharge measurement files (i.e. files that have been evaluated in WinRiver Il and Q-Rev but

not post-processed by Science) are stored on an online file storage page and post-processed by Science.
Complete the following steps toupload discharge measurement files.

8. Inthe office (or location with internet connection), store the measurement file on the cloud-

based Box.com folder.

d.

Navigate tothe main Box.com folder where raw ADCP files are stored.

1) “NEONADCP Discharge Measurement Files” https://app.box.com/folder/48084982589)

2) “Raw_Data”

Navigate tothe applicable Domain folder for raw files.

1) Ex:“Domain_03 Raw_Files”

Navigate tothe appropriate site folder.

1) Ex: “FLNT”

Navigate tothe appropriate calendar year.

Create a new folder that is unique to your discharge measurement.

1) Click the “New” dropdown and select “Folder”.

2) Ensurethatthe folder name is in a standardized format.
a) Ex:“SITE_YYYYMMDD” (FLNT_20180317)

Move all of the measurement files into this folder.

1) This includes .MMT, .PDOfiles, and _GPS.TXT file (StreamPro only) - everything that was
saved on the laptop/USB.

2) If any other relevant materials correspondto the discharge measurement (i.e. pictures,
screenshots, etc.) create a sub-folder here where they canbe stored.

3) Inadditionto.PDO and _GPS.TXT files (of which there will be many depending on the
number of transects measured), include only one (1) .MMT file (from WinRiver Il) and
one (1) .XMLfile in the sub-folder.

Once the all datais available on the Box folder, Science will assume it is ready for post-
processing.
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APPENDIXD REMINDERS
ARC-Boat Tiller Repair:

The ARC-Boat tiller may become disconnected from the rudder shaft during transport or use, resulting in
the inability to steer the ARC-Boat. A disconnected tiller can be easily repaired in the field with the
proper tools (Figure 77). Repairing a broken tiller mayinvolve a third party, such as the manufacturer or
a machine shop.

Symptoms of ARC-Boat tiller failure:

e Clicking noise emanates from the ARC-Boat at higher speeds.
e Loss of rudder control.

e |nability to accuratelysteer boatin a given direction.

e ARC-Boat moves in circles when the throttle is applied.

To repair a disconnected ARC-Boat tiller:

e Remove therear hatchplate on the ARC-Boat (A).
e Locatethe tiller arm.
o Note whetherit is broken or disconnected from the rudder shaft (B).
o Ifthetilleris broken the discharge measurement cannot be conducted and a more
extensive repair is likely needed. Contact Science immediately.
o Ifthetilleris disconnected from the rudder shaft use the following steps to re-connect
the tiller to the rudder shaft.
e Remove thestainless steel connecting piece using a 5/32 Allen wrench (C).
e Reconnect the tiller armto the stainless steel connecting piece.
e Carefully reconnect tiller armto rudder shaft.
o Ensurethatthe rudders are at exactly 90 degrees tothe rear hull and the rudder shafts
are at a45 degree angle (D, E).
e Contact Science and/or the manufacturer (HR Wallingford) with any ARC-Boat repair questions.
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Figure 77. Repairing a disconnectedtilleron the ARC-Boat.

Viewing thelaptop screen in bright and direct sunlight:

Computer screens can be difficult to read in direct sunlight. Mouse cursor and screen contrast settings
can be configured in Windows settings that make the laptop screen easier toread/navigate, increase the
size of the mouse cursor, and provide a high contrast display.

1. Configure mouse cursor size
a. Hitthe "Windows" key on the laptop keyboard.
1) Locatedon the bottom left of the keyboard between "Ctrl" and "Alt" keys.
b. Type "Mouse settings" and click the first result "Mouse settings".
c. Click"Adjust Mouse & cursor size" toincrease the size of the cursor.
d. Adjust the cursor size to something reasonable for easy viewing in the field.
2. Increasing Screen Contrast
a. Hitthe "Windows" key on the laptop keyboard.
1) Locatedon the bottom left of the keyboard between "Ctrl" and "Alt" keys.
b. Type "Contrast".

c. Select "Turnhigh contrast on or off" to turn on high contrast and choose screen color
themes that are easier to read.
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1) Hotkey option: Left Alt + Left Shift + Print Screen (PrtSC).
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Figure 78. Example of stage-dischargerating curve. Circles indicate discharge measurements collected across a
wide range of gauge heights. Rating equations for each of the three distinct segments are shown representing low,
medium, and high flow regimes. In this example, a section control governs the stage -discharge relationship during
the low-flow regime and the main channelcontrol becomes de-activated at higher stages when as the streamflow

tops the banks. Once flow exceeds the channel capacity the stage-discharge relationship is governed by floodplain
channel control.

Breaks in the slope of the rating curve are often associated with one control becoming
submerged and another becoming activated. Three types of controls are common in natural
streams, each of which depend on streamflow and channel conditions (Braca 2008).

1. Section Controls: a natural downstream feature such as a riffle, rock ledge, sand
bar, or severe channel restrictionthat tends to control the low-flow regime. As
gauge heightincreases with higher streamflow the section control becomes
submergedin sucha way that it no longer controls the relation between gauge
height and discharge.

2. Channel Controls: a combination of downstream features throughout the reach

such as channel size, shape, curvature, slope and roughness. The length of channel
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controls can be extremely variable. Channel controls typically governstage-
discharge relations during periods of higher streamflow.

3. Combination of Section and Channel Controls: at some stages, the stage-discharge

relation may be governed by a combination of section and channel controls. This
usually occurs during a short rangein stage between section-controlled and
channel-controlled segments of the rating curve, or the transitionzone. Channels
with unstable controls tend to exhibit section/channel combinations.

Flood plain channel contral
Main channel control

/ T Control Changes {"break paints”)

Log Stage
LY
A

Section control

Log Discharge

Figure 79. Schematic representation of control range in arating curve. (lllustration: Braca 2008).
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-SPECIFICINFORMATION

Estimated Dates for Onset and Cessation of Sampling

Each domain has site-specific guidelines for timing of sample collection, which can be found in Domain

Specific Sampling Designs (Table 10). The dates in the Sampling Designh documents are estimated from
historical hydrologic data. Dates presentedare only a guide, and are derived according to the logic

presentedin Section 4.2. Because individual years mayvary widely from the average dates provided

below, it is essential that domain staff monitor real-time conditions to determine when to start (and

stop) sampling per environmental conditions, as described in Section 4 of this protocol.

Table 10. Site-specific bout number, start dates, end dates and additionalsite-specific samplingguidance.

. Req. # of AnnualBouts
Domain . . Document Document
per Site pre-Rating Curve
Number Number Name
Development

Aquatic Site Sampling

01 24 NEON.DOC.003600 Design— NEON Domain 01
Aguatic Site Sampling

02 24 NEON.DOC.003601 Design— NEON Domain 02
Agquatic Site Sampling

03 12 NEON.DOC.003602 Design— NEON Domain 03
Aquatic Site Sampling

04 24 NEON.DOC.003603 Design— NEON Domain 04
05 NA NEON.DOC.003604 | AQuatic Site Sampling

' ' Design— NEON Domain 05
Aquatic Site Sampling

06 24 NEON.DOC.003605 Design— NEON Domain 06
Aquatic Site Sampling

07 24 NEON.DOC.003606 Design— NEON Domain 07
12 (TOMB, BLWA) Aquatic Site Sampling

08 24 (MAYF) NEON.DOC.003607 Design— NEON Domain 08
Agquatic Site Sampling

09 NA NEON.DOC.003608 Design— NEON Domain 09
10 24 NEON.DOC.003609 | Aquatic Site Sampling

' ' Design— NEON Domain 10
Agquatic Site Sampling

11 24 NEON.DOC.003610 Design— NEON Domain 11
Aquatic Site Sampling

12 24 NEON.DOC.003611 Design— NEON Domain 12
Aquatic Site Sampling

13 24 NEON.DOC.003612 Design— NEON Domain 13
Aquatic Site Sampling

14 24 NEON.DOC. 1
ON.DOC.003613 Design— NEON Domain 14
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. Req. # of Annual Bouts
Domain . . Document Document
per Site pre-Rating Curve
Number Number Name
Development
Aguatic Site Sampling
15 24 NEON.DOC.003614 Design— NEON Domain 15
16 24 NEON.DOC.003615 | Aduatic Site Sampling
' ' Design— NEON Domain 16
Aquatic Site Sampling
17 24 NEON.DOC.003616 Design— NEON Domain 17
18 24 (OKSR) NEON.DOC.003617 | Aduaticite Sampling
) ) Design— NEON Domain 18
Aquatic Site Sampling
19 24 NEON.DOC.003618 Design— NEON Domain 19

E.2 ADCP Maximum Depth Measurement Thresholds per Site

The maximum measurement depth of StreamPro (used at wadable stream sites) and RiverPro (used at

river sites)is 2.00 meters though specific units have been upgraded to increase the maximum depth
profiling to 6.00 meters at the following sites

Date: 03/16/2022

Revision: H

Domain Site Name(s) ADCP Maximum Depth

Number Model Measurement (m)
01 HOPB StreamPro 2.00
02 POSE, LEWI StreamPro 2.00
03 FLNT RiverPro 25.00
04 CUPE, GUIL StreamPro 6.00
06 KING, MCDI StreamPro 6.00
07 LECO StreamPro 2.00
08 MAYF, TOMB, BLWA RiverPro 25.00
10/13 COMO, WLOU, ARIK StreamPro 2.00
11 PRIN, BLUE StreamPro 6.00
12 BLDE StreamPro 2.00
14 SYCA StreamPro 6.00
15 REDB StreamPro 2.00
16 MART, MCRA StreamPro 2.00
17 TECR, BIGC StreamPro 2.00
18/19 CARI, OKSR, TOOK-IN, TOOK-OUT | StreamPro 2.00
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APPENDIXF  EQUIPMENT

The following equipment is needed to implement the procedures in this document. Equipment lists are
organized by task. They do not include standardfield and laboratory supplies such as charging stations,
first aid kits, drying ovens, ultra-low refrigerators, etc.

Table 11. Equipmentlist for measuring discharge at wadable stream sites using the Flowmeter Method.

Exact . . & =
Item No. Brand? Description Purpose 8 b=
Hach Y Velocity flow meter Measures stream velocity 1
Fondriest
. . . Houses flowmeter and measures
Environment Y Top setting wading rod 1
depth
al, Inc.
Meter tape (minimum length
N must be greaterthanthe Delineates the discharge transect 1
wetted width of the channel)
N Stakes Anchoring survey tape 2
N Clamps Attaches and secures meter tapeto )
stakes
N 5 Gallon Bucket Flowmeter calibration 1
N Waders (per person) Safe wading 1
N Pgrsonal FIotatlo_n Device (at Safe wading 1
sites where required)
Used as a reference during discharge
NA Discharge protocol 8 &
measurement
N Hand tools (flathead screw Assist inattaching the flowmeter to 1
driver, etc.) the wading rod
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Table 12. Equipmentlist for measuring discharge at wadable stream sites using the ADCP Method.

measurement, maximum
length not likely to exceed

Guideline rope

Exact s >
Item No. Description Purpose =
Brand? P P A
Fully charged laptop with
Bluetooth capability and
N y PabIlity Interfaces with ADCP and GPS 1
necessary software installed
(WinRiver I, Q-Rev, ParaniWin)
StreamPro ADCP with 8 .
Teledyne Y charged AA batteries Measures discharge 1
SX Blue v SX Blue 1| GPS antenna Provides GPS data during discharge 1
measurement
Trimaran float and all
Teledyne Y associated components to Houses ADCP and GPS 1
mount ADCP and GPS units
Parani SD1000U Bluetooth Tra nsmits ADCP and GP§ data from
Sena Y i instruments to laptop via Bluetooth 3
transmitter .
connection
Temporary High Line —all
cc;:lponﬁ;\ts (:):tp%d’,ge'?i Mechanical assembly used to deploy
Teledyne N post, pulley Post, BUIel the trimaran float across the stream
rope, guideline support, guy
. . channel
wire + earthanchor, guy wire
driving rod)
Control rope (minimum length
is twice the wetted width of
the stream + additional length
. & Long length of rope used to pull the
to accommodate the distance .
N . . trimaran float back and forth across
to the point of operation on channel
the near bank and tie off on
the far bank, strong climbing
rope is recommended)
Trimaranrope (required length
is dependent on surface Short length of rope that connects
N velocity during the and orients the trimaran float to the
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Exact s >
Item No. Description Purpose S &
Brand? P P A
~1.5m, strong climbing rope is
recommended)
Connects the trimaranfloat to the
N Locking carabiner . 3
Trimaranrope
Drives the guy wire earth anchor into
N Small hammer or mallet the substrate tosupport High Line 1
assembly
N Thermometer (reads in C) Measures water temperature 1
N Anemometer (reads in kmh) Measures wind speed 1
N Laser rangefinder Measures edge distances 1
Measures ADCP depthand edge
N Meter tape or metric ruler . P € 1
distances
N Flagging Marks start and end transect points 1
N Sharpie Marks flagging 1
N Laptop cover or umbrella Protects laptop in wet weather 1
. Rotates trimaranfloat during pre-
LazySusan (contains no
N . measurement QAQC, reduces 1
magnetic parts) . .
compass calibrationerror
Shades computer screensoit can be
N Laptop shade easilyread in bright weather !
N USB flash drive Backs up measurement files 1
Discharge protocol and Used as a reference during discharge
NA . 1
laminated TRDI protocol cards | measurement
NA All necessarysafetyand PPO Safety NA
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Table 13. Equipmentlist for measuring discharge atriver sites using the Remote Controlled Boat Method.

Exact s >
Item No. Description Purpose EEE
Brand? E E g~
Fully charged laptop with
Bluetooth capability and
N necessary software Interfaces with ADCP and GPS
installed (WinRiver 11, Q-
Rev, ParaniWin)
Teledyne Y RiverPro ADCP Measures discharge
N Charggd RiverPro ADCP 12V Powers the ADCP )
batteries
H-R. Y ARC-Boat Deploys ADCP
Wallingford ploy
RiverPro ADCP Adapter fi
Verrro . apter for Houses ADCPin ARC-Boat, provides
H.R. Y ARC-Boat (withcharged ADCP d Bluetooth
Wallingford 12V batteryinside) and GPS poWer and BIuetoo
communications
mount
H.R. Charged ARC-Boat Batteries
Wallingford Y (10Nimh) Powers the ARC-Boat 4
H.R. Charger for ARC-Boat .
Y Ch ARC-Boat batt
Wallingford batteries arges oatbattenes
Charged ARC-Boat Remote
H.R. Control (Futaba 2.4GHz)
Y Controls the ARC-Boat 1
Wallingford w/neckstrapand charged
battery pack
H.R. v Spare ARC-Boat Remote Powers the ARC-Boat remote 1
Wallingford Control battery pack controller
H.R. ARC-Boat spare parts kit .
Wallingford Y with Allen wrench ARC-Boat maintenance 1
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Item No 2210 Description Purpose C 2
" | Brand? a*
. Transmits ADCP and GPS data from
Sena Y Parani leOOOU Bluetooth instruments tolaptop via Bluetooth 2
transmitter )
connection
Subsea Y Hemisphere GNSS V102 Provides GPS referencing for ADCP
GPS antenna
N Thermometer (reads in C) Measures water temperature
N Anemometer (reads in kmh) | Measures wind speed
N Laser rangefinder Measures edge distances
Measures ADCP depthand edge
N Meter tape or metric ruler distances P &
. Marks starting and ending transect
N Flagging points & &
N Sharpie Marks flagging
Anchored floats (non-
N . ( Marks transect start and end points 2
magnetic)
N Laptop cover or umbrella Protects laptop in wet weather
Lazy Susan (contains no Rotates trimaranfloat during pre-
N mayneﬁc arts) measurement QAQC, reduces
g P compass calibrationerror
N Laptop shade Shades computer screensoit can be
ptop easilyread in bright weather
N USB flashdrive Backs up measurement files
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Item No Exact Description Purpose 52
" | Brand? P P g+
Discharge protocoland . .
NA laminated TRDI protocol Used as a reference during discharge 1
measurement
cards
NA All necessarysafetyand Safet NA
PPO Y
Table 14. Equipment list for measuring discharge at river sites using the Piloted Boat Method.
Exact _ g 2
Item No. Brand? Description Purpose 3 =
Fully charged laptop with
Bluetooth capability and
N necessary software installed | Interfaces with ADCP and GPS 1
(WinRiver I, Q-Rev,
ParaniWin)
Teledyne Y RiverPro ADCP Measures discharge 1
N Charggd RiverProADCP 12V Powers the ADCP )
batteries
ADCP mount (all .
EC0-05389 Y components listedin ECO- D,TptlogsbADtCP over the side of the 1
05389) + Allen wrench prioted boa
N Thermometer (reads in C) Measures water temperature 1
N Anemometer (reads in kmh) | Measures wind speed 1
N Laser rangefinder Measures edge distances 1
N Meter tape or metric ruler Measures ADCP depthand edge 1

distances
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Item No 2210 Description Purpose 5 2
" | Brand? a*
Marks starting and ending transect
N Flagging . & 8 1
points
N Sharpie Marks flagging 1
Anchored floats (non-
N . ( Marks transect start and end points 2
magnetic)
N Laptop cover or umbrella Protects laptop in wet weather 1
Lazy Susan (contains no Rotates trimaranfloat during pre-
N Y . measurement QAQC, reduces 1
magnetic parts) . .
compass calibrationerror
N Laptop shade Sha@esconjputgrscreen50|tcar\be 1
easilyread in bright weather
N USB flash drive Backs up measurement files 1
Discharge protocol and Used as a reference during discharge
NA laminated TRDI protocol 8 & 1
measurement
cards
NA All necessarysafetyand PPO | Safety NA
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